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Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit 

Translations 
Product documents may be provided in additional languages on electronic media. 

Symbols Lexicon 

European Conformity Manufacturer 
Authorized Representative in 

the European Union 

Lot Number Use by For In Vitro Diagnostic Use 

Temperature Limit 
Catalog Number Consult Instructions for Use 

Number of Tests For use with Serial Number 

Prescription Use Only Unique Device Identification – 
Device Identifier Contains Latex 

Research Use Only Single-Use Only Biohazard 

Bio-Rad Technical Support 
The Bio-Rad Technical Support department in the U.S. is open Monday through Friday, 5:00 AM to 5:00 
PM, Pacific Time. 

Phone: 1-800-424-6723, option 2 

Email: Support@Bio-Rad.com (U.S./Canada only) 

For technical assistance outside the U.S. and Canada, contact your local technical support office or click the 
Contact us link at bio-rad.com. 
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Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit 

Legal Notices 
No part of this publication may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, including photocopy, recording, or any information storage or retrieval system, without 
permission in writing from Bio-Rad Laboratories. 

Bio-Rad reserves the right to modify its products and services at any time. This instruction manual is subject 
to change without notice. Although prepared to ensure accuracy, Bio-Rad assumes no liability for errors, 
or for any damages resulting from the application or use of this information. 

BIO-RAD, HARD-SHELL, and MICROSEAL are trademarks of Bio-Rad Laboratories, Inc. in certain 
jurisdictions. 

Hard-Shell Plates are covered by one or more of the following U.S. patents or their foreign counterparts 
owned by Eppendorf AG: U.S. Patent Numbers 7,347,977; 6,340,589; and 6,528,302. 

All trademarks used herein are the property of their respective owner. 

This product and/or its use is covered by claims of U.S. patents, and/or pending U.S. and non-U.S. patent 
applications owned by or under license to Bio-Rad Laboratories, Inc. Purchase of the product includes a 
limited, non-transferable right under such intellectual property for use of the product for internal research 
and diagnostic purposes only. For the purposes of COVID-19 only, Bio-Rad grants the rights for use of the 
product for commercial applications of any kind, including but not limited to manufacturing, quality 
control, or commercial services, such as contract services or fee for services. Information concerning a 
license for such uses can be obtained from Bio-Rad Laboratories. For any purpose beyond COVID-19 testing, 
it is the responsibility of the purchaser/end-user to acquire any additional intellectual property rights that 
may be required. 

Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit Warnings and 
Precautions 
For in vitro diagnostic use under Emergency Use Authorization. For healthcare professional use. 

This test kit should be handled only by qualified personnel trained in laboratory procedures and familiar 
with their potential hazards. Wear appropriate protective clothing, gloves, and eye/face protection and 
handle appropriately with the requisite Good Laboratory Practices. 

Personal Protective Equipment (PPE) 
Proper use of gloves is recommended with the use of components and sample plates. OSHA requirements 
for PPE are set forth in the Code of Federal Regulations (CFR) at 29 CFR 1910.132 (General requirements); 
29 CFR 1910.138 (Hand protection); 29 CFR 1926.95 (Criteria for standard personal protective equipment). 
Any gloves with impaired protective ability should be discarded and replaced. 
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Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit 

Intended Use 
The Bio-Rad Reliance SARS-CoV-2 real-time reverse transcription polymerase chain reaction (RT-PCR) Assay 
Kit is intended for the qualitative detection of nucleic acid from SARS-CoV-2 in nasopharyngeal swabs, 
oropharyngeal swabs, nasal swabs, anterior nasal swabs, mid-turbinate nasal swabs, nasal aspirates, and 
nasal washes from individuals suspected of COVID-19 by their healthcare provider. Testing is limited to 
laboratories certified under the Clinical Laboratory Improvement Amendments of 1988 (CLIA), 42 U.S.C. 
§263a, that meet requirements to perform high complexity tests. 

Results are for the identification of SARS-CoV-2 RNA, which is generally detectable in upper respiratory 
specimens during the acute phase of the infection. Positive results are indicative of the presence of SARS-
CoV-2 RNA; clinical correlation with patient history and other diagnostic information is necessary to 
determine patient infection status. Positive results do not rule out bacterial infection or coinfection with 
other viruses. Laboratories within the United States and its territories are required to report all test results 
to the appropriate public health authorities. 

Negative results do not preclude SARS-CoV-2 infection and should not be used as the sole basis for patient 
management decisions. Negative results must be combined with clinical observations, patient history, and 
epidemiological information. 

The Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit is intended for use by qualified clinical laboratory 
personnel specifically trained and instructed in RT-PCR techniques and in vitro diagnostic procedures. 

The Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit is only for use under the Food and Drug Administration’s 
Emergency Use Authorization. 

Summary and Principle 
An outbreak of pneumonia caused by a novel coronavirus (SARS-CoV-2) in Wuhan City, Hubei Province, 
China, was identified and reported to the World Health Organization (WHO) on December 31, 2019. The 
rapid spread of SARS-CoV-2 to numerous areas throughout the world necessitates preparedness and 
response in healthcare and laboratory facilities. The availability of specific and sensitive assays for detecting 
the virus is essential for accurate diagnosis of cases, assessment of the extent of the outbreak, monitoring 
of intervention strategies, and surveillance studies. 

The Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit is a molecular in vitro diagnostic test containing the 
reagents required to perform an RT-PCR test. The primer and probe sets are designed to detect RNA from 
the SARS-CoV-2 virus in nasopharyngeal swabs, oropharyngeal swabs, nasal swabs, anterior nasal swabs, 
mid-turbinate nasal swabs, nasal aspirates, and nasal washes from patients who are suspected of COVID-
19. Additional testing and confirmation procedures should be performed in consultation with public health 
and/or other authorities to whom reporting is required. Test results should also be reported in accordance 
with local, state, and federal regulations. Performance is unknown in asymptomatic patients. 

The oligonucleotide primers and probes for detection of SARS-CoV-2 are the same as those reported by 
the Center for Disease Control and Prevention (CDC) and were selected from regions of the virus 
nucleocapsid (N1 and N2) gene. The panel is designed for specific detection of the SARS-CoV-2 (two 
primer/probe sets). An additional primer/probe set to detect the human RNase P (RP) gene in control 
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Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit 

samples and clinical specimens is also included in the panel. To perform a test, RNA is isolated and purified 
from control samples and clinical specimens then added to a master mix made using Bio-Rad Reliance One-
Step Multiplex RT-qPCR Supermix.  The master mix includes a reverse transcriptase that transcribes RNA 
into cDNA and a DNA polymerase that amplifies the cDNA fragments that share homology with the 
primer/probe sets. Amplification of specific targets is monitored by the change in fluorescence intensity 
within specific excitation/emission wavelengths using a real-time PCR instrument. 

The Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit can be used with the Bio-Rad CFX Opus 96, CFX96 
Touch, CFX96 Dx, CFX Opus 384, and CFX384 Touch Real-Time PCR Detection Systems, and the Thermo 
Fisher Scientific, Inc. Applied Biosystems (AB) 7500 Fast Real-Time PCR Instrument (Table 1). The 
workflow consists of four steps (Table 2). 

Table 1. Instruments Required 
Catalog Number Product Name 

1855485 CFX384 Touch Real-Time PCR Detection System2 

1855195 CFX96 Touch Real-Time PCR Detection System2 

12011319 CFX Opus 96 Real-Time PCR System2 

12011452 CFX Opus 384 Real-Time PCR System2 

4351106, 4351107 Applied Biosystems 7500 Fast Real-Time PCR System1, 2 

1845097-IVD 
1841000-IVD 

CFX96 Dx ORM 
C1000 Dx Thermal Cycler 

Starter packages available for CFX Touch and CFX Opus Systems 
1This instrument requires qualification prior to use with the Bio-Rad Reliance SARS-CoV-2 EUA assay. Please refer to 
Appendix A for the required protocol and acceptance criteria 
2 Please refer to Appendix B of this IFU for EUO labeling that should be affixed to select instruments. 

Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit Workflow 
Table 2. Bio-Rad SARS-CoV-2 RT-PCR Assay Kit Workflow 

Workflow 

Step 1 Isolation of viral RNA from nasopharyngeal swabs, oropharyngeal swabs, nasal swabs, 
anterior nasal swabs, mid-turbinate nasal swabs, nasal aspirates, and nasal washes 

Step 2 RT-PCR Plate Setup 
Step 3 One-step reverse transcription and PCR 
Step 4 Analysis 

Reagents and Instruments 

Materials Provided 
The Reliance SARS-CoV-2 RT-PCR Assay Kit contains sufficient reagents to process a total of 200 reactions 
(Table 3). 
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Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit 

Table 3. Materials Required Included in Kit for the Reliance SARS-CoV-2 RT-PCR Assay Kit 

Product Name QTY 
(Tubes) 

Volume 
(μL) Storage Conditions, °C 

4x Reliance One-Step Multiplex Supermix 1 1000 -20°C 
Exact Diagnostics SARS-CoV-2 Standard 2 300 -20°C 
Exact Diagnostics SARS-CoV-2 Negative 2 300 -20°C 

SARS-CoV-2 RT-PCR Oligos 1 300 -20°C 

Note: Safety Data Sheets (SDS) are available at bio-rad.com 

Materials Required but Not Provided 
Reagents and Consumables: 

Reagents for RNA Purification 

The Thermo Fisher Scientific MagMAX Viral/Pathogen Nucleic Acid Isolation Kit (Catalog #A48310, 
#A42352) and the QIAGEN QIAamp Viral Mini Kit (Catalog #52906, #52904) are validated for use with the 
Reliance SARS-CoV-2 RT-PCR Assay Kit per the manufacturer’s instructions. 

Generic Reagents and Consumables for Real-Time PCR 
Materials required but not provided for running the Reliance SARS-CoV-2 RT-PCR Assay Kit on the Bio-Rad 
and Thermo Fisher Scientific Real-Time PCR Systems are listed in Table 4 and Table 5. 

Table 4. Materials Required but Not Provided for Running on the CFX Opus 96, CFX96 Touch, CFX96 Dx, 
CFX Opus 384, and CFX384 Touch Real-Time Systems 

Bio-Rad 
Catalog # Name QTY 

(each) 
Storage 

Conditions 
MSB1001 Microseal 'B' PCR Plate Sealing Film, adhesive, optical 100 15°C to 30°C 

HSP3805, or 
equivalent* 

Hard-Shell 384-Well PCR Plates, thin wall, skirted, clear/white 50 15°C to 30°C 

HSP9955 or 
equivalent* 

HSP9955, Hard-Shell 96-Well PCR Plates, low profile, thin wall, 
skirted, white/white 50 15°C to 30°C 

* Refer to Bio-Rad’s Hard-Shell PCR Plate Brochure 5496 for other 96 & 384-well colored shell/white well PCR plates 

Table 5. Materials Required but Not Provided for Running on the Applied Biosystems 7500 Fast Real-
Time PCR System 

Thermo Fisher 
Scientific Catalog # Product Name QTY 

(each) 
Storage 

Conditions 
4311971 MicroAmp Optical Adhesive Film 100 15°C to 30°C 

4346906 MicroAmp Fast Optical 96-Well Reaction Plate 
with Barcode, 0.1 mL 20 15°C to 30°C 
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Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit 

Instrumentation, Software, and General Laboratory Equipment: 

General laboratory equipment required but not provided for running the Bio-Rad Reliance SARS-CoV-2 RT-
PCR Assay Kit is listed in Table 6. 

Table 6. General Laboratory Equipment Required but Not Provided 
Description 

Single and multichannel adjustable pipettors (1.00 μL to 1,000 μL) 
Source 

Rainin or Eppendorf 
Microcentrifuge Multiple suppliers 
Microwell plate centrifuge, with a rotor that accommodates standard 
microplates Multiple suppliers 

Laboratory mixer, vortex, or equivalent Multiple suppliers 
Laboratory freezers 
• –30°C to –10°C 
• ≤ –70°C 

Multiple suppliers 

96-well or 384-well cold block or ice Multiple suppliers 
Nonstick, RNase-free microcentrifuge tubes (1.5 mL and 2.0 mL) Multiple suppliers 
Sterile aerosol barrier (filtered) pipette tips Multiple suppliers 

General Precautions and Warnings 
1. For In vitro Diagnostic (IVD) Use under Emergency Use Authorization only. 
2. For professional use only. 
3. This product has not been FDA cleared or approved, but has been authorized for emergency use 

by FDA under an EUA for use by authorized laboratories; 
4. This product has been authorized only for the detection of nucleic acid from SARS-CoV-2, not for 

any other viruses or pathogens; and, 
5. The emergency use of this product is only authorized for the duration of the declaration that 

circumstances exist justifying the authorization of emergency use of in vitro diagnostics for 
detection and/or diagnosis of COVID-19 under Section 564(b)(1) of the Federal Food, Drug and 
Cosmetic Act, 21 U.S.C. § 360bbb-3(b)(1), unless the declaration is terminated or authorization is 
revoked sooner. 

6. Positive results are indicative of the presence of SARS-CoV-2 RNA. 
7. Laboratories within the United States and its territories should report all test results to the 

appropriate public health authorities, as required. 
8. All biological specimens should be treated as if they are capable of transmitting infectious agents. 

Use safe laboratory procedures, such as those outlined in HHS Publication (CDC) 21-1112, Biosafety 
in Microbiological and Biomedical Laboratories and in CLSI Document M29-A4, Protection of 
Laboratory Workers from Infectious Disease Transmitted by Blood, Body Fluids, and Tissue. [1, 2] 

9. Thoroughly clean and disinfect all work surfaces with a freshly prepared solution of 0.5% sodium 
hypochlorite (10% bleach) in deionized or distilled water, followed by 70% alcohol. 

10. To minimize nucleic acid contamination, routinely decontaminate bench space, pipettors, and 
equipment, and separate the specimen and RNA/DNA handling area from the assay preparation 
area. 

11. Optimize workflow and space to minimize the risk of carryover contamination from completed PCR 
reactions. 

12. Ensure that the real-time PCR system and automation system have a dedicated space in separate 
areas to avoid amplicon contamination. 
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Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit 

13. Perform assay setup and template addition in different locations, with dedicated pipettors. 
14. Use proper laboratory safety procedures for working with chemicals and handling specimens. 
15. Change gloves frequently when transporting and working with different reagents. 
16. Failure to follow the procedures and conditions described in this document can cause incorrect 

results and adverse effects. 
17. Do not substitute Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit reagents with other reagents. 
18. Setup and template addition must be performed under RNase/DNase-free conditions. 
19. It is required that the AB7500 Fast instrument is appropriately qualified prior to use with the Bio-

Rad Reliance SARS-CoV-2 RT-PCR Assay Kit using established testing protocols.  Refer to the 
protocol provided in Appendix A. 

20. Ensure that regular maintenance and calibration are performed on all equipment according to 
manufacturer’s recommendations. 

21. Use nuclease-free tips and reagents, and routinely clean pipettors. 
22. Ensure that only the recommended thermal cycling protocol is used. 
23. Do not use diethyl pyrocarbonate (DEPC) treated water for PCR amplification. 
24. Closely follow the procedures and guidelines provided to ensure that the test is performed 

correctly. Any deviation from the procedures and guidelines may affect optimal test performance. 
25. False-positive results may occur if the carryover of samples is not adequately controlled during 

sample handling and processing. 

Specimen Collection, Handling, and Storage 
Adequate, appropriate specimen collection, storage, and transport are important to obtain sensitive and 
accurate test results. Training in correct specimen collection procedures is highly recommended to ensure 
good quality specimens and results. CLSI MM13-A may be referenced as an appropriate resource. 

1. Sample acceptance criteria 
● Samples should be collected into sterile, labeled tubes, and shipped per testing laboratory 

requirements. 
2. Specimen rejection criteria 

● Samples that have not been pre-approved for testing and those that are labeled improperly 
will not be tested until the required information is obtained 

3. Collecting the specimen 
● Refer Interim Guidelines for Collecting, Handling, and Testing Clinical Specimens from 

Persons for Coronavirus Disease 2019 (COVID-19). https://www.cdc.gov/coronavirus/2019-
nCoV/guidelines-clinical-specimens.html 

● Follow manufacturer instructions for proper use of specimen collection devices 
● Swab specimens should be collected using only swabs with a synthetic tip, such as nylon or 

Dacron®, and an aluminum or plastic shaft. Calcium alginate swabs are unacceptable, and 
cotton swabs with wooden shafts are not recommended. Place swabs immediately into sterile 
tubes containing 2-3 mL of viral transport media or universal transport media 

4. Transporting specimens 
● Specimens must be packaged, shipped, and transported according to the current edition of the 

International Air Transport Association (IATA) Dangerous Goods Regulation. Follow shipping 
regulations for UN 3373 Biological Substance, Category B when sending potential 2019-nCoV 
specimens to the testing laboratory 
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Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit 

● Store specimens at 2-8°C and ship overnight to the testing laboratory on an ice pack. If a 
specimen is frozen at -70°C or lower, ship overnight to the testing laboratory on dry ice. 

5. Storing specimens 
● Specimens can be stored at 2-8°C for up to 72 hours after collection 
● If a delay in extraction is expected, store specimens at -70°C or lower 
● Extracted nucleic acid should be stored at 4°C if it is to be used within 4 hours, or -70°C or 

lower if stored longer than 4 hours 

Use of Control Materials 
Controls to be used with the Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit: 

● A no-template control (NTC) is needed to detect reagent and/or environmental contamination. An NTC 
uses RNase/DNase-free water in place of a clinical specimen sample with a minimum of one well per 
reaction plate. 

● A positive control is needed to detect substantial reverse transcriptase and/or reagent failure, 
including primer and probe integrity. The test utilizes Exact Diagnostics SARS-CoV-2 Standard, which is 
manufactured with synthetic RNA transcripts containing five gene targets: E, N, ORF1ab, RdRP, and S 
Genes of SARS-CoV-2, each quantified at 200,000 copies/mL along with human genomic DNA 
background. This control material is spiked into a sample-like matrix to achieve a final concentration 
of 1,000 copies/mL and the nucleic acid is extracted. One positive control must be included per batch 
of samples extracted, with a minimum of one positive control well per reaction plate. 

● A negative control is needed to detect extraction step failure or reagent/environmental contamination. 
The test utilizes Exact Diagnostics SARS-CoV-2 Negative control, which is manufactured with human 
genomic DNA and RNA. This control material is spiked into a sample-like matrix and the nucleic acid is 
extracted. One negative control must be included per batch of samples extracted, with a minimum of 
one negative control well per reaction plate. 

Reagent Handling and Storage 

Reliance SARS-CoV-2 RT-PCR Assay Kit 
● The kit contains RT-PCR supermix, assay oligos, standard and negative control 
● Storage at -20°C is recommended, with minimum freeze-thaw cycles 

Work Areas 
All necessary safety precautions should be taken according to good laboratory guidelines. Precautions 
must also be taken to prevent cross-contamination of samples. 

Separate work areas should be used for: 
● Nucleic acid extraction 
● Reagent preparation (for example, preparation of master mix) 

o No amplified reactions, target solutions, or clinical specimens should be brought into 
the reagent preparation area. After working in this area, laboratory coat and gloves 
should be changed before moving into the nucleic acid addition area 

● Nucleic acid addition 
● Instrumentation (for example, thermocyclers) 
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Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit 

General Handling 
Proper microbiological, aseptic technique should always be used when working with RNA. Hands and 
dust particles may carry bacteria and molds and are the most common sources of RNase 
contamination. Always wear powder-free latex, vinyl, or nitrile gloves while handling reagents, tubes, 
and RNA samples to prevent RNase contamination from the surface of the skin or from laboratory 
equipment. Change gloves frequently and keep tubes closed. During the procedure, work quickly and 
keep everything on cold blocks when possible to avoid degradation of RNA by endogenous or residual 
RNases. Clean working surfaces, pipettes, etc. with 10% bleach or other solutions that can destroy 
nucleic acids and RNases. To eliminate accelerated deterioration of any plastics and metals, wipe down 
with 70% ethanol after using 10% bleach. Make sure all bleach is removed to eliminate possible 
chemical reactions between bleach and guanidine thiocyanate, which is present in the extraction 
reagents. 

Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit Protocol 

Overview 
The Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit is intended for the qualitative detection of RNA from 
the SARS-CoV-2 in upper respiratory tract specimens, including nasopharyngeal swabs, oropharyngeal 
swabs, nasal swabs, anterior nasal swabs, mid-turbinate nasal swabs, nasal aspirates, and nasal washes. 
The assay detects two regions of the SARS-CoV-2 nucleocapsid gene (termed N1 and N2) and a 
constitutively expressed human RP gene, all in one reaction. Detection of viral RNA not only aids in the 
diagnosis of illness but also provides epidemiological and surveillance information. 

The test is composed of two principal steps: (1) extraction of RNA from patient specimens and (2) one-step 
reverse transcription and polymerase chain reaction amplification and detection of the SARS-CoV-2 specific 
N1 and N2 targets, which detect viral infection, and the RP assay that detects background human nucleic 
acid in the patient specimen. 

Description of Test Steps 
Nucleic acids are isolated and purified from upper respiratory tract specimens, using the Thermo Fisher 
Scientific MagMAX Viral/Pathogen Nucleic Acid Isolation Kit or the QIAGEN QIAamp Viral RNA Mini Kit, 
following the manufacturer’s instructions. The purified nucleic acids are reverse transcribed and amplified 
using Reliance One-Step Multiplex RT-qPCR Supermix. The SARS-CoV-2 RT-PCR Oligos contains a blend of 
the primers and probes for SARS-CoV-2 targets (N1 and N2) and the human RP gene to enable multiplexed 
detection of the targets. 

Nucleic Acid Extraction 
Performance of the Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit is dependent upon the amount and 
quality of template RNA purified from human specimens. The following commercial extraction kits and 
procedures have been qualified and validated for recovery and purity of RNA for use with the test: 

● Thermo Fisher Scientific MagMAX Viral/Pathogen Nucleic Acid Isolation Kit (Catalog #A48310, 
#A42352) 

● QIAGEN QIAamp Viral RNA Mini Kit (Catalog #52906, #52904) 
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Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit 

Follow the manufacturer’s recommended procedures for sample extraction. A positive control and a 
negative control must be included in each extraction batch. 

Preparation of controls 

Positive control: Spike 5 μL of Exact Diagnostics SARS-CoV-2 Standard into a tube containing 995 μL of 
phosphate buffered saline (PBS). Treat as a patient sample and process for nucleic acid extraction together 
with other samples according to the manufacturer’s instructions. 

Negative control: Spike 5 μL of Exact Diagnostics SARS-CoV-2 Negative control into a tube containing 995 
μL of PBS. Treat as a patient sample and process for nucleic acid extraction together with other samples 
according to the manufacturer’s instructions. 

Preparation of One-Step RT-PCR Reaction 
1. Ensure extracted RNA sample(s) are thawed on ice. 

Note: Do not vortex RNA samples. RNA samples may be mixed by flicking the tubes, followed by brief 
centrifugation to collect the contents to the bottom of the tubes. 

2. Thaw all kit components on ice. 
3. Mix thoroughly by vortexing each tube briefly to ensure homogeneity, then pulse centrifuge to collect 

contents at the bottom of each tube 
Note: The Reliance One-Step Multiplex Supermix is viscous. It is critical to vortex before beginning 

the assay mix preparation. 
4. RT-PCR master mix preparation: 

a. Prepare a master mix according to the number of patient samples and controls to be tested plus 
10% more volume (Table 7) when more than 1 sample is tested. 

b. Vortex the master mix briefly and pulse centrifuge to collect the contents to the bottom of the 
tube. 

Table 7. RT-PCR Master Mix Component Volumes 

Component Volume for 1 
Sample (μL) 

Volume for 96 
Samples (μL) 

Volume for N 
Samples (μL) 

Reliance One-Step Multiplex RT-qPCR Supermix 5.0 528 (5.0 x N) x 1.1 
SARS-CoV-2 RT-PCR Oligos 1.5 158 (1.5 x N) x 1.1 
RNase/DNase free water 3.5 370 (3.5 x N) x 1.1 

Volume per reaction 10.0 1056 (10.0 x N) x 1.1 

5. Dispense 10 μL of the master mix into the appropriate wells of the RT-PCR plate. 
6. Add 10 μL of RNase/DNase free water to one well for an NTC. 
7. Add 10 μL of negative control material to one well for a Negative Control. 
8. Add 10 μL of positive control material to one well for a Positive Control. 
9. For the remaining wells, add 10 µl of extracted RNA sample per well. 
10. Seal the plate with a Microseal 'B' PCR Plate Sealing Film. 
11. Vortex the plate for 30 seconds at high speed. 
12. Centrifuge the RT-PCR reaction plate for 30 seconds at 1000 RCF to remove any air bubbles and allow 

the RT-PCR reaction to settle to the bottom of the wells. If bubbles remain, spin the plate again. 
13. Proceed with loading the RT-PCR reaction plate onto a CFX Opus 96, CFX96 Touch, CFX96 Dx, CFX Opus 

384, CFX384 Touch, or AB7500 Fast Real-Time PCR instrument. 
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Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit 

Bio-Rad CFX Instrument Setup 
The following instructions are for running the Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit on a 
computer-controlled CFX Opus 96, CFX96 Touch, CFX96 Dx, CFX Opus 384, or CFX384 Touch Real-Time 
PCR Systems.  For more detailed information, refer to the instrument manuals and addendum. 

Using Bio-Rad CFX instrument software, there are three stages for a RT-PCR run: 
1. Protocol Setup 
2. Plate Setup 
3. Running the RT-PCR reaction 

Cycling Protocol Setup for CFX Opus 96, CFX96 Touch, CFX96 Dx, CFX Opus 384, and CFX384 Touch 

1. Click File -> New -> Protocol in the menu bar to open the Protocol Editor 
2. Change Sample Volume to 20 μl 
3. Modify the Cycling Protocol to the guidelines in Table 8 below: 

Table 8. Thermal Cycling Protocol 
Step Number Cycling Step Temperature (°C) Time Cycles 

1 Reverse transcription 50 10 minutes 1 
2 Enzyme activation 95 10 minutes 1 
3 Denaturation 95 10 seconds 

45 4 Annealing/extension/ 
plate read 60 30 seconds 

5 Go to step 3 and repeat 
44 times -- --

4. Confirm step 4 includes a plate read, as is indicated by a camera symbol in the step 
5. To add a plate read to step 4, click on the step to highlight then click Add Plate Read to Step 

Figure 1: Final Cycling Protocol 

6. Save the protocol by clicking File -> Save As 
7. Name the protocol file “Bio-Rad SARS-CoV-2 RT-PCR Protocol” 
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Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit 

Plate Setup for CFX Opus 96, CFX96 Touch, CFX96 Dx, CFX Opus 384, and CFX384 Touch 

1. Click File -> New -> New Plate in the menu bar to open the Plate Editor 
2. Select Settings -> Plate Size -> select 96 wells or 384 wells 
3. Select Settings -> Plate Type -> select BR White 
4. Expand the pull-down menu to the right of Scan Mode and select All Channels 
5. Highlight the wells where samples and controls will be on the plate.  To highlight all wells, click 

the upper left corner of the plate graphic. 
6. Click Select Fluorophores and select FAM, HEX, and Texas Red by checking the Selected box to 

the right of the fluorophore (uncheck SYBR). Click OK to apply changes. 
7. Define sample type for each well by highlighting the wells then choose the appropriate identifier 

from the Sample Type pull-down menu Wells -> assign Sample Type 
8. Apply target names and fluorophores to all wells by highlighting the wells then checking the 

Load box to the left of each of the fluorophores listed in the Target Name section.  To include the 
target name, replace <none> in the open text box to the right of the fluorophore with the 
following: 

FAM – SARS-CoV-2 (N1) 
HEX – SARS-CoV-2 (N2) 
Texas – RNase P 

9. Save the file by clicking File -> Save As 
10. Name the plate file “Bio-Rad SARS-CoV-2 RT-qPCR Plate Setup” 
11. Close the file by clicking File -> Close 

Running the RT-PCR Plate on CFX Real-Time PCR Systems 
1. Select the instrument from the Select Instrument drop-down menu in the Startup Wizard 
2. Click User-defined in the Select run type section of the Startup Wizard. This will open the Run 

Setup panel. 
3. Click Select Existing in the protocol tab 
4. Select the cycling protocol file “Bio-Rad SARS-CoV-2 RT-PCR Protocol.prcl” 
5. Click Open to apply 
6. Confirm the cycling protocol is as shown in Table 8 
7. Click the Plate tab in the Run Setup panel 
8. Click Select Existing 
9. Select the plate setup file “Bio-Rad SARS-CoV-2 RT-qPCR Plate Setup.pltd” 
10. Click Open to apply 
11. Click the Start Run tab in the Run Setup panel 
12. Select the instrument in the Start Run on Selected Blocks section by checking the box to the left 

of the instrument name 
13. Load the plate into the instrument 
14. Click Start Run 
15. Define a file name for the run file and click Save to begin the run 
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Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit 

Data Analysis on CFX Real-Time PCR Systems 
The run data file will open automatically after the run has completed.  To open a file that has been 
closed, click File -> Open -> Data File -> Select the data file from the menu. 

To analyze the data, adjust the baseline and threshold values for each fluorophore in the Quantification 
Tab. 

1. Click Settings -> Cycles to Analyze -> enter "5" in the first cell to replace the default setting of "1" 
2. Deselect HEX and Texas Red by unchecking the corresponding boxes under the amplification plot. 

Only the FAM box should be selected. 

3. Select Log Scale by checking the box in the lower right of the amplification plot 

4. Visually inspect the traces. Any well with amplification in the FAM channel should show an 
exponential increase in RFU values up until the reaction plateaus. 

5. Manual baseline adjustment may be necessary if amplification traces are not exponential. To 
manually define the baseline, select Settings -> Baseline Threshold.  Highlight the well to be 
adjusted, enter 2 in the Baseline Begin cell, enter a cycle number that is 2 cycles before 
amplification trace starts to rise in the Baseline End cell. Click OK to apply. 

6. Set the FAM threshold in the amplification plot by clicking and dragging the threshold line until it 
lies within the exponential phase of the fluorescence curves and above any background signal. 

7. Confirm baseline and define the threshold for the HEX and Texas Red channels by selecting the 
appropriate fluorophore in Step 2 and repeating the process defined above 

Applied Biosystems 7500 Fast Real-Time Instrument Setup 
The following instructions are essential for running Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit on a 
AB7500 Fast Real-Time PCR system.  For more detailed information about plate, and cycling protocol 
setup, refer to the Applied Biosystems 7500 Fast Real-Time PCR instrument manual. 

1. Launch the 7500 software 
2. Select File -> New in the menu bar 
3. Define the following 

a. Assay – Standard Curve (Absolute Quantitation) 
b. Container – 96-Well Clear 
c. Template – Blank Document 
d. Run Mode – Standard 7500 

4. Assign the report dye as defined in Table 9:  

Table 9: Required Reporter Dyes 
Reporter Dye Detector 

FAM N1 
HEX N2 

TEXAS RED RP 
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Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit 

Note: For the N2 assay, the VIC channel is applicable for detecting this target.  Alternatively, the 
HEX reporter can be added by calibrating the instrument. This can be done by following the 
instrument manual. 

5. Select Passive Reference -> None 
6. Define the cycling protocol using the values listed in Table 10 

Table 10. Thermal Cycling Protocol for AB7500 
Cycling Step Temperature (°C) Time Number of Cycles 

Reverse transcription 50 10 minutes 1 
Enzyme activation 95 10 minutes 1 

Denaturation 95 10 seconds 45Annealing/extension 60 30 seconds 

7. Define the data collection step by selecting Stage 3, step 2 (60.0 @ 0:30) from the Data Collection 
dropdown menu, select Stage 3, Step 2 (60.0 @ 0:30), see Figure 3. 

Figure 3: Data Collection Dropdown Menu for AB7500 

Data Analysis on Applied Biosystems 7500 Fast Real-Time 
The following instructions are essential for analyzing results obtained using Bio-Rad Reliance SARS-CoV-2 
RT-PCR Assay Kit with the 7500 Fast Real-Time PCR system.  For more detailed information about data 
analysis, refer to the Applied Biosystems 7500 Fast Real-Time PCR instrument manual. 

Setting Baseline and Threshold Values 

1. Select File -> Open -> Select the data file to be analyzed 
2. Select the Result tab at the upper left corner of the software. 
3. Click on the Amplification Plot tab 
4. Highlight all the samples from the run to view all amplification curves. 
5. Set Data to Delta Rn vs. Cycle on the right side of the panel 
6. Set Detector to N1 
7. Set Line Color to Detector Color 
8. Select Manual Ct and Manual Baseline under Analysis Settings. Do not change the Manual 

Baseline default numbers. 
9. Click and drag the threshold line until it lies within the exponential phase of the fluorescence curves 

and above any background signal. 
10. Click the Analyze button in the lower right corner of the window. The red threshold will turn to 

green, indicating the data has been analyzed. 
11. Repeat step 6-10 to analyze results for each set of markers 
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Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit 

Interpretation of Results 
The NTC, positive control, and negative control should be examined prior to interpreting the patient 
results. If the controls are not valid, the patient results cannot be interpreted. 

Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit Controls – NTC, Positive and 
Negative 

No Template Control (NTC) 
The NTC reactions for the SARS-CoV-2 RT-PCR oligo mix should not exhibit positive signals in any 
channel (FAM, HEX or Texas Red) for any of the three targets tested, N1, N2, or RP. If any of the NTC 
reactions exhibit positivity, sample contamination may have occurred. Invalidate the run and repeat 
the assay with the residual extracted nucleic acid with strict adherence to the guidelines. If the repeat 
test result is positive, re-extract and re-test all samples that were included in that batch. 

Positive Control 
The Positive Control will yield positive results (Cq < 40) for the detection of N1, N2 and, RP primer 
and probe sets. 

Negative Control 
The Negative Control should yield a positive result with the RP primer and probe set (Cq < 40) and 
negative results with all SARS-CoV-2 N1 and N2 targets. 

Examination and Interpretation of Patient Specimen Results 
Assessment of clinical specimen test results should be performed after the positive and negative 
controls have been examined and determined to be valid and acceptable. The expected performance 
of the Bio-Rad Reliance SARS-CoV-2 RT-PCR assay controls is shown in Table 11. 

Table 11. Expected Performance of Controls in the Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit 

Control 
Type 

External 
Control 
Name 

Used to Monitor 
SARS-CoV-2 Internal 

Control Expected Cq 

N1 N2 RP N1 N2 RP 

NTC RNase/DNase 
free water 

Reagent and/or 
environmental 
contamination 

Negative Negative Negative Cq ≥ 40 or N/A 

Negative SARS-CoV-2 
Negative 

Reagent and/or 
Environment 

Contamination 
Negative Negative Positive Cq ≥ 40 

or N/A 
Cq ≥ 40 
or N/A < 40 

Positive SARS-CoV-2 
Standard 

Substantial 
reagent failure, 
including primer 

and probe 
integrity 

Positive Positive Positive < 40 < 40 < 40 

If any control does not meet these criteria, the test may have improper setup or execution, or reagent or 
equipment malfunction or failure.  Invalidate the run and re-test. 
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Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit 

RP (Internal Control) 
All clinical samples should exhibit positive signals with the RP primers and probe (Cq < 40), thus 
indicating the presence of the human RP gene. A failure to detect RP in any clinical specimens may 
indicate: 
● Improper extraction of nucleic acid from clinical materials resulting in loss of RNA and/or RNA 

degradation 
● Absence of sufficient human cellular material due to poor collection or loss of specimen integrity 
● Improper assay set up and execution 
● Reagent or equipment malfunction 

If the RP assay does not produce a positive result for a human clinical specimen, interpret as follows: 

● If the SARS-CoV-2 N1 and/or N2 is/are positive, even in the absence of a positive RP, the result 
should be considered valid. It is possible that some samples may fail to exhibit RP as positive (Cq 
< 40) due to low cell numbers in the original clinical sample. A negative RP signal does not 
preclude the presence of SARS-CoV-2 virus RNA in a clinical specimen. 

● If all SARS-CoV-2 markers and RP are negative for the specimen, the result should be considered 
invalid for the specimen. If a residual specimen is available, repeat the extraction procedure and 
repeat the test. If all markers remain negative after re-testing, report the results as invalid and a 
new specimen should be collected. 

SARS-CoV-2 Markers (N1 and N2) 
● SARS-CoV-2 is detected when all controls exhibit the expected performance; a specimen is 

considered positive for SARS-CoV-2 if all SARS-CoV-2 marker (N1, N2) amplification curves cross 
the threshold line within 40 cycles. The RP may or may not be positive as described above, but the 
SARS-CoV-2 result is still valid. 

● SARS-CoV-2 is not detected when all controls exhibit the expected performance and all SARS-CoV-
2 markers (N1, N2) amplification curves DO NOT cross the threshold line within 40 cycles AND the 
RNase P amplification curve DOES cross the threshold line within 40 cycles. 

● The result is inconclusive when all controls exhibit the expected performance and the amplification 
curves for either of the SARS-CoV-2 markers (N1 or N2, but not both markers) cross the cycle 
threshold within 40 cycles. The extracted RNA should be retested. If residual RNA is not available, 
re-extract RNA from residual specimen and re-test. If the same result is obtained, report the 
inconclusive result.  Consult with your state public health laboratory or CDC, as appropriate, to 
request guidance and/or to coordinate transfer for the specimen for additional analysis. 

● The result is invalid when all controls exhibit the expected performance and the amplification 
curves for the SARS-CoV-2 markers (N1, N2) AND the RP marker DOES NOT cross the cycle 
threshold within 40 cycles. The extracted RNA from the specimen should be re-tested. If residual 
RNA is not available, re-extract RNA from the residual specimen and re-test. If the re-tested sample 
is negative for all markers and RP, the result is invalid and collection of a new specimen from the 
patient should be considered. 

For ease of interpretation, refer to the guide in Table 12. 
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Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit 

Table 12. Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit Results Interpretation Guide 
SARS-CoV-2 

N1 Result 
SARS-CoV-2 

N2 Result 
Internal Control 

RP Result Interpretation Actions 

Positive 
(Cq < 40) 

Positive 
(Cq < 40) 

Positive or 
Negative 

SARS-CoV-2 
detected 

Store samples at -70°C as needed and 
report the results to the appropriate 

Public Health Authority 

If only one of the two targets is 
positive 
(Cq < 40) 

Positive or 
Negative 

Inconclusive 

Repeat testing of nucleic acid and/or 
re-extract and repeat RT-PCR. If the 

repeated result remains inconclusive, 
contact your State Public Health 

Laboratory or CDC for instructions for 
transfer of the specimen or further 

guidance. 
Negative 

(Cq ≥ 40 or N/A) 
Negative 

(Cq ≥ 40 or N/A) 
Positive 
(Cq < 40) 

SARS-CoV-2 not 
detected 

Report the results to the appropriate 
Public Health Authority 

Negative 
(Cq ≥ 40 or N/A) 

Negative 
(Cq ≥ 40 or N/A) 

Negative 
(Cq ≥ 40 or N/A) 

Invalid Result 

Repeat extraction and RT-PCR. If the 
repeated result remains invalid, 

consider collecting a new specimen 
from the patient. 

Limitations 
1. The Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit has only been evaluated for use on the CFX Opus 

96, CFX96 Touch, CFX96 Dx, CFX Opus 384, CFX384 Touch, and Applied Biosystems 7500 Fast Real-Time 
PCR Systems. 

2. Performance of the Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit has only been established in 
nasopharyngeal swab specimens. Use of the Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit with other 
specimen types has not been assessed and performance characteristics are unknown. 

3. Oropharyngeal swabs, nasal swabs, mid-turbinate swabs, nasal aspirates and nasal washes are 
considered acceptable specimen types for use with the Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit 
but performance with these specimen types has not been established. 

4. Reliable results depend on proper sample collection, storage, and handling procedures. 
5. This test is used for the detection of SARS-CoV-2 RNA in upper respiratory specimens collected in a 

Universal Transport Medium (UTM) or Universal Viral Transport System (UVT). Testing of other sample 
types with Reliance SARS-CoV-2 RT-PCR Assay Kit may result in inaccurate results. 

6. Detection of SARS-CoV-2 RNA may be affected by sample collection methods, patient factors (for 
example, presence of symptoms), and/or stage of infection. 

7. The output of the Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit is a qualitative assessment of patient 
samples that are positive of SARS-CoV-2. The user assesses RT-PCR results for controls and patient 
samples to make a qualitative call of SARS-CoV-2 detected or not detected. The values reported should 
not be used or interpreted as quantitative. 

8. As with any molecular test, mutations within the target regions of Reliance SARS-CoV-2 RT-PCR Assay 
Kit could affect primer and/or probe binding resulting in a failure to detect the presence of a virus. 

9. Due to inherent differences between technologies, it is recommended that, prior to switching from 
one technology to the next, users perform method correlation studies in their laboratory to qualify 
technology differences. One hundred percent agreement between the results should not be expected 
due to the aforementioned differences between technologies. Users should follow their own specific 
policies/procedures. 
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Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit 

10. The performance of this test was established based on the evaluation of a limited number of clinical 
specimens. The clinical performance has not been established in all circulating variants but is 
anticipated to be reflective of the prevalent variants in circulation at the time and location of the clinical 
evaluation. Performance at the time of testing may vary depending on the variants circulating 
including newly emerging strains of SARS-CoV-2 and their prevalence, which change over time. 

Conditions of Authorization for the Laboratory 
The Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit Letter of Authorization, along with the authorized Fact 
Sheet for Healthcare Providers, the authorized Fact Sheet for Patients, and authorized labeling are available 
on the FDA website: https://www.fda.gov/medical-devices/coronavirus-disease-2019-covid-19-
emergency-use-authorizations-medical-devices/in-vitro-diagnostics-euas 

However, to assist clinical laboratories using the Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit (“your 
product” in the conditions below), the relevant Conditions of Authorization are listed below: 

A. Authorized laboratories1 using your product must include with test result reports all authorized 
Fact Sheets. Under exigent circumstances, other appropriate methods for disseminating these 
Fact Sheets may be used, which may include mass media. 

B. Authorized laboratories using your product must use your product as outlined in the authorized 
labeling. Deviations from the authorized procedures, including the authorized instruments, 
authorized extraction methods, authorized clinical specimen types, authorized control materials, 
authorized other ancillary reagents and authorized materials required to use your product are not 
permitted. 

C. Authorized laboratories that receive your product must notify the relevant public health 
authorities of their intent to run your product prior to initiating testing. 

D. Authorized laboratories using your product must have a process in place for reporting test results 
to healthcare providers and relevant public health authorities, as appropriate. 

E. Authorized laboratories will must collect information on the performance of your product and 
report to DMD/OHT7-OIR/OPEQ/CDRH (via email: CDRH-EUA-Reporting@fda.hhs.gov) and Bio-
Rad Technical Support at 1-800-4BIORAD (1-800-424-6723) about any suspected occurrence of 
false positive or false negative results and significant deviations from the established performance 
characteristics of your product of which they become aware. 

F. All laboratory personnel using your product must be appropriately trained in PCR techniques and 
use appropriate laboratory and personal protective equipment when handling this kit and use 
your product in accordance with the authorized labeling. 

G. You, authorized distributors, and authorized laboratories using your product must ensure that any 
records associated with this EUA are maintained until otherwise notified by the FDA. Such records 
will be made available to the FDA for inspection upon request. 
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Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit 

1 The letter of authorization refers to, “Laboratories certified under the Clinical Laboratory Improvement 
Amendments of 1988 (CLIA), 42 U.S.C. §263a, that meet requirements to perform high complexity tests” 
as “authorized laboratories.” 

Analytical Performance Characteristics 

Analytical Sensitivity 

Limit of detection (LOD) studies were conducted to determine the lowest detectable concentration of 
SARS-CoV-2 at which greater or equal to 95% of all (true positive) replicates test positive using the Bio-Rad 
Reliance SARS-CoV-2 RT-PCR Assay Kit.  To determine the LOD, patient samples were simulated for the 
study through titrating a synthetic virus (AccuPlex SARS-COV-2, Seracare, Cat# 0505-0126) into a 
background of pooled SARS-CoV-2 negative nasopharyngeal swab matrix prior to nucleic acid purification. 
The Thermo Fisher MagMAX Viral/Pathogen Nucleic Acid Isolation Kit and QIAGEN QIAamp Viral RNA Mini 
Kit were the extraction kits validated in the LOD study. 

For LOD studies using the QIAGEN QIAamp Viral RNA Mini Kit, simulated patient samples were produced 
with viral loads of 31.25, 62.5, 125 and 250 copies per mL for the CFX96 Touch, CFX96 Dx, CFX384 Touch 
and AB7500 instruments.  In a subsequent study to include the CFX Opus 96 and CFX Opus 384, the viral 
loads tested for LOD studies was adjusted to 125, 250, 500 and 1000 copies per mL. Twenty replicates of 
each viral dilution were isolated according to the manufacturer's instructions (140 μL sample volume and 
an elution volume of 60 μL). The LOD results are shown in Table 13.  CFX96 Touch and CFX96 Dx 
instruments can detect SARS-CoV-2 infection with an LOD of 125 viral copies/mL. CFX384 Touch, CFX Opus 
96, CFX Opus 384, and AB7500 instruments can detect SARS-CoV-2 infection with an LOD of 250 viral 
copies/mL. 

Subsequent to the QIAGEN QIAamp Viral RNA Mini Kit LOD study, the LOD studies on all instruments using 
Thermo Fisher’s MagMAX Viral/Pathogen Nucleic Acid Isolation Kit used simulated patient samples that 
were produced with viral loads of 125, 250, 500 and 1000 copies per mL and isolated 20 replicates of each 
viral dilution according to the manufacturer's instructions (200 μL sample volume and an elution volume 

of 100 μL). The LOD results are shown in Table 14.  CFX96 Dx and CFX Opus 96 instruments can detect 
SARS-CoV-2 infection with an LOD of 125 viral copies/mL. CFX96 Touch, CFX Opus 384, and AB7500 
instruments can detect SARS-CoV-2 infection with an LOD of 250 viral copies/mL. The CFX384 Touch 
instrument can detect SARS-CoV-2 infection with an LOD of 500 viral copies/mL. 

The LOD range is 125-250 viral copies/mL on all instruments Independent of nucleic acid purification 
method (Table 15) with the exception of CFX384 Touch, which has an LOD of 500 copies/mL when used 
with the Thermo Fisher’s MagMAX Viral/Pathogen Nucleic Acid Isolation Kit. 
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Table 13. LOD Results QIAamp Viral RNA Mini Kit Extracted Samples 

SARS-
CoV-2 

copies/mL 

CFX96 Touch CFX96 Dx CFX384 Touch AB7500 
N1 

Positive 
replicates 

/Total 
replicates 

N2 
Positive 

replicates 
/Total 

replicates 

N1 
Positive 

replicates 
/Total 

replicates 

N2 
Positive 

replicates 
/Total 

replicates 

N1 
Positive 

replicates 
/Total 

replicates 

N2 
Positive 

replicates 
/Total 

replicates 

N1 
Positive 

replicates 
/Total 

replicates 

N2 
Positive 

replicates 
/Total 

replicates 
250 20/20 20/20 20/20 20/20 20/20 20/20 20/20 20/20 
125 19/20 19/20 19/20 20/20 18/20 19/20 16/20 15/20 
62.5 20/20 17/20 19/20 18/20 18/20 18/20 16/20 12/20 

31.25 17/20 19/20 14/20 15/20 13/20 10/20 9/20 7/20 

Table 13 (cont.) LOD Results QIAamp Viral RNA Mini Kit Extracted Samples 

SARS-
CoV-2 

copies/mL 

CFX Opus 96 CFX Opus 384 
N1 

Positive 
replicates 

/Total 
replicates 

N2 
Positive 

replicates 
/Total 

replicates 

N1 
Positive 

replicates 
/Total 

replicates 

N2 
Positive 

replicates 
/Total 

replicates 
1000 20/20 20/20 20/20 20/20 
500 20/20 20/20 20/20 20/20 
250 20/20 20/20 19/20 19/20 
125 16/20 19/20 17/20 13/20 

Table 14. LOD Results MagMAX Viral/Pathogen Nucleic Acid Isolation Kit Extracted Samples 

SARS-
CoV-2 

copies/mL 

CFX96 Touch CFX96 Dx CFX384 Touch AB7500 
N1 

Positive 
replicates 

/Total 
replicates 

N2 
Positive 

replicates 
/Total 

replicates 

N1 
Positive 

replicates 
/Total 

replicates 

N2 
Positive 

replicates 
/Total 

replicates 

N1 
Positive 

replicates 
/Total 

replicates 

N2 
Positive 

replicates 
/Total 

replicates 

N1 
Positive 

replicates 
/Total 

replicates 

N2 
Positive 

replicates 
/Total 

replicates 
1000 20/20 20/20 20/20 20/20 19/20 20/20 20/20 20/20 
500 20/20 20/20 20/20 20/20 19/20 20/20 19/20 20/20 
250 20/20 20/20 19/20 20/20 12/20 20/20 20/20 19/20 
125 15/20 19/20 19/20 20/20 10/20 10/20 14/20 14/20 

10000132460, Rev. E – Instructions for Use 23 

REVOKED



  

 
      

    

 

       

    
      

      
      
      

 
    

    
   

   
   

    
      

      
 

 
   

    
      

   
               

   
          

    
   

 
     

          
     

  

  
     

  
   

   
        

     

Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit 

Table 14 (cont.) LOD Results MagMAX Viral/Pathogen Nucleic Acid Isolation Kit Extracted Samples 

SARS-
CoV-2 

copies/mL 

CFX Opus 96 CFX Opus 384 
N1 

Positive 
replicates 

/Total 
replicates 

N2 
Positive 

replicates 
/Total 

replicates 

N1 
Positive 

replicates 
/Total 

replicates 

N2 
Positive 

replicates 
/Total 

replicates 
1000 20/20 20/20 20/20 20/20 
500 20/20 20/20 20/20 20/20 
250 20/20 20/20 19/20 19/20 
125 20/20 19/20 20/20 9/20 

Table 15. Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit LOD Summary 
Instrument QiaAMP Viral Mini Kit MagMAX Viral/Pathogen Kit 

250 copies/mL CFX96 Touch 125 copies/mL 
CFX96 Dx 125 copies/mL 125 copies/mL 
AB7500 250 copies/mL 250 copies/mL 

CFX384 Touch 250 copies/mL 500 copies/mL 
CFX Opus 96 250 copies/mL 125 copies/mL 

CFX Opus 384 250 copies/mL 250 copies/mL 

Inclusivity 
The Bio-Rad Reliance SARS-CoV-2 RT-PCR Oligos (primers and probes) sequences for N1, N2, and RP were 
developed by the CDC. CDC performed an alignment with the oligonucleotide primer and probe sequences 
of the CDC 2019 nCoV Real Time RT-PCR Diagnostic Panel with all publicly available nucleic acid sequences 
for SARS-CoV-2 in the Global Initiative on Sharing All Influenza Data (GISAID, https://www.gisaid.org) 
database as of June 20, 2020 to demonstrate the predicted inclusivity of the CDC 2019 nCoV Real-Time RT-
PCR Diagnostic panel. An evaluation of 31,623 available SARS-CoV-2 sequences in GISAID was used in this 
study. With the exception of one nucleotide mismatch with frequency > 1% (2.00%) at the third position of 
the N1 probe, the frequency of all mismatches was < 1%, indicating that prevalence of the mismatches 
were sporadic. Only one sequence (0.0032%) had two nucleotide mismatches in the N1 probe, and one 
other sequence from a different isolate (0.0032%) had two nucleotide mismatches in the N1 reverse 
primer. No sequences were found to have more than one mismatch in any N2 primer/probe region. 

The risk of a single mismatch resulting in a significant loss in reactivity, and false-negative result, is low due 
to the design of the primers and probes with melting temperatures > 60°C and run conditions of the assay 
with annealing temperature at 55°C to tolerate one to two mismatches. 

Analytical Specificity (cross-reactivity) 
In silico analysis for the pathogens listed in Table 16 was performed by downloading one GenBank 
reference sequence per genome for each of the organisms. The reference sequences were compared 
against the Bio-Rad SARS-CoV-2 targets, N1 and N2 for all possible combinations (forward primer, reverse 
primer, probe, and the reverse complements for all of these) to determine homology percentage. If any 
of these primer combinations were mapped to a sequence on opposite strands with a homology of >80% 
on the same target within a short distance (≤100 bp) apart, potential amplifications were flagged. No 
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potential unintended cross-reactivity is expected based on this in silico analysis except for SARS-
coronavirus (SARS-CoV) with the N2 target. 
As reported under the CDC EUA, the in-silico analysis for the N1 primer/probe set showed high sequence 
homology of the N1 probe with SARS-CoV and bat SARS-like coronavirus genome. However, forward and 
reverse primers showed no sequence homology with SARS-CoV and bat SARS-like coronavirus genome. 
Combining the primers and probe results, there are no significant homologies with the human genome, 
other coronaviruses, or human microflora that would predict potential false positive RT-PCR results. 

Table 16. In silico analysis for SARS-CoV-2 

Pathogens Tested in-Silico Unintended Cross-
Reactivity to N1 

Unintended Cross-
Reactivity to N2 

SARS-CoV None detected Homology match 92%* 
MERS-coronavirus None detected None detected 

Human adenovirus A None detected None detected 
Human adenovirus B1 None detected None detected 
Human adenovirus B2 None detected None detected 
Human adenovirus C None detected None detected 
Human adenovirus D None detected None detected 
Human adenovirus E None detected None detected 
Human adenovirus F None detected None detected 

Human Metapneumovirus (hMPV) None detected None detected 
Parainfluenza virus 1 None detected None detected 
Parainfluenza virus 2 None detected None detected 
Parainfluenza virus 3 None detected None detected 
Parainfluenza virus 4 None detected None detected 

Influenza A H3N2 None detected None detected 
Influenza A H2N2 None detected None detected 
Influenza A H7N9 None detected None detected 
Influenza A H1N1 None detected None detected 

Influenza B None detected None detected 
Human enterovirus A None detected None detected 
Human enterovirus B None detected None detected 

Enterovirus E, Bovine enterovirus None detected None detected 
Enterovirus F None detected None detected 

Enterovirus G, Porcine enterovirus 9 None detected None detected 
Enterovirus H, Simian enterovirus A None detected None detected 

Enterovirus J strain 1631 None detected None detected 
Enterovirus J strain N203 None detected None detected 

Respiratory syncytial virus None detected None detected 
Rhinovirus A, Human rhinovirus 89 None detected None detected 

Rhinovirus A, Human rhinovirus 1 strain 
ATCC VR-1559 None detected None detected 
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Pathogens Tested in-Silico Unintended Cross-
Reactivity to N1 

Unintended Cross-
Reactivity to N2 

Rhinovirus B None detected None detected 
Rhinovirus C, Human rhinovirus C None detected None detected 

Rhinovirus C, Human rhinovirus NAT001 None detected None detected 
Haemophilus influenzae None detected None detected 
Legionella pneumophila None detected None detected 

Mycobacterium tuberculosis None detected None detected 
Streptococcus pneumoniae None detected None detected 

Streptococcus pyogenes None detected None detected 
Enterovirus (e.g. EV68) None detected None detected 
Pneumocystis jirovecii None detected None detected 

*Analysis of the forward primer of the N2 target showed high homology to bat SARS-like coronaviruses. 
However, the reverse primer and probe sequences showed no significant homology with the human 
genome, other coronaviruses or human microflora that would predict potential false-positive RT-PCR 
results. Combining the primers and probe results, there is no prediction of potential false-positive RT-
PCR results. 

In addition to the in silico analysis, CDC reported analytical specificity and exclusivity 
demonstrating expected results are obtained for each organism noted in Table 17 to 
demonstrate that final results are not impacted by these viruses. 
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Table 17. Specificity/Exclusivity reported by CDC 
Virus Strain Source 2019-nCoV_ N1 2019-nCoV_ N2 Final Result 

Human coronavirus 229E Isolate 0/3 0/3 Neg. 
Human coronavirus OC43 Isolate 0/3 0/3 Neg. 
Human coronavirus NL63 Clinical Specimen 0/3 0/3 Neg. 
Human coronavirus HKU1 Clinical Specimen 0/3 0/3 Neg. 
MERS-coronavirus Isolate 0/3 0/3 Neg. 
SARS-coronavirus Isolate 0/3 0/3 Neg. 
Bocavirus Clinical Specimen 0/3 0/3 Neg. 
Mycoplasma 
pneumoniae Isolate 0/3 0/3 Neg. 

Streptococcus Isolate 0/3 0/3 Neg. 
Influenza A(H1N1) Isolate 0/3 0/3 Neg. 
Influenza A(H3N2) Isolate 0/3 0/3 Neg. 
Influenza B Isolate 0/3 0/3 Neg. 
Human adenovirus, 
type 1 Ad71 Isolate 0/3 0/3 Neg. 

Human 
metapneumovirus Isolate 0/3 0/3 Neg. 

Respiratory syncytial 
virus Long A Isolate 0/3 0/3 Neg. 

Rhinovirus Isolate 0/3 0/3 Neg. 
Parainfluenza 1 C35 Isolate 0/3 0/3 Neg. 
Parainfluenza 2 Greer Isolate 0/3 0/3 Neg. 
Parainfluenza 3 C-43 Isolate 0/3 0/3 Neg. 
Parainfluenza 4 M-25 Isolate 0/3 0/3 Neg. 

Clinical Evaluation 
The performance of Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit with nasopharyngeal swab 
clinical samples was evaluated using 34 individual negative clinical samples and 34 confirmed 
positive clinical samples. Samples procured by iSpecimen (Lexington, MA) were collected from 
patients with signs and symptoms of an upper respiratory infection.  The samples were collected 
by qualified personnel according to the package insert of the collection device and stored frozen 
at -80°C. The positive specimens represented a wide range of viral load and included low positive 
samples.  The samples were provided with results obtained using a high sensitivity, EUA 
authorized molecular comparator assay. 

Nucleic acid was purified from the 68 clinical samples using the QIAGEN QIAamp Viral RNA Mini 
Kit using a sample volume of 140 µl and an elution volume of 60 µl. The samples were randomized, 
blinded, and assessed with Bio-Rad's Reliance SARS-CoV-2 RT-PCR Assay Kit using Bio-Rad's 
CFX384 Touch instrument, which had the highest LOD of the instruments tested. The QIAGEN 
QIAamp Viral RNA Mini extraction method was utilized for the clinical evaluation study because 
the LOD was within 2X of the LoD established with the MagMAX Viral/Pathogen Nucleic Acid 
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Isolation Kit extraction method across tested instruments.  Results obtained from samples tested 
using the Bio-Rad's Reliance SARS-CoV-2 RT-PCR Assay Kit were compared to the results obtained 
from the EUA authorized molecular comparator assay. 

Clinical study results (Table 18) show a 100% percent positive agreement (PPA) with a 95% 
confidence interval of 89.9% - 100% and a 100% negative percent agreement (NPA) with a 95% 
confidence interval of 89.9% - 100%. 

Table 18.  PPA and NPA of the Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit against comparator 
Reliance SARS-
CoV-2 RT-PCR 

Comparator 
Test Positive 

Comparator 
Test Negative Total PPA [95% CI] NPA [95% CI] 

Test positive 34 0 34 

100% 
[89.9%-100%] 

100% 
[89.9%-100%] 

Inconclusive 0 0 0 

Test negative 0 34 34 

Total 34 34 68 

There were two discordant results (Case ID 751 & 761) on initial testing; the Bio-Rad Reliance 
SARS-CoV-2 RT-PCR Assay Kit was inconclusive and the molecular comparator assay was negative. 
Both samples were re-extracted and re-tested in three replicates using the Bio-Rad Reliance SARS-
CoV-2 RT-PCR Assay Kit as per the assay instructions for use.  Repeat testing of the Bio-Rad 
Reliance SARS-CoV-2 RT-PCR Assay Kit resolved the inconclusive result and confirmed the sample 
was negative. Additionally, both of the samples (Case ID 751 & 761) were confirmed negative by 
two additional EUA authorized molecular comparator assays. 

FDA SARS-CoV-2 Reference Panel Testing 

The evaluation of sensitivity and MERS-CoV cross-reactivity was performed using reference 
material (T1), blinded samples and a standard protocol provided by the FDA. The study included 
a range finding study and a confirmatory study for LoD. Blinded sample testing was used to 
establish specificity and to corroborate the LoD. The extraction method and instrument used were 
QIAGEN QIAamp Viral RNA Mini and the CFX384 Touch instrument. The results are summarized in 
Table 17. 
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Table 17: Summary of LoD Confirmation Result Using the FDA SARS-CoV-2 Reference Panel 
Reference Materials 

Provided by FDA Specimen Type Product LoD Cross-Reactivity 

SARS-CoV-2 Nasopharyngeal Swab 1.8x103 NDU/mL N/A 
MERS-CoV N/A ND 

NDU/mL: RNA NAAT detectable units/mL 
N/A: Not Applicable 
ND: Not Detected 

References 
1. Center for Disease Control and Prevention. Biosafety in Microbiological and Biomedical 

Laboratories, 5th Edition. U.S. Department of Health and Human Services, Public Health Service, 
Centers for Disease Control and Prevention, National Institutes of Health HHS Publication No. (CDC) 
21-1112, revised December 2009. 

2. Clinical and Laboratory Standards Institute (CLSI). Protection of Laboratory Workers from 
Occupationally Acquired Infections. Approved Guideline-Fourth Edition. CLSI Document M29-A4: 
Wayne, PA; CLSI, 2014. 
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Appendix A: AB7500 Real-Time PCR System Qualification 

Purpose 
This appendix is intended to provide a qualification procedure describing how to prepare a panel 
of mock specimens for use in verifying performance of the AB7500 Fast Real-Time PCR System 
with the Bio-Rad Reliance SARS-CoV-2 RT-PCR Assay Kit by the end user. Qualification of the 
AB7500 Fast Real-Time PCR System with the Bio-Rad Reliance SARS-CoV-2 Assay Kit must be 
achieved prior to usage for diagnostic testing. 

Required Materials 
Description Quantity Included in the kit 

Exact Diagnostics SARS-CoV-2 Standard 1 vial Yes 
Exact Diagnostics SARS-CoV-2 Negative 1 vial Yes 
Phosphate buffered saline (PBS, pH 7.4) 3 mL* No 

*The quantity indicated is for preparing one set of 9 mock specimens 

Precautions 
The positive control provided with the Reliance SARS-CoV-2 RT-PCR Assay Kit is comprised of 
RNA transcript encoding the SARS-CoV-2 (SC2) N1 and N2 genes and human genomic DNA for 
the RNaseP (RP) gene amplification.  This control is non-infectious. Both the Exact Diagnostics 
SARS-CoV-2 Standard and Negative controls are single use only; do not refreeze.  The Reliance 
SARS-CoV-2 RT-PCR Assay Kit should be handled in accordance with Good Laboratory Practices. 

The control materials and other kit components must be stored at appropriate temperatures, as 
described in the Instruction for Use (IFU) and be kept on ice once thawed. The extracted RNA 
samples should be kept cold during preparation and use. 

Instructions for Preparing Mock Specimens Before Extraction with the QIAGEN 
QIAamp Viral RNA Mini Kit 

1. Prepare sufficient Buffer AVL (with carrier RNA) for 9 samples, according to 
manufacturer’s instructions. 

2. Label three 1.5ml RNase-free tubes as A, B, and C. Label nine 1.5 ml tubes as 1-9. 
3. Aliquot 995 μL of PBS into Tube “A” then add 5 μL of Exact Diagnostics SARS-CoV-2 

Standard. Mix well. 
4. Aliquot 900 μL of PBS into Tube “B” then add 100 μL of Tube “A”. Mix well. 
5. Aliquot 995 μL of PBS into Tube “C” then add 5 uL of Exact Diagnostics SARS-CoV-2 

Negative. Mix well. 
6. Aliquot 560 μL of Buffer AVL containing carrier RNA into each of nine tubes labeled 1-9. 
7. Add 140 μL of Tube A into each of the tubes 1-3. 
8. Add 140 μL of Tube B into each of the tubes 4-6. 
9. Add 140 μL of Tube C into each of the tubes 7-9. 
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10. Extract the samples using the QIAamp Viral RNA Mini Kit following the manufacturer's 
instructions, eluting the samples in 60 uL of AVE. 

Instructions for Preparing Mock Specimens Before Extraction with the Thermo 
Fisher MagMAX Viral/Pathogen Nucleic Acid Isolation Kit 

1. Label three 1.5ml RNase-free tubes as A, B, and C. 
2. Aliquot 995 μL of PBS into Tube “A” then add 5 μL of Exact Diagnostics SARS-CoV-2 

Standard. Mix well. 
3. Aliquot 900 μL of PBS into Tube “B” then add 100 μL of Tube “A”. Mix well. 
4. Aliquot 995 μL of PBS into Tube “C” then add 5 uL of Exact Diagnostics SARS-CoV-2 

Negative 
5. Aliquot 10 μL of Proteinase K from the MagMAX Viral/Pathogen Nucleic Acid Isolation Kit 

into each of nine wells, designated 1-9, of a deep-well 96-well plate 
6. Add 200 μL of tube A into each of the wells 1-3. 
7. Add 200 μL of tube B into each of the wells 4-6. 
8. Add 200 μL of tube C into each of the wells 7-9. 
9. Extract the samples using the MagMAX Viral/Pathogen Nucleic Acid Isolation Kit 

following the manufacturer's instructions, eluting the samples in 100 μL of Elution 
Solution. 

Test of extracted samples 
Follow the Reliance SARS-CoV-2 RT-PCR Kit IFU for testing each of the moderate concentration, 
low concentration, and negative samples at least once using the AB7500 Fast Real-Time PCR 
System. 

Expected Results 
Tubes 1-3 and wells 1-3 contain moderate concentration of SC2 (approximately at 4xLoD) and 
should be positive for N1, N2, and RP. 

Tubes 4-6 and wells 4-6 contain low concentration of SC2 (approximately at 0.4xLoD) and should 
be positive for N 1, N2, and RP. 

Tubes 7-9 and wells 7-9 are negative samples and should be negative for N1 and N2 but positive 
for RP. 

Acceptance Criteria: 

Negative samples (Tubes 7-9): 100% (3/3) should be in agreement with expected results. 

Moderate Positive Samples (Tubes 1-3): 100% (3/3) should be in agreement with expected 
results 

Low Positive Samples (Tubes 4-6): At least 66% (2/3) should be in agreement with expected 
results. 
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Successful qualification is required prior to use of the AB7500 Fast Real-Time PCR System with 
the Reliance SARS-CoV-2 RT-PCR Assay Kit for diagnostic testing. 

Questions 
If you have questions or comments about these instructions, please contact Bio-Rad Technical 
Support, which is open Monday through Friday, 5:00 AM to 5:00 PM, Pacific Time. (US). 

Phone: 1-800-424-6723, option 2 

Email: Support@Bio-Rad.com (U.S./Canada only) 

For technical assistance outside the U.S. and Canada, contact your local technical support office 
or click the Contact Us link at bio-rad.com. 
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Appendix B: Additional Label 

For CFX96 Touch, CFX384 Touch, CFX Opus 96, CFX Opus 384, and 
Qualified* AB7500 Fast Real-Time PCR Systems 

Please print and place this label on the front panel of the instrument. If the instruments include 
labeling indicating “For Research Use Only”, please cover with the below “Emergency Use Only” 
labeling. The instrument should retain this labeling throughout the EUA use of the Bio-Rad 
Reliance SARS-CoV-2 RT-PCR Assay Kit. 

* Refer to Appendix A: AB7500 Real-Time PCR System Qualification for instructions 

Emergency Use Only 
This instrument is authorized for use with Bio Rad 

Reliance SARS CoV 2 RT PCR Assay Kit 
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Bio-Rad Technical Support 
The Bio-Rad Technical Support department in the U.S. is open Monday through Friday, 5:00 AM to 

5:00 PM, Pacific Time. 

Phone: 1-800-424-6723, option 2 

Email: Support@bio-rad.com (U.S./Canada Only) 

For technical assistance outside the U.S. and Canada, contact your local technical support office or 
click the Contact us link at www.bio-rad.com. 

Notice 

No part of this publication may be reproduced or transmitted in any form or by any means, 
electronic or mechanical, including photocopy, recording, or any information storage or retrieval 
system, without permission in writing from Bio-Rad. 

Bio-Rad reserves the right to modify its products and services at any time. This guide is subject to 

change without notice. Although prepared to ensure accuracy, Bio-Rad assumes no liability for 
errors or omissions, or for any damage resulting from the application or use of this information. 

BIO-RAD, HARD-SHELL, and MICROSEAL are trademarks of Bio-Rad Laboratories, Inc. in certain 

jurisdictions. 

SYBR is a trademark of Thermo Fisher Scientific Inc. Bio-Rad Laboratories, Inc. is licensed to sell 
reagents containing SYBR Green I for use in real-time PCR, for research purposes only. 

All trademarks used herein are the property of their respective owner. 

Copyright © 2020 by Bio-Rad Laboratories, Inc. All rights reserved. 
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Safety and Regulatory Compliance 
The CFX Opus real-time PCR system heats and cools very quickly during operation. Bio-Rad strongly 

recommends that you follow the safety specifications listed in this chapter and throughout this guide. 

Note: Use only Bio-Rad–supplied USB cables (catalog #12012942) when using the CFX 

Opus real-time PCR system. 

Safety Warning Labels 

Warning labels posted on the CFX Opus real-time PCR system and in this manual warn you about 
sources of injury or harm. Table 1 defines each safety warning label. 

Table 1. General safety warnings 

Icon Meaning 

Operating the CFX instrument before reading this manual can constitute a 

personal injury hazard. The use of this instrument in a manner not specified in 

this manual or by Bio-Rad may result in the protection features of the instrument 
becoming impaired or disabled. 

There are no biohazards or radioactive hazards associated with the CFX 

instrument itself. These hazards only become a concern when they are 

introduced into the system via the samples being tested. When handling 

biohazardous or radioactive samples, adhere to the recommended precautions 

and guidelines specific to your laboratory and location. These guidelines should 

include cleaning, monitoring, and disposal methods for the hazardous 

material(s) you are using. 

In addition, as identified above, there is a small risk of explosion, or of expulsion 

of liquids or vapors from the sample container(s). When working with hazardous 

materials the risk of injury from expelled material is compounded with the risk 

that the hazardous material themselves could be dispersed in and around the 

instrument. Users should take appropriate precautions for such a situation. 
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Safety and Regulatory Compliance 

Table 1. General safety warnings, continued 

Icon Meaning 

The CFX operates at temperatures high enough to cause serious burns. Always 

allow the reaction block to return to room temperature before opening the lid and 

removing samples. Even after the reaction block has cooled, the surrounding 

areas as well as the heater plate can remain hot for quite some time. In 

situations where there is not sufficient time to allow the instrument to cool, the 

use of protective equipment such as thermal gloves or “oven mitts” is 

recommended. 

The safety and performance of any system incorporating a CFX instrument is 

solely the responsibility of the assembler of the system. 

The CFX instrument can become hot enough during the course of normal 
operation to cause liquids in the samples to boil or vaporize, pressurizing the 

sample containers. There is the possibility that the sample container(s) could fail; 
leading to leaks, fluid spray, or explosive rupture and expelling vapors or liquids 

in and around the instrument. 

Users should always operate the instrument with the lid closed or wear safety 

goggles, thermal gloves, and other personal protection equipment during 

operation to avoid injury. Opening the instrument while samples are still hot, 
such as after aborting a run, can allow pressurized containers to leak, spray, or 
spurt liquid. Always allow the samples to cool before opening the lid. 

Users should never run a reaction with a lid or seal that is open, loose, 
punctured, or otherwise damaged because it will increase the likelihood of a 

dangerous rupture or explosion. 

Users should never run a reaction with volatile reagents that could increase the 

likelihood of a dangerous rupture or explosion. 
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Safety and Regulatory Compliance 

Safety and Regulatory Compliance 

The CFX Opus real-time PCR system has been designed to be safely operated under the 

environmental conditions listed in Table 2. 

Table 2. Conditions for safe use 

Usage Aspect Conditions for Safe Use 

Rated input power 100–240 VAC ±10%, 50–60 Hz, 850 W Max 

Overvoltage category II 

Fuses 10 A, 250 V, 5 x 20 mm, fast blow (qty. 2) 

Environment Indoor use only 

Operating temperature 15–31°C (operation over the range of 5°C–40°C is safe, but the 

instrument may not meet performance specifications) 

Relative humidity Up to 80% (noncondensing) 

Altitude Up to 2,000 meters above sea level 

Pollution degree 2 

Safety Compliance 

The CFX Opus real-time PCR system has been tested and found to be in compliance with all 
applicable requirements of the following safety and electromagnetic standards: 

n IEC 61010-1:2010 Safety requirements for electrical equipment for measurement, control, and 

laboratory use, Part 1: general requirements 

n IEC 61010-2-010:2014 Safety requirements for electrical equipment for measurement, control 
and laboratory use — Part 2-010: Particular requirements for laboratory equipment for the 

heating of materials 

n IEC 61010-2-081:2015 Safety requirements for electrical equipment for measurement, control 
and laboratory use — Part 2-081: Particular requirements for automatic and semi-automatic 

laboratory equipment for analysis and other purposes 
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n CAN/CSA-C22.2 NO. 61010-1-12:2018 Safety requirements for electrical equipment for 
measurement, control, and laboratory use, Part 1: General Requirements 

n CAN/CSA-C22.2 NO. 61010-2-010:15 Safety requirements for electrical equipment for 
measurement, control, and laboratory use, Part 2-010: Particular requirements for laboratory 

equipment for the heating of materials 

n CAN/CSA-C22.2 NO. 61010-2-081:15 Safety requirements for electrical equipment for 
measurement, control, and laboratory use, Part 2-081: Particular requirements for automatic 

and semi-automatic laboratory equipment for analysis and other purposes 

n EN 61010-1:2010 Safety requirements for electrical equipment for measurement, control, and 

laboratory use, Part 1: General requirements 

n EN 61010-2-010:2014 Safety requirements for electrical equipment for measurement, control 
and laboratory use — Part 2-010: Particular requirements for laboratory equipment for the 

heating of materials 

n EN 61010-2-081:2015 Safety requirements for electrical equipment for measurement, control 
and laboratory use — Part 2-081: Particular requirements for automatic and semi-automatic 

laboratory equipment for analysis and other purposes 

n UL 61010-1:2012 Safety requirements for electrical equipment for measurement, control and 

laboratory use — Part 1: General Requirements 

n UL 61010-2-010:2019 Safety requirements for electrical equipment for measurement, control 
and laboratory use — Part 2-010: Particular requirements for laboratory equipment for the 

heating of materials 

n UL 61010-2-081:2015 Safety requirements for electrical equipment for measurement, control 
and laboratory use — Part 2-081: Particular requirements for automatic and semi-automatic 

laboratory equipment for analysis and other purposes 
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Safety and Regulatory Compliance 

Electromagnetic Compatibility (EMC) 
The CFX Opus real-time PCR system has been tested and found to be in compliance with all 
applicable requirements of the following electromagnetic compatibility standards: 

n IEC 61326-1:2012 Electrical equipment for measurement, control and laboratory use 

n EN 61326-1:2013 Electrical equipment for measurement, control and laboratory use — EMC 

requirements — Part 1: General requirements. Tested as a Class A device 

n FCC Part 15, Subpart B, Sections 15.107 and 15.109. Tested as a Class A digital device 

n CAN ICES-003v6:2019 Interference-causing equipment standard, information technology 

equipment (including digital apparatus) — Limits and methods of measurement. Tested to 

Class A limits 

EMC Warnings and Notes 

n Warning: Changes or modifications to this unit, not expressly approved by Bio-Rad, could void 

the user’s authority to operate the equipment. 

n Note: This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable 

protection against harmful interference when the equipment is operated in a commercial 
environment. This equipment generates, uses, and can radiate radio frequency energy and, if 
not installed and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a residential area is 

likely to cause harmful interference, in which case the user will be required to correct the 

interference at their own expense. 

n Note regarding FCC compliance: Although this instrument has been tested and found to 

comply with Part 15, Subpart B of the FCC Rules for a Class A digital device, please note that 
this compliance is voluntary, for the instrument qualifies as an “exempted device” under 47 

CFR 15.103(c), in regard to the cited FCC regulations in effect at the time of manufacture. 

n Note regarding cables: This instrument was tested for EMC compliance using specially 

designed USB cables, which are supplied with the instrument. These cables, or Bio-Rad 

authorized replacements, must be used with this instrument to ensure continued compliance 

with the EMC emissions limits. 
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Safety and Regulatory Compliance 

Hazards 

The CFX Opus real-time PCR system is designed to operate safely when used in the manner 
prescribed by the manufacturer. If the CFX Opus real-time PCR system or any of its associated 

components is used in a manner not specified by the manufacturer, the inherent protection 

provided by the instrument may be impaired. Bio-Rad is not liable for any injury or damage caused 

by the use of this equipment in any unspecified manner, or by modifications to the instrument not 
performed by Bio-Rad or an authorized agent. Service of the CFX Opus real-time PCR system 

should be performed only by trained Bio-Rad personnel. 

Biohazards 

The CFX Opus real-time PCR system is a laboratory product. However, if biohazardous samples 

are present, adhere to the following guidelines and comply with any local guidelines specific to 

your laboratory and location. 

Note: No biohazardous substances are exhausted during normal operations of this 

instrument. 

General Precautions 

n Always wear laboratory coat, laboratory gloves, and safety glasses with side shields or 
goggles. 

n Keep your hands away from your mouth, nose, and eyes. 

n Completely protect any cut or abrasion before working with potentially infectious materials. 

n Wash your hands thoroughly with soap and water after working with any potentially infectious 

material before leaving the laboratory. 

n Remove wristwatches and jewelry before working at the bench. 

n Store all infectious or potentially infectious material in unbreakable leak-proof containers. 

n Before leaving the laboratory, remove protective clothing. 

n Do not use a gloved hand to write, answer the telephone, turn on a light switch, or touch 

anything that other people may touch without gloves. 

n Change gloves frequently. Remove gloves immediately when they are visibly contaminated. 

n Do not expose materials that cannot be properly decontaminated to potentially infectious 

material. 

n Upon completion of an operation involving biohazardous material, decontaminate the work 

area with an appropriate disinfectant (for example, a 1:10 dilution of household bleach). 
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Hazards 

Surface Decontamination 

WARNING! To prevent electrical shock, always turn off and unplug the instrument 
prior to performing decontamination procedures. 

The following areas can be cleaned with any hospital-grade bactericide, virucide, or fungicide 

disinfectant: 

n Outer lid and chassis 

n Inner reaction block surface and reaction block wells 

n Control panel and display 

To prepare and apply the disinfectant, refer to the instructions provided by the product 
manufacturer. Always rinse the reaction block and reaction block wells several times with water 
after applying a disinfectant. Thoroughly dry the reaction block and reaction block wells after 
rinsing with water. 

Important: Do not use abrasive or corrosive detergents or strong alkaline solutions. These 

agents can scratch surfaces and damage the reaction block, resulting in loss of precise 

thermal control. 

Disposal of Biohazardous Material 

Dispose of the following potentially contaminated materials in accordance with laboratory local, 
regional, and national regulations: 

n Clinical samples 

n Reagents 

n Used reaction vessels or other consumables that may be contaminated 

Chemical Hazards 

The CFX Opus real-time PCR system contains no potentially hazardous chemical materials. 

Explosive or Flammability Hazards 

The CFX Opus real-time PCR system poses no uncommon hazard related to flammability or 
explosion when used in a proper manner as specified by Bio-Rad Laboratories. 
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Safety and Regulatory Compliance 

Electrical Hazards 

The CFX Opus real-time PCR system poses no uncommon electrical hazard to operators if 
installed and operated properly without physical modification and connected to a power source of 
proper specification. 

Transport 
Before moving or shipping the CFX Opus real-time PCR system decontamination procedures must 
be performed. Always move or ship the system in a separate container(s) in the Bio-Rad-supplied 

packaging material, which will protect the system from damage. 

For information about transporting the system and to request the appropriate packaging material, 
contact your local Bio-Rad office. 

Battery 

This CFX Opus real-time PCR system uses two 3 V lithium-metal coin cell batteries to maintain 

time settings in the event of AC power loss. If the time does not remain set after the unit is turned 

off, it may be an indication that the batteries are getting weak. 

WARNING! Do not attempt to change the batteries, they are not user serviceable. 
Instead, contact Bio-Rad Technical Support for assistance. 

For the State of California, USA only 

n Perchlorate material — Lithium batteries contain perchlorate material, special handling may 

apply. See www.dtsc.ca.gov/hazardouswaste/perchlorate 

Disposal 
The CFX Opus real-time PCR system contains electrical materials; they should not be disposed of 
as unsorted waste and must be collected separately, according to European Union Directive 

2012/19/EU on waste electrical and electronic equipment — WEEE Directive. Before disposal, 
contact your local Bio-Rad representative for country-specific instructions. 
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Chapter 1 Introduction 
The CFX Opus instrument is a real-time PCR system with an integrated 96-well or 384-well optical 
reaction module, depending on the model. 

This guide explains how to set up and use the CFX Opus system to perform sensitive quantitative 

PCR. 

Main Features 

The main features of the CFX Opus system include: 

n Connectivity to Bio-Rad's BR.io app in order to manage PCR file management and data 

analysis 

Using the BR.io app, you can create real-time PCR experiments in the app, download and run 

them on your registered CFX Opus system, and then analyze the results in the BR.io app. 

For more information about Bio-Rad‘s BR.io app, go to BR.io. From the BR.io Home page, you 

can 

o Explore the BR.io app via video 

o Access helpful BR.io guides 

To register for a BR.io account, see your company’s IT administrator. 

n Wireless and WLAN Ethernet network compatibility enables connectivity to your internal 
network for unlimited data access and storage on shared network drives as well connectivity to 

your BR.io cloud account 

n USB drive compatibility provides an optional medium for protocol transfer and data storage 

n USB ports enable direct connectivity to a computer running CFX Maestro software 

n Programmable temperature gradient to quickly and easily identify optimal annealing 

temperatures 
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Performance Specifications 

CFX Opus system components provide sensitive detection for precise quantification and target 
discrimination. The tables in this section list the reaction module and optical detection performance 

specifications for both the CFX Opus 96 and CFX Opus 384 real-time PCR systems. 

Reaction Module Performance Specifications 

Table 3. CFX Opus system reaction module specifications 

Item Specification 

CFX Opus 96 systems CFX Opus 384 systems 

Volume 1–50 µl 1–30 µl 

(10–50 µl Recommended) (5–30 µl Recommended) 

Maximum ramp rate 5°C/sec 2.5°C/sec 

Average ramp rate 3.3°C/sec 2.0°C/sec 

Lid temperature 30–110°C 

Heating and cooling method Peltier 

Temperature range 4–100°C 

Increment -10°C to 10°C/cycle 

Gradient 

Operational range 30–100°C 

Programmable span 1–24°C 

Temperature accuracy ±0.2°C of programmed target at 90°C 

Temperature uniformity ±0.3°C well-to-well within 10 sec of arrival at 90°C 
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Finding Out More 

Optical Detection Performance Specifications 

Table 4. CFX Opus optical detection specifications 

Item Specification 

CFX Opus 96 systems CFX Opus 384 systems 

Excitation 6 filtered LEDs 5 filtered LEDs 

Detection 6 filtered photodiodes 5 filtered photodiodes 

Range of excitation/emission 

wavelengths 
450–730 nm 450–690 nm 

Multiplex analysis 5 targets per well 4 targets per well 

Scan time 

All channels 

Single-channel fast scan 

FRET 

12 sec 

3 sec 

Yes 

<20 sec 

8 sec 

Yes 

Sensitivity Detects 1 copy of target sequence in 

human genomic DNA 

Dynamic range 10 orders of magnitude 

Finding Out More 

The CFX Maestro system web site (bio-rad.com/CFXOpus) provides access to technical notes, 
manuals, product information, and technical support. This site also provides many technical 
resources on a wide variety of methods and applications related to real-time PCR. 
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Chapter 2 Setting Up the CFX Opus System 
This chapter explains how to set up the CFX Opus system at your site. 

Tip: Before setting up the CFX Opus system, familiarize yourself with the system and its 

reaction module, ports, and accessories. 

Site Requirements 

The tables in this section list the room, environment, power, and networking requirements 

necessary to successfully install and use the CFX Opus system. For weight and dimensions of the 

packaged instrument, see Unpacking the System on page 26. 

Note: Install your CFX Opus system on a flat, dry surface with sufficient cool airflow for it to run 

properly. 

Bench Space Requirements 

Caution: The CFX Opus system requires at least 10 cm behind and at 
least 5 cm along one side or the top to allow exhaust air to flow properly. 

Additionally, ensure you provide sufficient space around the system to disconnect the power 
cord or to access the power switch in case of an emergency. 

Note: If you plan to connect the CFX Opus system to the computer running CFX Maestro, 
ensure during setup that you have sufficient space near the system for the computer. 

Table 5. CFX Opus system bench space requirements 

Item 

Dimensions 

Specification 

W: 13 in; 33 cm 

D: 22 in; 56 cm 

H: 14 in; 36 cm 

Weight 48 lb; 22 kg 
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Environment Requirements 

Table 6. CFX Opus system environment requirements 

Parameter 

Operating conditions 

Range 

15 to 31°C 

59 to 87.8°F 

Humidity Range 

0–80% RH, non-condensing 

Storage conditions –20 to 60°C 

–4 to 140°F 

0–80% RH, non-condensing 

Power Requirements 

Power to the CFX Opus system must be stable and within specifications to ensure proper 
operation. The power cord connected to the power inlet port must be rated for 10 amps or more. 

Table 7. CFX Opus power requirements 

Item Specification 

Input voltage 100–240 VAC ±10%; 50–60 Hz, single phase 

Maximum power usage <850 watts 

Number of power sockets n 1 socket for the CFX Opus system 

n (Optional) 1 socket for the computer running CFX Maestro 

software 
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Network Requirements 

The CFX Opus system supports connectivity through Ethernet, USB, and wireless networking. 

Table 8. CFX Opus system networking requirements 

Item Specification 

Ethernet port 10/100 BASE-T (RJ45)* 

USB ports USB 2.0 type A (two on rear panel, one on front panel) 

USB 2.0 type B (one on rear panel) 

Wireless connectivity Requires the CFX Opus Wi-Fi adaptor appropriate for your 
locale 

(See your Bio-Rad Sales representative for more 

information.) 

Supports IEEE 802.11b/g/n 2.4 GHz, and IEEE 802.11 

a/n/ac 5 GHz standards.* 

USB barcode scanner Scanner must be compatible with Microsoft Windows 10 

(optional) 

* Default network support is DHCP. For information about configuring a static IP connection, see 

Setting Up a Network Connection on page 56 
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Chapter 2 Setting Up the CFX Opus System 

System Overview 

The illustrations in this section display the main components of the system. 

Front View 

LEGEND 

1. Touch screen display 2. Reaction block 

3. Retractable lid (partially retracted) 4. LED system status bar 

5. Air intake vents 6. USB A port 

Details 

n Touch screen display — provides access to all functions necessary to create and run 

protocols. 

n Reaction block — holds the 96– or 384–well plate, depending on the instrument. 

n Retractable lid — provides access to the reaction block. 

Note: The CFX Opus instrument does not have a manual open/close button on the lid. To 

open or close the lid, use the button on the Home screen, Run Setup screen, or Run 

Status screen, or use the lid control in the CFX Maestro software. 
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System Overview 

n LED system status bar — indicates system status: 

o Green (constant) — run is in progress. 

o Green (flashing) — run is paused. 

o Blue (flashing) — lid is opening (flashes until lid is fully open); run has completed (flashes 

until lid is opened). 

o Red (flashing) — system error. 

o OFF — system is idle (not executing a run, lid not moving) or system is shut down. 

n Air intake vents — allow the system to heat and cool quickly. 

Important: Keep all air vents clean and clear of obstruction. Do not 
insert any object in the air vents while the system is operating. Fans or 
other internal moving parts may collide with the object and cause 

personal injury or damage the system. Conductive objects could contact 
internal circuitry and cause damage to the system. 

n USB A port — connects the CFX Opus system to a USB drive, mouse, keyboard, CFX Opus 

Wi-Fi adaptor, or barcode scanner. 

Special Considerations Regarding the CFX Opus Touch Screen 

The following are special consideration regarding the CFX Opus instrument’s touch screen. If you 

have any questions regarding the touch screen, contact Bio-Rad Technical Support. 

WARNING! If any liquid leaks out of a damaged glass cell and comes in contact with 

your skin, wash thoroughly with soap and water. 

Notes: 

n A strong incident light shining on the touch screen for extended periods of time may 

degrade the quality and performance of the display. 

n Do not expose the touch screen to strong ultraviolet rays or direct sunlight for long periods 

of time. 

n Do not touch or scratch the surface of the touch screen with any hard object. 
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n The touch screen self-calibrates the first few seconds after turning on the instrument. 
During this process, do not 

o Touch the surface of the touch screen 

o Place your hands near the surface of the touch screen 

If it cannot successfully calibrate during system initialization, the touch screen might not 
work properly for some time. If the problem persists, turn off and on the system or contact 
Bio-Rad Technical Support for assistance. 
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System Overview 

Back View 

LEGEND 

1. Power input 

3. Fuses 

5. USB Type A ports 

2. Power switch 

4. Cooling vents 

6. USB Type B port 

7. Ethernet port 

Details 

n Power input — connects to AC power. 

n Power switch — turns on or off power to the CFX Opus system. 

n Fuses — provides access to the fuses. 

n Cooling vents — cools the CFX Opus system. 

Important: Do not block the cooling vents. For optimal operation, ensure that air can 

circulate behind the CFX Opus system. 

n USB type A ports — transfer data to and from a USB flash drive or connect a USB mouse, 
keyboard, CFX Opus Wi-Fi adaptor, or barcode scanner. 

n USB type B port — connects the CFX Opus system to a computer running CFX Maestro 

software. 

n Ethernet port — connects the CFX Opus system to your network. 
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Unpacking the System 

This section explains how to properly unpack the CFX Opus instrument. Read this section before 

you unpack the system. 

Caution: The packaged CFX Opus instrument weighs approximately 57 lb (26 kg). Bio-Rad 

strongly recommends that you use a pallet jack to move the instrument from the shipping dock 

to the laboratory. 

Important: Use proper lifting techniques when moving and lifting the 

instrument to prevent damage to the instrument and personal injury. 
Bio-Rad recommends that two or more people lift the instrument. 

Packaged Instrument Specifications 

Table 9 lists the specifications of the packaged CFX Opus instrument. For information about bench 

space specifications, see Site Requirements on page 19. 

Table 9. Specifications for the packaged CFX Opus instrument 

Parameter Specification 

Weight 57 lb; 26 kg 

Dimensions Depth: 28 in; 71 cm 

Width: 19 in; 48 cm 

Height: 19 in; 48 cm 

The image on page 27 depicts the CFX Opus instrument inside its packaging. 
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Unpacking the System 

Install the CFX Opus system on a flat, dry surface with sufficient cool airflow to run properly. The 

AC power cord is approximately 5’ in length. Ensure you have sufficient access to the power outlet 
before you unpack the system. 

Note: Ensure that there is enough clear space on the lab bench for your instrument plus 

additional space to maneuver it while installing cables and accessories. If you plan to operate 

the system via CFX Maestro, ensure you have space on the lab bench for the computer 
running CFX Maestro software. 

Caution: When handling the instrument, do not grip the LCD screen or retractable lid. To lift 
the instrument, position your hands underneath the right and left sides of the instrument. 

To unpack the system 

1. Ensure that the path from the shipping dock to the laboratory is clear of obstacles and can 

accommodate the packaged CFX Opus instrument and a pallet jack. 

2. Using a pallet jack, move the instrument container from the shipping dock to the laboratory. 

Important: Bio-Rad strongly recommends that you do NOT use a hand truck to move the 

packaged instrument. 

3. Release the instrument container next to the lab bench. 

4. Using two people, lift and place container onto the lab bench. 
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5. With scissors or a box cutter, cut and remove the exterior straps that secure the container top 

to the base. 

Tip: The exterior straps are very tight. Hold the straps securely while cutting to prevent 
injury. 

6. Remove the plastic clips on the bottom corners by firmly pinching the tabs together and pulling 

the clips straight out. 

7. Lift the large container top up and out of the base and place it to the side. 

You see the CFX Opus instrument wrapped in plastic sheeting and inserted into the foam 

packing structure. 
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8. Remove the top foam insert and place it to the side. 

9. Standing in front of the instrument, fold down the front of the cardboard base. 
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10. While another person holds the base, grasp the cardboard tray and slide the instrument 
completely out of the base. 

11. Using the lift points first on one side of the instrument and then the other, gently lift the 

instrument, remove the foam inserts, and place them to the side. 

12. Using two people, carefully lift the instrument and remove the cardboard tray. 

13. Slide the plastic cover toward the back of the instrument to remove. 

14. Inspect the instrument for any damage. 
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Chapter 2 Setting Up the CFX Opus System 

Connecting the Power and Communication Cables 

After you unpack the CFX Opus and install it on the lab bench, you will need to connect the power 
cord and (optionally) the communication cables. This section explains how to connect the cables. 

Tip: Before connecting the cables, familiarize yourself with the CFX Opus system, its 

accessory kit, and power switches. 

Important: Ensure you have enough room on the lab bench to reach the power switch on the 

back of the system after connecting the power cord and USB Type B and Ethernet cables. Use 

only the Bio-Rad-supplied power cord and USB Type B and Ethernet cables. 

To connect the CFX Opus power and communication cables 

1. Locate the accessory kit that shipped inside the CFX Opus container. 

2. Remove the AC power cord and the USB and Ethernet cables from the accessory kit. 

Tip: Store the packing material for future use. If any item is missing or damaged, contact 
your local Bio-Rad office. 

3. Insert one end of the AC power cord into the power inlet port on back of the system. 

4. Insert the other end of the AC power cord into an available grounded, surge-protected AC 

outlet. 

5. (Optional) If you plan to connect the CFX Opus system to a computer running CFX Maestro 

software, insert the male end of the supplied USB Type B cable into the USB Type B port on 

the back of the system. 

6. (Optional) If you plan to connect CFX Opus to your internal network, insert the Ethernet cable 

into the Ethernet port on the back of the system. 
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Removing the Shipping Screw 

Important: The CFX Opus system ships with a red shipping screw inserted in the side of the 

lid to stabilize it during transport. You must remove the shipping screw before you can operate 

the system. 

To remove the shipping screw 

1. Locate the shipping screw plug that ships with the CFX Opus instrument. 

Tip: This might be located in a plastic sheath taped to the front or side of the instrument. 

2. Ensure the power cord is properly inserted into the power input on the back of the instrument. 

3. If you have not yet done so, insert the other end of the power cord into an available grounded, 
surge-protected AC outlet. 

4. Press the power switch on the back of the instrument to start the CFX Opus system. 

5. The system recognizes that the shipping screw is inserted and displays a message on the 

touch screen instructing you to remove the screw. Tap OK. 

The Remove Shipping Screw instructions appear. 
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6. To remove the shipping screw, turn it counter-clockwise and then pull it straight out of the 

access hole. Set the screw in a safe place. 

Caution: Do not insert the shipping screw or any other object in the 

shipping screw hole while instrument is operating. Internal moving parts 

might collide with the object, which can cause personal injury or damage 

the system. 

7. Insert the shipping screw plug into the hole for the shipping screw. 

Tip: The plug helps to prevent contamination of internal components. 

8. On the Shipping Screw screen, tap Screw Removed to confirm the screw is removed. 

9. Tap Open Lid to open the lid. 

10. Remove the shipping plate from the reaction block, and set it in a safe place. 

Note: Save the screw and plate in a safe and accessible place. You must reinsert the 

shipping screw and shipping plate should you need to return the system for any reason. 
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11. On the Shipping Screw screen, tap Close Lid to close the lid. 

The CFX Opus system is ready to use and displays the Login screen. 
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Logging In to CFX Opus 

CFX Opus ships with three default users: Admin, System, and Guest. Users also have the option to 

create their own account when first logging in to the system. 

Tip: Creating user accounts on the CFX Opus system is optional. 

Any user can log in as Guest and access all protocols and runs in the Public folder including the 

qPCR files within the default Bio-Rad qPCR folder. 

Any user, including the Guest account, can create folders and protocols, edit protocol templates, 
and run protocols. When logged in as Guest, users can create subfolders in the Public folder and 

save their protocols and run files into the selected folder. 

Tip: All folders and files saved into the Public folder are available to all users of the CFX Opus 

system. 

CFX Opus automatically creates a personal folder for each user who creates their own user 
account. When logged in, users can create subfolders within their personal folder and save their 
protocols and run files into the selected folder. 

Note: For the Admin or Service user, all such files are saved into the respective folders. These 

folders are not accessible to any other user. 
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Starting the CFX Opus System 

To start the CFX Opus system 

u If you have not already done so, press the power switch on the back of the instrument to start 
the CFX Opus system. 

You see the CFX Opus startup screen. 

The system performs a series of initialization tests and then displays the Login screen. 
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Creating CFX Opus User Accounts 

Tip: Creating user accounts on the CFX Opus system is optional. 

When logged in to the CFX Opus system, you can 

n Create and manage a folder structure within a browser environment. 

n Create and edit protocols and then save them to their personal folders. 

n Run a protocol and save it to your personal folders. 

n Delete protocols and runs in your personal folders. 

n Copy a protocol or run file to a public folder or USB drive. 

n Connect to a shared folder on the network to store or access protocol and run files. 

n Connect to your BR.io account. 

n Execute pending runs and upload results to your BR.io account. 

n Create and change your password. 

This section explains how to create user accounts on the CFX Opus system. 

To create a new user 

1. Do one of the following: 

n Turn on the CFX Opus system. 

n On the Home screen, tap Logout to log out a currently logged in user. 

The Login list appears. 
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2. Tap the Create User icon: 

3. Using the alphanumeric keypad that appears, type a user name and then tap OK. 

The Password dialog appears. 

4. Do one of the following: 

n Enter and confirm a password using the alphanumeric keypad that appears, and then tap 

Save Password. 

CFX Opus passwords can be any combination of alphanumeric characters. Passwords 

must be between 4–50 characters. 

Note: If you plan to connect to a shared network folder or Bio-Rad’s BR.io app, you 

must have a password. 

n Tap Skip Password. 

Tip: You can create a password some other time by accessing Tools > User Profile. See 

Setting User Passwords on page 67 for more information. 

The Home screen appears and displays your user name next to the Logout button. 
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Logging In to CFX Opus 

When the CFX Opus starts, the Login list appears and displays the existing users with the most 
recent user at the top. 

Important: By default, the Admin account does not have a password. When accessed for the 

first time, Bio-Rad strongly recommends that you create a password for the Admin account and 

record the password in a password safe. Resetting a forgotten Admin password requires a 

phone call to Bio-Rad Technical Support. See Setting User Passwords on page 67 for more 

information. 

To log in to the Admin account when CFX Opus starts 

1. In the Login list, locate and tap Admin. 

2. When prompted, enter the Admin password using the alphanumeric keypad that appears and 

then tap OK. 

To log in to a User account when CFX Opus starts 

1. In the Login list, locate and tap your user name. 

2. If prompted, enter your password using the alphanumeric keypad that appears and then tap 

OK. 

Tip: After you create your user account, the keypad does not appear if you did not create a 

password. 
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To log in to the Guest account when CFX Opus starts 

u In the Login list, locate and tap Guest. 

Tip: The keypad does not appear because the Guest account does not have a password. 

To change users 

1. On the Home screen, tap Logout to log out the currently logged in user. 

The Login list appears. 

2. In the Login list, tap your user name. 

3. If prompted, enter your password using the alphanumeric keypad that appears and then tap 

OK. 

Tip: The keypad does not appear if the user account does not have a password. 

To log out 

u On the Home screen, tap Logout. 
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Loading Sample Plates 

Important: Bio-Rad strongly recommends that you use only low-profile plates and flat-cap 

tubes with the CFX Opus real-time PCR systems. Using high-profile plates can crush tubes. 
Using domed-cap tubes can negatively affect plate reads. 

For a list of plates and tubes compatible with the CFX Opus real-time PCR systems, visit us at 
www.bio-rad.com/cfxopus or contact your local Bio-Rad Sales representative. 

To ensure uniform heating and cooling of samples, plates must be in complete contact with the 

reaction block. To ensure adequate contact, do the following: 

n Confirm that the reaction block is clean before loading samples. 

n Firmly press the individual tubes, tube strips, or microplates into the block wells. 

n When using one or a few tubes, use the tube frame or load at least one empty tube in each 

corner of the block to ensure the lid exerts even pressure on individual tubes. 

Loading Plates into the Optical Reaction Module 

Caution: Never run a reaction with a lid or seal that is open, loose, punctured, or 
otherwise damaged. Doing so will increase the likelihood of a rupture, which could 

cause injury or contaminate the system. 

Important: When running the CFX Opus, always balance the tube strips or add capped tubes 

to the corner wells to ensure the heated lid applies even pressure across the block. 

To load plates into the optical reaction module 

1. To open the motorized lid, do one of the following: 

n On the Home screen, tap Open Lid. 

n On the Run Setup screen, tap Open Lid. 

n In the Detected Instruments pane in CFX Maestro software, click Open Lid. 

n On the Start Run tab in the software, click Open Lid. 

2. Place the microplate, individual tubes, or tube strips with sealed lids in the block. 

Important: Ensure that the tubes are completely sealed to prevent leakage. 

Tip: For optimal results, load sample volumes of 10–30 µl for the CFX Opus 96 system 

and 5–30 µl for the CFX Opus 384 system. 
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3. For accurate data analysis, verify that the orientation of reactions in the block is exactly the 

same as the orientation of the well contents in the plate layout in the BR.io app or in the CFX 

Maestro software. 

Tip: You can edit the well contents from your BR.io account or from CFX Maestro software 

before, during, or after the run. 

4. To close the motorized lid, do one of the following: 

n On the Home screen, tap Close Lid. 

n On the Run Setup screen, tap Close Lid. 

n In the Detected Instruments pane in CFX Maestro software, click Close Lid. 

n On the Start Run tab in the software, click Close Lid. 

Important: Ensure that nothing blocks the lid when it closes. Although there is a safety 

mechanism to prevent the lid from closing if it senses an obstruction, do not place 

anything in the way of the lid before closing. 
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Shutting Down the CFX Opus System 

Important: Follow these instructions to safely and completely shut down the CFX Opus 

system. 

To shut down the CFX Opus system 

1. Ensure that no protocol is running and the system is no longer in use. 

2. If you have not already done so, remove the samples from the block. 

a. On the Home screen, tap Open Lid to access the samples. 

b. Remove the samples from the block and then tap Close Lid. 

3. On the Home screen, tap Logout to log out of the system. 

4. On the Login screen, tap Shut Down ( ) to perform a soft shutdown of the system. 

5. When the CFX Opus system has completed the soft shutdown process, press the power switch 

on the back of the instrument to shut down the system. 
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After successfully installing the CFX Opus system, you can configure the system according to the 

requirements at your site. Using the system’s touch screen, the Admin user can perform the 

following tasks. 

n Set the CFX Opus system’s time zone and local time 

n Enable or disable the system’s screen saver 

n Rename the system 

n Set up network and wireless communication 

n Set up the email service 

n Connect the system to a computer running CFX Maestro 

As a CFX Opus user, you can 

n Create your own CFX Opus log-in account 

n Set or change your password 

n Set or change your email address 

n Connect to your Bio-Rad BR.io account 

n Set or change connection to a shared network folder 

As a CFX Opus Guest user, you can 

n Set or change your email account 

This chapter explains how to configure the CFX Opus system. 
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Touch Screen Overview 

This section provides an overview of the CFX Opus system touch screen features. 

LEGEND 

1. Connectivity and software version 2. Primary activity menu 

3. Instrument details 4. Current logged in user 

5. Open/close lid 

Details 

n Connectivity and software version — displays the current software version and the type of 
operational connection: 

o Network connection — indicates operational connection to either an Ethernet or wireless 

network: 

– Ethernet network connection 

– wireless network connection 
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o BR.io connection — the icon appears when the logged-in user is connected to the 

BR.io account. To manage the connection, see Connecting to Your Bio-Rad BR.io 

Account on page 72. 

o Software version — displays the touch screen software version. To manually install 
updates, see Upgrading System Software and Firmware on page 145. 

n Primary activity menu — provides quick access to the primary activities required to create 

and run protocols and manage the operation of the CFX Opus system. 

o New Protocol — opens the New Protocol screen in which you can create a new protocol. 
For details, see Creating Protocols on page 79. 

o Files — opens the File Browser, where you can manage your files and execute runs. For 
details on managing files, see Managing Files and Folders on page 121. 

o Tools — accesses menus from which users and administrators can perform system 

management operations. 

o Run Status — opens the Run Status screen to view the status of the current run. 

n Instrument status — identifies the system, its serial number, and current status. 

n Logout action/status — identifies the currently logged in user and enables the user to log out 
of the system 

o Logout — tap this button to log out of the system. The system then displays the Login list. 

Tip: To create a new user account, see Creating CFX Opus User Accounts on page 

38. 

o Logged in user — identifies the user currently logged in to the system. 

n Open/Close Lid — opens or closes the instrument lid. 

If the lid is closed, the label is Open Lid. If the lid is open, the label is Close Lid. For details on 

loading plates, see Loading Sample Plates on page 42. 
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Software Files 

Table 10 lists the CFX Opus file types. 

Table 10. CFX Opus file types 

File Type Icon Details 

Protocol Contains protocol setup details to perform a PCR run. 

Data Contains the results of an experiment run and PCR 

analysis. 

Pending run Contains setup details of a protocol that was created in the 

BR.io app. This file appears in the File Browser when you 

successfully connect to your BR.io account. 

JSON A read-only file, which contains the run file data that 
appear in the details pane in the File Browser when a run 

file is selected. This file is generated after a run 

completes. It is exported with the .zpcr file and saved with 

the data files when the Save Location is either a USB 

drive or a shared network folder. 
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Tools Screen 

From the Tools screen, users and administrators can access a variety of options. These options 

control the system. All options available to users are also available to administrators. Only those 

who log in with an administrator account have access to the Admin options. 

User Tools Screen Options 

Tip: You do not need to log in with a user account to access the User options. The Guest 
account can also access options on the Tools screen. 

To access the User Tools screen 

1. On the Home screen, tap Logout, and then log in with your user credentials. 

2. On the Home screen, tap Tools. 

The User Tools screen appears. 

n About — view the current software version, serial number, disk space capacity and 

availability, as well as total number of run hours and cycles the system has accumulated. 

n User Profile — view user profile options for password, email address, shared network drive, 
and (when registered) the BR.io account information. 

Note: The Guest user can set only their email address. 
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n Run Reports — view the run report for each protocol run on the system. Users can export a 

specific run report or all run reports to an attached USB drive. 

Tip: In addition to exporting run reports, Admin users can trim the list of run reports to 

remove older or invalid reports as well as recover the .zpcr file of selected runs. 

n System Logs — view two types of logs: 

o Messages Log — messages that occur during each run. 

o Usage Log — all events that occur during each run. 

Note: From this screen, logged in users can export all message and usage logs to an 

attached USB drive. Admin users can export all logs as well as clear all logs from the 

system. 

n Real-Time PCR Demo — view a demonstration of a real-time 96-well or 384-well SYBR® or 
multiplex PCR run on the touch screen. 

n Shipping Screw — view instructions for removing or installing the shipping screw. 
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Admin Tools Screen Options 

All options available to users are also available to administrators. Only those who log in as Admin 

have access to the Admin options. 

To access the Admin Tools screen 

1. If necessary, on the Home screen tap Logout, and log in as Admin. 

2. Tap Tools on the Home screen. 

The Tools screen appears and displays the Admin options. 

Tip: To view the standard User options, tap User on the bottom of the screen. 

n System Settings — from this screen, Admin users can 

o Set the time zone, date, and time on the system. 

o Enable or disable password requirement. 

Note: If a user creates a local user account without a password before you enable 

this requirement, that user will be prompted to create a password at the next log-in 

attempt. 
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o Enable or disable the screen saver and set its idle time. 

Note: The screen saver appears after the system has been idle for a specified 

amount of time. The screen saver does not appear while a run is in progress. 

o Rename the system. 

n Network Settings — view details about the current network connection; use this screen to 

connect the system to the internal network via wireless or Ethernet connection. 

n User Management — remove users and reset passwords. 

n Email Settings — set email server information. 

n System Updates — update the system software and firmware from an attached USB 

drive. 

Note: The CFX Opus installer can include both software and firmware updates. CFX 

Opus firmware updates are not distributed in a separate package. 

n Diagnostic Test — perform a series of diagnostic self tests on the system (for use when 

servicing the system). 
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Renaming the CFX Opus System 

Initially, each CFX Opus system is given the name of the serial number. You can rename a system 

for easy identification. 

To rename a CFX Opus system 

1. On the Home screen, tap Logout, then log in as the Admin user. 

2. On the Home screen, tap Tools to open the Tools menu. 

3. In the Admin tools screen, tap System Settings to open the System Settings screen. 

4. Tap the Instrument name field and type a new name using the alphanumeric keypad that 
appears. 

5. Tap Apply to confirm the change in settings. 

6. Tap Back to return to the Tools menu. 
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Setting the Time Zone on CFX Opus Systems 

Initially, the time zone for each CFX Opus system is set to (UTC-11:00) Coordinated Universal 
Time-11. If your instrument is connected to the Internet, you can set the time zone according to your 
lab’s best practices. You can then set the actual time on the system according to the time in which 

the system resides. 

The time zone changes are applied immediately to the System Settings Date and Time fields and 

saved when you tap Apply. Any changes you made to the date and time prior to setting the time 

zone are lost. Changes to Date and Time made after the time zone change are saved and applied 

in addition to the time zone change when you tap Apply. 

Run reports will display local time (that is, the time zone in which the instrument on which 

experiment is run is located). 

Important: Even if you set the time zone, you must set the correct time. The system does not 
automatically detect the local time. 

Tip: Time changes due to switching between daylight saving and standard time are performed 

automatically when you set the Time zone. 

To set the time zone on the CFX Opus system 

1. On the Home screen, tap Logout, then log in as the Admin user. 

2. On the Home screen, tap Tools to open the Tools menu. 

3. In the Admin tools screen, tap System Settings to open the System Settings screen. 
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4. Tap the Time zone field and select the target time zone from the dropdown list that appears. 

5. Tap the Date field and set the date using the calendar that appears. 

6. Tap the Time fields and set the hour, minute, and second fields using the keypads that appear. 

Note: The Hour field is a 24-hour field. 

7. Tap Apply to confirm the change in settings. 

8. Tap Back to return to the Tools menu. 
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Setting Up a Network Connection 

When establishing a connection between the CFX Opus system and your internal network, a 

DHCP server is required so that the system receives an IP address. The DHCP server should be 

configured to always assign the same IP address to the system. See your network administrator for 
more information. 

By default, the CFX Opus system’s IP address is dynamic. That is, the IP address can change each 

time the system restarts. In these cases, the system must reestablish a connection to your internal 
network each time it starts. A static IP address never changes; thus the system always reconnects 

to the network each time it restarts. 

This section explains how to set up a dynamic IP or static IP network connection on the CFX Opus 

system. 

Setting Up a Dynamic IP Network Connection 

Note: Before starting this procedure, ensure your CFX Opus system is turned off. 

To set up an a dynamic IP network connection 

1. If you have not already done so, insert the provided Ethernet cable into the Ethernet port on 

the back of the CFX Opus system. 

2. Insert the loose end of the Ethernet cable into the network connection router or hub. 

3. Turn on the system. 

The CFX Opus system automatically detects an available IP address and connects to your 
network. The system displays the Ethernet icon in the lower left corner of the Home screen to 

indicate successful Ethernet network communication. 

4. To test the dynamic IP configuration, log into CFX Opus as Admin and tap Tools on the Home 

screen. 

5. In the Admin Tools list, tap Network Settings. 
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6. On the Network Settings screen, tap IP Config. 

The IP Config dialog box appears and displays the current dynamic IP configuration details, 
for example: 

7. Tap Test to test the connection. 

A message appears indicating an Internet connection has been found. 

8. Tap OK to close the message and then tap Cancel to close the IP Config dialog box and return 

to the Network Settings screen. 

9. On the Network Settings screen, tap Back to return to the Tools screen. 

10. If necessary, implement network security measures per your organization’s security and 

privacy policies. 
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Setting Up a Static IP Network Connection 

Note: Before starting this procedure, ensure your CFX Opus system is turned off. 

When setting up a static IP network connection, you must provide the IPv4 address, subnet mask, 
default gateway, and primary and alternate DNS server details for your system. See your system 

administrator for the appropriate settings. 

Note: CFX Opus supports only IPv4 connectivity. Ensure the settings are appropriate for your 
site. 

To set up an a static IP network connection 

1. If you have not already done so, insert the provided Ethernet cable into the Ethernet port on 

the back of the CFX Opus system. 

2. Insert the loose end of the Ethernet cable into the network connection router or hub. 

3. Turn on the system. 

The CFX Opus system automatically detects an available IP address and connects to your 
network. 

4. To set up a static IP configuration, log into CFX Opus as Admin and tap Tools on the Home 

screen. 

5. In the Admin Tools list, tap Network Settings. 

6. On the Network Settings screen, tap IP Config. 

The IP Config dialog box appears. 

7. Tap Static IP and provide the IP address, subnet mask, default gateway, and primary and 

alternate DNS server details for your site. 

n IP address — the specific numeric address for the CFX Opus system 

n IP subnet mask — the numeric filter used to define the subnet to which the IP address 

belongs 

n IP default gateway — (optional, required if you plan to access the CFX Opus system from 

CFX Maestro computers that are on another subnet) the IP address of the node that 
allows communication between subnets 

n Primary and alternate DNS servers — the IP address of the nodes that translate a server 
name to its IP address 
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8. Tap Test to test the connection. 

A message appears indicating that an Internet connection has been found. 

9. Tap OK to close the message and then tap Cancel to close the IP Config dialog box and return 

to the Network Settings screen. 

10. On the Network Settings screen, tap Back to return to the Tools screen. 

11. The system displays the Ethernet icon in the lower left corner of the Home screen to indicate 

successful Ethernet network communication. 

12. If necessary, implement network security measures per your organization’s security and 

privacy policies. 
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Setting Up the CFX Opus Wi-Fi Adaptor 
Note: The CFX Opus Wi-Fi adaptor is specific to the country in which it is to be used. Contact 
your Bio-Rad Sales representative for the correct adaptor to purchase or visit 
bio-rad.com/cfxopus. 

You can connect the CFX Opus system to internal wireless access points within your organization. 
When successfully connected, you can send email notifications directly to a specified user account 
and access your shared network folder. The CFX Opus system recognizes all wireless access 

points within your company and displays the strength of each connection for best connection. The 

system maintains the most recent connection until you change it. 

This section explains how to connect the CFX Opus system to a wireless access point within your 
organization and how to change wireless connections. 

Tip: To set up the email server and verify the email settings, see Setting Up Email Service on 

page 63. To set up a shared network folder, see Setting Up a Connection to a Shared Network 

Drive on page 70. 

Important: Consult your system administrator for site-specific wireless IP connections and 

their secure passwords before continuing. Wireless networks that require additional 
authentication are not supported. 

To connect the CFX Opus system to a wireless access point 

1. Locate your locale-specific CFX Opus Wi-Fi adaptor and insert it into the USB A port on the 

system. 

2. On the CFX Opus Home screen, tap Logout, then log in to the system as the Admin user. 

3. Tap Tools to open the Tools screen and then tap Wireless Settings in the Admin tools list. 
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The Networks Settings dialog box appears. The following image appears if you have not 
established an Ethernet connection and this is the first time you are setting up a wireless 

connection. 

If you have previously connected CFX Opus to a wireless access point, its network connection 

information appears on the screen: 
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4. Tap WiFi Settings to display a list of available wireless connections. 

The system displays the name of each wireless access point, its privacy setting (Secured or 
Open), and its signal strength: 

n Above 75% is considered Strong 

n 50–75% is considered Good 

n Less than 50% is considered Weak 

Tip: If your preferred access point does not appear in the list, click Refresh to refresh the 

list. 

5. Tap the preferred access point and then tap Connect. 

6. If the preferred access point is secured, you must provide the Wi-Fi password in order to 

connect. 

Note: If you do not know the password, contact your system administrator. 

Type the Wi-Fi password in the alphanumeric keyboard that appears and then tap OK. 

A message appears indicating that the Wi-Fi connection is successful. 

7. Tap OK to close the message and return to the Network Settings screen. 

8. On the Network Settings screen, tap Back to return to the Tools screen. 

9. The system displays the Wi-Fi icon in the lower left corner of the Home screen to indicate 

successful wireless access point connection. 
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Setting Up Email Service 

You can connect the CFX Opus system to your outgoing email server and have run notifications 

and reports emailed directly to a specified user account. CFX Opus saves the email server 
connection parameters until you change them. 

By default, the system ships with Gmail server settings saved. You can create a Gmail account and 

have email sent to that account, or you can program the system to send email to a specific account 
on your site’s email server. 

This section explains how to connect the system to a custom email server. 

Note: Before connecting the system to a custom email server, consult your system 

administrator for site-specific email server requirements. 

To connect the CFX Opus system to a custom email server 

1. On the Home screen, tap Logout and then log in as Admin. 

2. On the Home screen, tap Tools to open the Tools screen. 

3. In the Admin Tools screen, tap Email Settings to open the Email Setup dialog box. 

The Email Setup dialog box displays the default Gmail server settings. 

4. Provide the information for your company: 

n Authentication — by default Authentication is selected (required for Gmail email servers) 
and the Authenticated Account and Account Password fields are active. If your site does 

not require account authentication, clear this checkbox. 
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Tip: See your system administrator for the name of the authenticated account and its 

password. 

o Authenticated Account — the name of the authenticated account. 

o Account Password — the password for the authenticated account. 

5. Tap Save to save the changes. 

6. (Optional) To verify that the SMTP server settings are correct: 

a. Tap Test Email to open the Email Server dialog box. 

b. Provide a valid email address and enter a sample attachment size. 

The size limit for attachments is determined by your company’s server. Bio-Rad 

recommends testing an attachment size between 0.5 and 5 MB. 

Tip: Enter 0 to send a test email with no attachment. 

c. Tap Send Email. 

The system sends a test email to the email account. 

d. Tap Cancel to return to the Email Setup dialog box. 

7. Tap Back to return to the Tools screen. 

Changing Email Servers 

CFX Opus saves the connection parameters for one email server at a time. It retains the most 
recent server connection until you change it. 

To change to another email server 

1. In the Email Setup dialog box, make the appropriate changes. 

2. Tap Save and then tap Yes to save the changes. 

3. Tap Back to return to the Tools screen. 
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Connecting to a Computer Running CFX Maestro Software 

During installation, the CFX Maestro software installer automatically installs the instrument drivers 

onto the computer running the CFX Maestro software. CFX Maestro detects connected instruments 

when you start the software. 

Important: You must disconnect the CFX Opus system from the CFX Maestro computer before 

you install the software. You do not need to turn off the system during the software installation. 

To detect connected instruments 

1. If you have not yet done so, insert the square (male) end of the supplied USB Type B cable 

into the USB Type B port located on the back of the instrument. 

2. Insert the other (port) end into a USB port on the CFX Maestro computer. 

3. If the system is not already running, press the power switch on the back of the instrument to 

turn it on. 

4. Start CFX Maestro software. 

The software automatically detects the connected instrument and displays its name in the Detected 

Instruments pane in the Home window. 
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Note: If the instrument does not appear in the Detected Instruments pane, verify that the USB 

cable is properly installed. To reinstall drivers, select Tools > Reinstall Instrument Drivers in 

the CFX Maestro software Home window. 
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Managing Personal User Accounts 

As a logged in CFX Opus user, you can 

n Set or change your password 

n Set or change your email address 

n Set or change your shared network drive 

n Connect to your BR.io account from CFX Opus 

This section explains how to manage your personal account. 

Important: Guest users can only set or change their email account. 

Setting User Passwords 

Bio-Rad recommends that you create a password at the time you create your user profile. You can 

change your password at any time. The section explains how to set a password if you did not 
create one at the time you created your user profile. 

Note: If you plan to connect to Bio-Rad’s BR.io app or a shared network drive, you must have 

a password. 

Tip: CFX Opus passwords can be any combination of alphanumeric characters. Passwords 

must be between 4–50 characters. 

To create a user password 

1. From the Home screen, tap Tools, then in the Tools screen tap User Profile. 

The User Profile screen appears. 
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2. In the CFX Opus Password section, tap to expand the dialog box and then tap Change 

Password. 

The Change Password dialog box appears. 

3. Type and confirm your password using the alphanumeric keyboard and then tap Save 

Password. 

4. Tap Back to return to the Tools screen, and then tap Home to return to the Home screen. 

To change your password 

1. In the CFX Opus Password section on the User Profile screen, tap Change Password. 

2. Type your current password using the alphanumeric keyboard that appears, and then tap OK. 

The Change Password dialog box appears. 

3. In the Change Password dialog box, type and confirm your password using the alphanumeric 

keyboard that appears and then tap Save Password. 

4. Tap Back to return to the Tools screen, and then tap Home to return to the Home screen. 
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Setting Up Your Email Address 

Adding an email address to your CFX Opus user account allows you to be notified by email after a 

run is completed. This is an option in the Run Setup screen for executing runs. For details, see 

Running Protocols on page 105. 

Note: To receive email notifications from the CFX Opus system, your site administrator must 
configure the email service. For details, see Setting Up Email Service on page 63. 

To add an email address to your user account 

1. From the Home screen, tap Tools, then in the User screen tap User Profile. 

The User Profile screen appears. 

2. In the Email Notification section, tap to expand the dialog box. 

3. Tap the Email Address field and type your email address using the alphanumeric keypad that 
appears, and then tap OK. 

4. Tap Back to return to the Tools screen, and then tap Home to return to the Home screen. 
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Setting Up a Connection to a Shared Network Drive 

Note: You must have a password on the CFX Opus system in order to connect to a shared 

network drive. See Setting User Passwords on page 67 for more information. 

You can connect your CFX Opus system user account to a shared drive on your internal network. 
When connected, you can create protocols on your CFX Opus system and save protocols and run 

files to your network drive. You can also copy CFX protocol files from your network drive to a folder 
on the CFX Opus system. 

Important: Before you can connect the CFX Opus instrument to your BR.io account, your CFX 

Opus Admin must establish a connection to the Internet through either Ethernet or a wireless 

network connection. For more information, see Setting Up a Network Connection on page 56 

or Setting Up the CFX Opus Wi-Fi Adaptor on page 60. 

To connect to a shared network drive 

1. From the Home screen, tap Tools, then in the User screen tap User Profile. 

The User Profile screen appears. 

2. In the Network Folder section, tap to expand the dialog box. 

3. In the Folder Path section, type the path to the shared network folder using the following 

format: 

\\server_name\folder_name\...\target_folder 

Note: You must type the two backslashes (\\) at the beginning of the path, and separate 

each folder with a single backslash. 

70 | CFX Opus 96 and CFX Opus 384 Real-Time PCR Systems 

REVOKED



Managing Personal User Accounts 

4. In the Connection section, type the global domain name and user name you use to connect to 

that server in this format: 

global_domain_name\user_name 

You must include the backslash in the path, for example: 

Global\Carln 

Tip: This user name might be different than your CFX Opus user name. 

5. (Optional) Tap Save User Password to save your network password on the CFX Opus system. 
You will not be prompted for a password the next time you log in to your CFX Opus account. 

6. Tap Connect. 

7. Type the password you use to connect to that server using the alphanumeric keyboard that 
appears and then tap OK. 

When the connection is successful, the Network Folder status changes to Connected: 

8. Tap Back to return to the Tools screen, and then tap Home to return to the Home screen. 

Tip: The system informs you when the folder to which you are connected is read-only. 

To disconnect the CFX Opus instrument from your network drive 

1. From the Home screen, tap Tools, then in the User screen tap User Profile. 

The User Profile screen appears. 

2. In the Network Folder section, tap the icon to expand the dialog box. 

3. Tap Disconnect. 

4. Tap Back to return to the Tools screen, and then tap Home to return to the Home screen. 
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Connecting to Your Bio-Rad BR.io Account 
Note: You must have a password on the CFX Opus system in order to connect to your BR.io 

account. See Setting User Passwords on page 67 for more information. You must also set up a 

BR.io account. For information about registering a BR.io account, see the help information in 

the BR.io app. 

You can connect multiple CFX Opus systems to your Bio-Rad BR.io account. When connected, you 

can create PCR experiments in the BR.io app, download them to and run them on one or more 

CFX Opus systems, and then analyze the uploaded results in the BR.io app. You can also run 

different PCR experiments from the BR.io on each CFX Opus system. 

Important: Before you can connect the CFX Opus instrument to your BR.io account, your CFX 

Opus Admin must establish a connection to the Internet either through Ethernet or a wireless 

network communication. For more information, see Setting Up a Network Connection on page 

56 or Setting Up the CFX Opus Wi-Fi Adaptor on page 60. 

Tip: For more information about Bio-Rad‘s BR.io app, go to www.BR.io. To register for a BR.io 

account, see your company’s IT administrator. 

Connecting the CFX Opus System to Your BR.io Account 

To connect the CFX Opus system to your BR.io account 

1. From the Home screen, tap Tools, then in the User screen tap User Profile. 

The User Profile screen appears. 

2. In the BR.io Account section, tap to expand the dialog box. 

3. Type the email address for your Bio-Rad cloud account and then tap Connect. 

4. Type the password for your Bio-Rad cloud account and then tap OK. 
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A status dialog appears while your BR.io connection is authenticating. When the connection is 

successful, the BR.io Account status changes to Connected: 

5. Tap Back to return to the Tools screen, and then tap Home to return to the Home screen. 

When the CFX Opus system successfully connects to the BR.io 

n The cloud icon appears in the bottom left corner of the Home screen: 

n In the BR.io app, the Instrument Manager displays the connected instrument: 

Note: When you log into the CFX Opus system after establishing the BR.io account 
connection, you are automatically connected to your BR.io account. When you log in to 

your BR.io account, your instrument appears in the instrument list. When you log out of the 

CFX Opus system, your instrument is removed from the BR.io instrument list. 

Disconnecting the CFX Opus Syste from Your BR.io Account 

If you need to remove a CFX Opus system from your BR.io account, you must first disconnect the 

system from your CFX Opus user account. 

To disconnect the CFX Opus system from your BR.io account 

1. From the Home screen, tap Tools, then in the User screen tap User Profile. 

The User Profile screen appears. 

2. In the BR.io Account section, tap to expand the dialog box. 

3. Tap Disconnect. 

A status dialog appears to confirm your CFX Opus user account is disconnected from BR.io. 
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4. Tap Back to return to the Tools screen, and then tap Home to return to the Home screen. 
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Managing User Accounts 

The CFX Opus Admin user can perform limited user management tasks. From the User Profile 

screen, the Admin user can create his own password. From the User Management screen, the 

Admin user can 

n Change a user’s password 

n Delete a user account 

This section explains how to set the Admin password and manage user accounts. 

Setting the Admin Password 

Important: The default Admin user does not have a password. Bio-Rad strongly recommends 

that the user who assumes the Admin role immediately set a password and store that 
password in a password safe. Resetting the Admin password requires a call to Bio-Rad 

Technical Support. 

CFX Opus passwords can be any combination of alphanumeric characters. Passwords must be 

between 4–50 characters. 

Note: If you plan to connect to Bio-Rad’s BR.io app or a shared network drive, you must have 

a password. 

To add the Admin password 

1. On the Home screen, tap Logout to log out any logged-in user then log in as the Admin user. 

2. On the Home screen, tap Tools to open the Admin Tools screen. 

3. Tap the User icon on the bottom of the screen to display the User Tools screen then tap User 
Profile. 

The User Profile screen appears. 

4. In the CFX Opus Password section, tap the icon and then tap Change Password. 

5. In the Change Password dialog box, type and confirm your password using the alphanumeric 

keyboard that appears and then tap Save Password. 

6. Tap Back to return to the Tools screen, and then tap Home to return to the Home screen. 

To change the Admin password 

1. In the CFX Opus Password section on the User Profile screen, tap Change Password. 

2. Type your current password using the alphanumeric keyboard that appears, and then tap OK. 
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The Change Password dialog box appears. 

3. In the Change Password dialog box, type and confirm your password using the alphanumeric 

keyboard that appears and then tap Save Password. 

4. Tap Back to return to the Tools screen, and then tap Home to return to the Home screen. 

Resetting User Passwords 

In the event that a user forgets his password, the Admin user can reset the password for that user. 
Users can change their password at any time and as often as they choose. 

To change or add a password for another user 

1. On the Home screen, tap Logout then log in as the Admin user. 

2. From the Home screen, tap Tools then in the Admin Tools screen tap User Management. 

The User Management screen appears. 

3. Tap the targeted user name on the Users list. 

4. Tap Reset Password on the bottom toolbar. 

The Reset Password dialog box appears. 

5. Type and confirm the new password using the alphanumeric keyboard that appears, and then 

tap Save Password. 

6. Tap Back to return to the Tools screen, and then tap Home to return to the Home screen. 
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Deleting CFX Opus User Accounts 

WARNING! Deleting users accounts from the CFX Opus system also permanently 

deletes their protocols, run files, and user data. Take care when deleting users 

from the system. 

Note: You cannot delete the Admin, Guest, or Service user accounts. 

To delete a user account 

1. On the Home screen, tap Logout then log in as the Admin user. 

2. From the Home screen, tap Tools then in the Admin Tools screen tap User Management. 

The User Management screen appears. 

3. Tap the targeted user name on the Users list. 

4. Tap Remove User on the bottom toolbar. 

A warning appears informing that removing a user permanently deletes their user data. 

5. Tap Cancel to cancel the screen or tap Remove to remove the user account and permanently 

delete their data. 

6. Tap Back to return to the Tools screen and then tap Home to return to the Home screen. 
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Using the touch screen on the CFX Opus system, you can create and edit protocols, change step 

parameters, and set the sample volume and lid temperature. 

For each protocol, you can add, edit, or remove any of the following parameters: 

n Plate “read” 

n Temperature gradients 

n Temperature increments 

n Ramp rate 

n Extend time 

n Alert beeps 

n Goto steps 

A protocol can contain the following types of steps: 

n Temperature — ramps to a target temperature at specified ramp rate and holds that 
temperature; can include a plate read at end of the step. 

n Gradient — applies a temperature differential across the rows of the block; can include a plate 

read at end of the step. 

n Goto — creates a cycle of a specific number of repetitions between certain steps in the 

protocol. 

n Melt Curve — collects fluorescence data at specified temperature intervals between a starting 

temperature and an ending temperature; used to perform melt curve analysis. Includes a plate 

read after each interval. 

The section Parameters and Ranges for Protocol Steps on page 80 lists the options and ranges for 
protocol steps. Review the information in this section before creating your protocol. 
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Parameters and Ranges for Protocol Steps 

Use the information in Table 11 on page 80 to modify the default settings for the steps in your 
protocol. 

Temperature Steps 

The target temperature is a value between 4.0 and 100.0 °C, set in tenths of a degree. The system 

ramps up to this temperature and holds that value for a specified amount of time (the hold time). 

Gradient Steps 

The gradient range is the difference between the lower and upper temperatures in a gradient step. 
The maximum allowed range is 24°C. The lower temperature is a value between 30.0 and 99.0°C, 
set in tenths of a degree. The maximum upper temperature is 100°C. The thermal cycler ramps up 

to the target temperature gradient across the block and holds that temperature for a specified hold 

time. 

Important: The instrument calculates the gradient value. When you enter a value in the 

gradient calculator’s top and bottom fields, the software automatically calculates and assigns 

the temperatures for the remaining fields. When you enter a temperature in any field between 

the top and bottom field, the instrument automatically calculates the remaining fields. You 

cannot manually enter a temperature value in every field. 

Table 11. Parameters and ranges for protocol steps 

Parameter Range Description 

Ramp rate n For CFX Opus 96 systems: 
0.1–5°C per sec 

n For CFX Opus 384 systems: 
0.1–2.5°C per sec 

Instructs the thermal cycler to ramp to the 

target temperature at the specified rate in 

that step. 

Available only to temperature steps. 

Increment A number from –10.0 to 10.0°C per 
cycle in tenths of a degree 

Instructs the thermal cycler to change the 

target temperature of a step with each 

cycle, where a positive number increases 

the temperature and a negative number 
decreases the temperature. 

Available only to temperature steps. 
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Table 11. Parameters and ranges for protocol steps, continued 

Parameter Range Description 

Extend A time from –60 to 60 sec per cycle Instructs the thermal cycler to extend the 

hold time with each cycle. A positive 

number increases the hold time and a 

negative number decreases the hold time. 

Available to both temperature and gradient 
steps. 

Beep (No parameters) Instructs the thermal cycler to beep to 

signal that the thermal cycler has reached 

the target temperature for that step. 

Available only to temperature steps. 

Plate read (No parameters) Instructs the thermal cycler to add a plate 

read to the selected step. 

Available to both temperature and gradient 
steps. 
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Creating a Protocol 
Important: While creating your protocol, take care when setting the sample volume and lid 

temperature. If the lid temperature is too high, the sample temperature might rise above the 

target temperature. For more information about these settings, see Setting Sample Volume 

and Lid Temperature on page 95. 

To create a protocol 

1. On the Home screen, tap New Protocol to open the New Protocol screen. 

2. To set or change any of the following, tap its respective button or field and enter a value using 

the alphanumeric keypad that appears: 

n Name — the name of the protocol. The name can consist of up to 32 alphanumeric 

characters. 

Tip: Spaces are considered as a character. 

n Volume — the reaction volume in μl. 

Note: The volume setting affects the control mode used to determine when the 

sample reaches the target temperature. For details, see Sample Volume and 

Temperature Control Modes on page 95. 

n Lid temp — the temperature of the lid in °C. 
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n Temperature — the target temperature of the step. For example: 

(target temperature set to 95°C) 

n Time — the hold time of the step (between 1 sec and 17:59:59) in the format of 
HH:MM:SS. For example: 

(hold time set to 10 sec) 

Tip: To set an infinite hold on a step, tap the key. 

n Goto step number — (for Goto steps only) the step number to which the Goto cycle 

returns. For example: 

(Goto cycle returns to step 2 and repeats the succeeding steps.) 

n Goto cycles — (for Goto steps only) the number of times to repeat cycle. For example: 

(repeat the cycle 39 times) 

3. (Optional) If your protocol requires a new temperature, gradient, melt curve, plate read, or Goto 

step: 

a. Select the step in the protocol that will precede the new step and tap Insert at the bottom 

of the screen. 

The Insert Step dialog appears. 

b. Tap the type of step to insert. 
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The new step appears in the protocol, highlighted and to right of the selected step. The 

default temperature of the new step is 50°C and the default time is 30 sec (0:30). Tap time 

or temperature to edit the parameters in the new step. 

4. (Optional) To delete a step, select the step and tap Remove at the bottom of the screen. 

5. Tap Save to save the protocol. 

The Save As dialog box appears: 

If you have a local user account, the default save location is your personal folder, which 

appears as My Files in the Save As dialog box. Protocols that are saved in that folder or any 

folder within the My Files folder structure are visible only to you. Files within your My Files 

structure are not available to or shareable with other users. 

Alternatively, you can choose to save protocols to a shared network folder if you have enabled 

this setting. You can also choose to save to an attached USB drive. 

Finally, you can save protocols to a location in the Public folder. Files that are saved in that 
folder or any folder within the Public folder structure are visible to and shareable with every 

CFX Opus user in your organization. 

Important: Files saved to an alternate location are not concurrently saved on the CFX 

Opus system. Consider this before selecting the location. 

For Guest users, the default save location is the Public folder. Guest users can save protocols 

only in the Public folder structure or to an attached USB drive. 
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Tip: For more information about managing files and folders, see Chapter 6, Managing 

Files and Folders. 

6. In the Save As dialog box: 

a. If you have not yet named the protocol, tap the Protocol Name field and type a name for 
the protocol in the alphanumeric keyboard that appears. 

b. Do one of the following to determine the file destination: 

n Accept the default folder location. 

n Tap the Folder Location link to open the Select Location dialog box and select the 

new location. If necessary, tap Create Folder ( ) to create a new folder in the 

currently-selected location. When you are finished, tap Select. 

c. Tap Save to save the protocol or Cancel to return to the New Protocol screen. 

7. In the New Protocol screen, tap Next to open the Run Setup dialog box. 
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8. Adjust the run settings as needed for your protocol: 

n Sample volume 

n Lid temperature 

n Scan mode 

Important: If you plan to upload your completed run and analyze it using the BR.io 

app, you must choose either SYBR®/FAM or All Channels. 

n (Optional) Plate ID 

n Run file name 

Tip: This is the name for the run file, separate from the protocol name. 

n Save location 

Tip: The default location is the user’s personal folder (My Files), you can change this 

to save into the same folder as the folder containing the saved protocol, to a shared 

network drive, a USB, or to your BR.io account if you have enabled this setting. 

n Notifications after the run is completed 

You can have the system beep and/or send email to a specified email account when the 

run completes. 

9. On the Run Setup screen, tap Run to start the run. 

For more information, see Chapter 5, Running Protocols. 
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Modifying the Settings in a Protocol Step 

While you create your protocol, you can modify the default settings for each step. You can add or 
remove any of the following: 

n Target temperature 

n Hold time 

n Temperature gradients 

n Temperature increments 

n Ramp rate 

n Extend time 

n Alert beeps 

You can also modify the default settings of a Goto step. These tasks are explained in the sections 

that follow. 

Changing Target Temperature and Hold Time 

To change the target temperature and hold time 

1. Select the target step and then tap Options on the bottom toolbar to open the Step Options 

dialog box: 

2. Tap the appropriate option and enter a new value in the keypad that appears. 

3. Tap OK to confirm and close the keypad. 
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4. Tap OK to close the Step Options dialog box. 

5. Tap Save to save the changes. 

Tip: Alternatively, tap the appropriate field in the target step and enter a new value in the 

keypad that appears. Tap OK to close the keypad and return to the protocol. 
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Adding or Removing a Temperature Gradient 
To add a temperature gradient 

1. On the protocol, select the target step and tap Options. 

The Step Options dialog box appears. 

2. In the Step Options dialog box, tap the Gradient checkbox. The gradient range appears to the 

right in the Step Options dialog box. 

3. To change the gradient range, tap either the higher or lower value and enter a new value in 

the keypad that appears. 

Important: The upper value of the gradient range must be within 24°C of the lower value. 
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4. Tap OK to confirm and close the keypad. 

5. Tap OK to close the Step Options dialog box. 

6. Tap Save to save the changes. 

To remove the temperature gradient 

1. On the protocol, select the gradient step and then tap Options. 

The Step Options dialog box appears. 

2. Clear the Gradient checkbox. 

3. Tap OK to confirm and close the keypad. 

4. Tap OK to close the Step Options dialog box. 

5. Tap Save to save the changes. 

Adding or Removing the Ramp Rate 

The ramp rate option instructs the thermal cycler to ramp to the target temperature at a specified 

rate in that step. 

To emulate a thermal cycler that runs at a slower ramp rate than the CFX Opus, change the ramp 

rate of the appropriate protocol step. 

To add a ramp rate 

1. On the protocol, select the target step and tap Options. 

The Step Options dialog box appears. 

2. Tap Ramp Rate and enter a value using the keypad that appears. 

3. Tap OK to confirm and close the keypad. 

4. Tap OK to close the Step Options dialog box. 

5. Tap Save to save the changes. 

To remove a ramp rate 

1. On the protocol, select the ramp rate step and tap Options. 

2. In the Step Options dialog box, tap Ramp Rate and then tap Off to clear the entry. 

3. Tap OK to confirm and close the keypad. 

4. Tap OK to close the Step Options dialog box. 

5. Tap Save to save the changes. 
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Adding or Removing a Temperature Increment 
An increment raises or lowers the target temperature of a step within each cycle. 

To add a temperature increment 

1. On the protocol, select the target step and tap Options. 

The Step Options dialog box appears. 

2. Tap Increment. 

3. Enter an increment value using the keypad that appears. 

Tip: A positive number increases the temperature, a negative number decreases the 

temperature. 

4. Tap OK to confirm and close the keypad. 

5. Tap OK to close the Step Options dialog box. 

6. Tap Save to save the changes. 

To remove a temperature increment 

1. On the protocol, select the temperature increment step and tap Options. 

2. In the Step Options dialog box, tap Increment and then tap 0 (zero) to clear the entry. 

3. Tap OK to confirm and close the keypad. 

4. Tap OK to close the Step Options dialog box. 

5. Tap Save to save the changes. 
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Adding or Removing an Extend Time Option 

The Extend option instructs the thermal cycler to extend the hold time with each cycle. 

To add or modify an Extend option 

1. On the protocol, select the target step and tap Options. 

The Step Options dialog box appears. 

2. Tap Extend and type a value using the keypad that appears. 

3. Tap OK to confirm and close the keypad. 

4. Tap OK to close the Step Options dialog box. 

5. Tap Save to save the changes. 

To remove an Extend option 

1. On the protocol, select the extend step and tap Options. 

2. In the Step Options dialog box, tap Extend and then tap 0 (zero) to clear the entry. 

3. Tap OK to confirm and close the keypad. 

4. Tap OK to close the Step Options dialog box. 

5. Tap Save to save the changes. 

Adding or Removing a Beep Alert 

The thermal cycler can emit a beep sound when it reaches the target temperature of a protocol 
step. 

To add a beep alert 

1. On the protocol, select the target step and tap Options. 

The Step Options dialog box appears. 

2. Tap the Beep checkbox to select it. 

3. Tap OK to confirm and close the keypad. 

4. Tap OK to close the Step Options dialog box. 

5. Tap Save to save the changes. 
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To remove a beep alert 

. On the protocol, select the beep step and tap Options. 

. In the Step Options dialog box, tap Beep to clear the checkbox. 

. Tap OK to confirm and close the keypad. 

. Tap OK to close the Step Options dialog box. 

. Tap Save to save the changes. 
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Changing Parameters in a Goto Step 

The Goto step instructs the thermal cycler to return to a specific step in the protocol and repeat the 

series of steps a specified number of times. This creates a cycle in the PCR experiment. The Goto 

step in Step 4 in the following image instructs the thermal cycler to return to Step 2 and perform 34 

additional repeats, for a total of 35 cycles. 

To change parameters in a Goto step 

1. To change the return-to step, tap Step in the Goto step and type the new step number using 

the keypad that appears. 

2. Tap OK to confirm and close the keypad. 

3. To change the number of repeats, tap the repeat X on the Goto step and type a new value 

using the keypad that appears. 

4. Tap OK to confirm and close the keypad. 

5. Tap OK to close the Step Options dialog box. 

6. Tap Save to save the changes. 
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Setting Sample Volume and Lid Temperature 

Important: If the lid temperature is too high, the sample temperature might rise above the 

target temperature. 

Sample Volume and Temperature Control Modes 

The CFX Opus system uses one of two control modes to determine when the sample reaches the 

target temperature: 

n Calculated mode — when a sample volume setting is greater than zero, the system calculates 

the sample temperature based on the sample volume. Bio-Rad recommends using the 

calculated mode because it most accurately represents the actual sample temperature. 

n Block mode — when a sample volume setting is zero (0) µl, the system assumes that the 

sample temperature is the same as the measured block temperature. 

To change the sample volume 

1. On the New Protocol or Edit Protocol screen, tap Volume at the top of the screen and type a 

new value using keypad that appears. 

2. Tap OK to confirm and close the keypad. 

To view the control mode setting for a saved protocol or run file 

1. From the Home screen, tap Files to open the File Browser screen. 

2. Tap the location and folder in which the protocol or run file resides, and then tap the file’s 

name to view its details. 

For example, the image that follows shows that the PCR2 protocol uses the CALC (calculated) 
control mode: 
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Lid Temperature 

Note: For the CFX Opus 96-well system, Bio-Rad recommends a lid temperature of 105°C. For 
the CFX Opus 384-well system, Bio-Rad recommends a lid temperature of 95°C. 

The CFX Opus’s adjustable heated lid allows you to control the lid temperature. Heating the lid 

prevents condensation from forming inside the reaction wells. When the CFX Opus is running, the 

heated lid maintains the temperature specified for the protocol being run. Without a heated lid, 
water from the reagents can be lost to condensation, concentrating the reactants in the tube or 
plate. 

The default lid temperature of the CFX Opus is 105°C for 96--well reaction blocks and 95°C for 
384-well blocks. 

Note: When the block is running an infinite hold at a temperature below 30.0°C, the lid heater 
maintains 31.0°C. 

To change the lid temperature 

1. On the New Protocol or Edit Protocol screen, tap Lid temp at the top of the screen and type a 

new value using keypad that appears. 

2. Tap OK to confirm and close the keypad. 
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Editing a Protocol 
You can edit any parameter within an existing protocol. You can then save it with the same name 

into the same or a different folder, or you can rename the protocol and save it into any folder. A 

renamed protocol does not overwrite the original protocol. 

Tip: You can also open a completed run file, edit the original protocol, and save the protocol to 

another folder or with another name. For details, see Extracting and Editing a Protocol from a 

Run on page 118. 

Caution: Saving a protocol with the same name in the same folder overwrites the original 
protocol. You can have multiple protocols with the same name as long as they are saved in 

different folders. 

CFX Opus provides two options with which to edit the protocol: 

n Direct interaction with buttons that appear on the protocol: 

o On temperature, gradient, and melt curve steps, tap the temperature and step time buttons 

to set these parameters. More options are available in the Options dialog. 

o On Goto steps, tap the step number button to change the step at which the Goto cycle 

begins. Tap the cycles button to change the number of cycles to repeat. 

n Tap Options on the bottom toolbar to open the Step Options dialog box, which provides access 

to all options available for the selected step. 

Editing a Protocol 
To edit a protocol 

1. On the Home screen, tap Files to open the File Browser screen. 
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2. Tap the location and folder in which the protocol file resides, and then tap the file’s name to 

select it. 

3. Tap Edit to open the Edit Protocol screen. The protocol appears in a graphical format. 
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4. To set or change any of the following, tap its respective button or field and enter a value using 

the alphanumeric keypad that appears: 

n Name 

n Volume 

Note: The volume setting affects the control mode used to determine when the 

sample reaches the target temperature. For details, see Sample Volume and 

Temperature Control Modes on page 95. 

n Lid temp 

n Temperature 

n Step time 

n Goto step destination (start of cycle) 

n Goto number of cycles 

5. (Optional) To add a new step, select a step in the protocol and tap Insert on the bottom toolbar. 

In the Insert Step dialog box, tap the type of step to insert. The new step appears to the right of 
the selected step. See Editing a Protocol on page 97 for more information. 

6. Tap Next to run the protocol to open the Run Setup dialog box and then tap Run to run the 

protocol. 

7. Tap Save to enter a new file name, folder, and location in which to save the protocol. 
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Editing a qPCR Protocol 

The CFX Opus system ships with a set of preconfigured sample qPCR protocols. These protocols 

are read-only. You can copy the sample qPCR protocols to any folder on the system, however 
copied sample protocol are also read-only. You cannot delete the copied protocol, even when 

saved to another folder. 

The sample qPCR files are located in the Public > Bio-Rad qPCR folder, which is also read-only. 
Because the Bio-Rad qPCR folder is read-only, you cannot save files to or delete files from this 

folder. 

However, any user, including the Guest user, can rename and save the protocol to another 
location before running it. Renamed protocols are open protocols and can be edited, copied, and 

deleted. 

Note: You must save the renamed qPCR protocol to a location other than the Bio-Rad qPCR 

folder. 

This section explains how to edit a sample qPCR protocol. 

To edit a qPCR protocol 

1. On the File Browser screen, tap Public in the left navigation pane and then tap the Bio-Rad 

qPCR folder to display the sample qPCR protocols. 

2. Select the target protocol and then tap Edit. 

The Edit Protocol screen appears. 
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3. In Name field, type a new name for the protocol. 

Tip: You must rename the protocol. Unless you rename it, the system will not save edits to 

a qPCR protocol regardless of the folder into which you choose to save it. 

4. (Optional) In the Edit Protocol screen, make any necessary changes to the protocol and then 

tap Save. 

5. In the Save As dialog box, tap the Folder Location link and select a location in which to save 

the protocol. 

6. Verify that you changed the name of the file and then tap Save to save the renamed sample 

qPCR file. 

7. On the Edit Protocol screen, do one of the following: 

n Tap Next to open the Run Setup to set up and run the protocol. 

n Tap Back to return to the File Browser screen. 

Adding a Protocol Step 

To add a protocol step 

1. Tap the step in the protocol that will precede the new step and tap Insert on the bottom toolbar. 

The Insert Step dialog box appears. 

2. Tap the type of step to insert: 

n Temperature 

n Gradient 

n Melt curve 
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n Plate read 

Note: The Plate Read option does not insert a step. Instead, it adds a plate read action to 

the selected step. If a step contains a plate read, it displays the following icon: 

n Goto 

The new step appears to the right of the selected step. 

Tip: The default target temperature of a new step is 50°C and its default time is 30 sec 

(0:30). Tap the step’s time or temperature or tap Options to edit the parameters in the new 

step. 

Deleting a Protocol Step 

To delete a protocol step 

u On the protocol, select the target step and tap Remove on the bottom toolbar. 

Renaming a Protocol 
To rename a protocol 

1. On the protocol, tap Name on the top of the screen. 

2. Type a new name for the protocol using the alphanumeric keyboard that appears. 

3. Tap OK to accept the name and close the keyboard. 

Saving an Edited Protocol 
To save an edited protocol 

1. On the protocol, tap Save to open the Save As dialog box. 
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Important: Saving the protocol with the same name in the same location overwrites the 

original protocol. Saving the protocol with a new name or in another location creates a 

new protocol. The original file remains unchanged. 

2. Tap the Protocol Name field and type a name for the protocol. 

3. Do one of the following to determine the file destination: 

n Accept the existing folder location. 

n Tap the Folder Location link to open the Select Location dialog box and select the new 

location. If necessary, tap Create Folder ( ) to create a new folder in the selected 

location. When you are finished, tap Select. 

Folder Location path displays the path to the selected destination: 

4. Click Save to save the protocol or Cancel to return to the Edit Protocol screen. 
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From the CFX Opus system you can 

n Run a protocol 

n Run a pending run created from a BR.io protocol 

n Repeat a completed run 

n View the status of a run 

n Pause and resume a run 

n Skip steps in a run 

n Stop a run 

This chapter explains how to perform these tasks using the system’s touch screen. 
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Running a Protocol 
CFX Opus offers several options for running a protocol: 

n Run a new protocol. 

n Run a saved protocol. 

n Run a completed run again. 

n Run a pending run from your BR.io account. 

n Edit a protocol from a completed run, and then run the edited protocol. 

This section explains these options in detail. 

Running a Saved Protocol 
Using the CFX Opus system’s File Browser feature, logged-in users can select and run protocols 

that are saved locally in their My Files folder structure, an attached USB drive, or a shared network 

folder. 

Guest users can run protocols saved in the Public folder structure or an attached USB drive. 

Admin users can run saved protocols from any local folder, an attached USB drive, or a shared 

network folder. 

To run a saved protocol 

1. On the Home screen, tap Files to open the File Browser screen. 

2. Tap the location and folder in which the protocol is saved and then tap the file’s name to select 
it. 
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Tip: Protocol files are identified by a protocol icon ( ) while run files are identified by a 

run icon ( ). 

3. Tap Next. 

The Run Setup dialog box appears. 
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4. Adjust the run settings as needed for your experiment: 

n Sample volume 

n Lid temperature 

n Scan mode 

Note: If you plan to analyze your run data using the BR.io app, you must select either 
SYBR®/FAM or All Channels. 

n (Optional) Plate ID 

To add a plate ID, do one of the following: 

o Tap the Plate ID field and manually enter the plate ID in the alphanumeric keyboard 

that appears and then tap OK to accept the plate ID and close the keyboard. 

o Use a USB barcode scanner to scan the plate’s barcode into this field: 

a. Connect a barcode scanner to one of the system’s USB ports. 

Note: The CFX Opus system only supports barcode scanners that are 

compatible with Windows 10 and are ready to use when connected. 

b. Tap the Plate ID field to view the Plate ID alphanumberic keyboard. 

c. Tap the text field in the keyboard and then scan the barcode to insert the barcode 

into the text field. 

d. Tap OK to accept the barcode and close the keyboard. 

n Run file name — the default file name format is <ProtocolName>_<Date>_<Time>_ 

<SerialNumber>_<UserName>. You can change it to a name of your choice. 

Note: The run file name is limited to 64 characters. 

n Save Location — the location in which to save the run file. The default location is the 

folder in which the saved protocol is located. 

To save the run file in a different location, tap the location link to access the Select 

Location dialog and select the new location. If necessary, tap Create Folder ( ) to create 

a new folder at the currently-selected location. When you are finished, tap Select. 
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n Notifications after the run is completed: 

o Beep 

= off 

= on 

o Email 

= off 

= on 

Your email address appears next to the email icon. 

= disabled because email is not configured. 

For information about setting up email, see Setting Up Your Email Address on page 69. 

5. As needed, tap Open Lid (and Close Lid) to insert the plate in the reaction block. 

6. Tap Run to start the run. 

7. When the run completes, the Status screen displays Protocol Complete. The system saves the 

run file into the location with the name indicated in Step 4, for example: 
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Running a Pending Run from Your BR.io Cloud Account 
To run a pending run from your BR.io account 

1. Make sure you have connected your CFX Opus instrument’s user account to your BR.io 

account. For details, see Connecting to Your Bio-Rad BR.io Account on page 72. 

2. On the Home screen, tap Files to open the File Browser screen. 

3. In the File Browser’s left navigation pane, tap the BR.io icon to display the pending runs, and 

then tap the pending run you want to run. 

Tip: BR.io pending runs are identified by a pending icon ( ). 

4. Tap Run Setup. 

The Run Setup dialog box appears. 
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5. Adjust the run settings as needed for your experiment. 

See Running a Saved Protocol on page 106 for more information. 

Note: When the CFX Opus system connects to your BR.io account, your run file is 

automatically uploaded and is removed from the system. 

In the event of an interruption to the CFX Opus/BR.io connection while your run is in progress 

and the connection is not restored before the end of the run, the run file is automatically saved 

to your My Files folder. In this case, you can copy the run file to an attached USB drive or to a 

shared network folder and analyze the data using CFX Maestro software. 

6. As needed, tap Open Lid (and Close Lid) to insert the plate in the reaction block. 

7. Tap Run to start the run. 

While the run is in progress, the instrument status in your BR.io app is Running. 
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8. When the run completes, the CFX Opus system displays a message indicating the run is 

uploaded to your BR.io account and the instrument status in your BR.io app is Idle. 

The CFX Opus system removes the pending run file from your BR.io location. The completed 

run file is available in your BR.io Files list. For example: 
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Running a Completed CFX Opus Run 

To run a completed run 

1. On the Home screen, tap Files to open the File Browser screen. 

2. Tap the location and folder in which the completed run file is located, and then tap the file’s 

name to select it. 

3. Tap Run Setup. 

The Run Setup dialog box appears. 
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4. Adjust the run settings as needed for your experiment. 

See Running a Saved Protocol on page 106 for more information. 

5. When the run completes, the system saves the run file into the location with the name 

indicated inStep 4Step 4 

Tip: To differentiate the second run file from the original if you did not change the name, 
view the time stamp on the run file name, for example: 
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Monitoring a Run 

During a run, you can use the status buttons on the Home screen to monitor the run. 

To monitor a running protocol 

1. To see the detailed status of a run in progress, tap the Run Status button on the Home screen. 

The Run In-Progress screen appears. 

2. To view the remaining time for the run, tap Time Remaining. 

3. To return to the Run In-Progress screen, tap View Status. 
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Pausing a Run 

From its status screen, you can temporarily pause a run in progress. While the run is paused, the 

system continues heating or cooling to the target temperature and maintains the lid temperature. 

Tip: After a power failure, the CFX Opus system displays a warning message. When the power 
resumes the system automatically resumes the run in progress at the time of the power failure. 

Important: Pausing a step can adversely change the outcome of the PCR reaction. If the 

protocol is paused during a temperature step, the PCR reaction stays at the target temperature 

for a longer hold time than the protocol step requires. 

To pause or resume a running protocol 

1. On the Home screen, tap the status button for the system. 

The Run In-Progress screen appears. 

2. On the Run In-Progress screen, do one of the following: 

n Tap Pause to pause the running protocol, 

n Tap Resume to resume the protocol. 

Skipping Steps in a Protocol 
From the status screen, you can skip steps in a protocol while it is running if it is necessary to 
shorten the protocol. 

Notes: 

n If the system is currently in an infinite hold, tap Skip Step to exit the hold. 

n If you tap Skip Step while in a GOTO step, the software skips to the next cycle in the GOTO 

loop. If the GOTO step is in the last cycle when you tap Skip Step, the CFX Opus software 

exits the GOTO loop and continues to the next step in the protocol. 

n By repeatedly skipping steps, it is possible to bypass several cycles of a GOTO loop and 

shorten the protocol. 

To skip a step in a running protocol 

1. If necessary, on the Home screen, tap Run Status to display the Run In-Progress screen. 

2. Tap Skip Step to skip to the next step. 

Tip: To skip more than one step, tap Skip Step multiple times. 
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Stopping a Run 

You can stop a protocol while it is running. When the protocol is stopped, the block immediately 

stops changing temperature. 

WARNING! Do not open the lid immediately after stoppinga 

run. Opening the lid while samples are still hot can allow 

pressurized containers to leak, spray, or spurt liquid. Always 

allow the samples to cool before opening the lid. 

To stop a run in progress 

1. On the Home screen, tap the status button for the thermal cycler. 

The Run In-Progress screen appears. 

2. Tap Stop Run. 
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Extracting and Editing a Protocol from a Run 

You can extract a protocol from a run, edit the protocol, and save it. This is helpful if, for example, 
you do not have access to the original protocol file. 

This process creates a copy of the protocol file contained in the run file and does not impact the run 

file or the original protocol file. If you want to edit an existing protocol file on the CFX Opus system, 
see Editing a Protocol on page 97. 

Important: If you save the edited protocol with the same name and into the same location as 

the original file, the system prompts you whether you want to overwrite the original file. You 

cannot recover the original file if it is overwritten. Bio-Rad recommends that you save the file 

with another name or in a different location to avoid any loss of data. 

To extract and edit a protocol from a run 

1. On the Home screen, tap Files to open the File Browser screen. 

2. Tap the location and folder in which the run file resides, and then tap the file’s name to select 
it. 

3. Tap Edit to open the Edit Protocol screen. The protocol appears in a graphical format. 
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4. To set or change any of the parameters, tap its respective button or field and enter a value 

using the alphanumeric keypad that appears. 

For detailed information about the protocol parameters, see Parameters and Ranges for 
Protocol Steps on page 80 

For detailed information about the settings in a protocol, see Creating a Protocol on page 82. 

5. (Optional) To delete a step, select the step and tap Remove at the bottom of the screen. 

6. Tap Save to open the Save As dialog box. 

7. Type a new name for the protocol and (optionally) select a new location in which to save the 

protocol. 

8. Tap Save to save the protocol or Cancel to return to the Edit Protocol screen. 

9. (Optional) Tap Run Setup to set the run parameters and then run the protocol. 
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Chapter 6 Managing Files and Folders 
Using the CFX Opus system’s file browser feature, you can 

n Create a sophisticated folder structure in which to manage your stored data files 

n Save data files directly on the CFX Opus system or to a connected USB drive or shared 

network drive 

n Copy files and folders to and from shared network drive 

n Copy files and folders to and from a connected USB drive 

n Rename files and folders on the system 

n Delete unnecessary files and folders from the system 

This chapter explains how to manage files and folders on the CFX Opus system. 
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The File Browser Screen 

On the CFX Opus system, you manage folders and files using the File Browser screen. 

To view the File Browser, tap Files on the Home screen. 

The Legend table on page 123describes the File Browser screen in detail. 
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The File Browser Screen 

LEGEND 

Directories — Potential directories: 

n My Files — file storage available only to the person logged in to the CFX Opus system. 

Tip: This option is not available to users who do not have a local account (that is, users 

logged in as Guest). 

n Public — file storage available to all system users. Use this directory to share files across 

users. 

Tip: This option is available to users who do not have a local account (that is, users 

logged in as Guest). 

n USB — file storage on a portable USB storage device connected to the CFX Opus system. 

n BR.io — contains pending run files available in the BR.io account for the logged in user only; 
requires a BR.io account and a connection to the account (for details, see Connecting to Your 
Bio-Rad BR.io Account on page 72). 

n Network — file storage on a network drive connected to the CFX Opus system via Ethernet 
or wireless communication (for details, see Setting Up a Connection to a Shared Network 

Drive on page 70 

Sub-directory location — identifies your current location within the selected directory. 

Create Folder — enables you to create a folder within the current location. 

File management options — after selecting a file, the file details pane appears. Management 
options include: 

n Copy — copies the existing file to a specified location 

n Delete — deletes the file from the system 

n Rename — renames the file at its current location 
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Managing Files and Folders 

To manage files and folders, tap Files on the Home screen to open the File Browser screen. Table 

12 lists all the folder and file management functions available on the File Browser screen. 

Notes: 

n The folder and file management functionality is not available for files viewed in your BR.io 

folder. 

n Folder and file names have a 32-character limit on the CFX Opus system. 

Table 12. List of file and folder functions in the File Browser screen 

Options Function 

File options (all file actions occur locally on the instrument) 

Copy Copies the existing file to the specified location on the system, attached USB 

drive, or a connected shared network drive. 

Delete Deletes the file from the instrument. 

Rename Renames the file at its current location. 

Folder options 

New Folder Creates a new folder in the current location. 

Copy Copies the existing folder to a specified location on the system, attached USB 

drive, or a connected shared network drive. 

Delete Deletes the folder and all of its contents. 
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Managing Files on the CFX Opus System 

Using the CFX Opus system’s File Browser, you can copy, rename, and delete protocol and run 

folders located 

n Locally on the system 

n On an attached USB 

n On a connected shared network drive 

Note: You cannot copy files to or from your BR.io account. When your CFX Opus connects to 

your BR.io account, CFX Opus automatically syncs with your BR.io account and displays a list 
of all current pending runs that are compatible with your system. 

Tip: To resync the list after creating new pending runs in the BR.io app, tap Refresh on the File 

Browser. 

This section explains how to manage files on the CFX Opus system. 

Copying a File 

To copy a file 

1. On the Home screen, tap Files to view the File Browser screen. 

2. On the File Browser screen, navigate to the file you want to copy, then tap the file to view the 

file details pane. 

3. In the file details pane, tap Options and then tap Copy. 
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The Select Location dialog box appears. 

4. In the Select Location dialog box, do one of the following: 

n Navigate to an existing folder. 

n Navigate to the location to create a folder in which to save the file, then tap Create Folder 

( ) to create a new folder in that location. 

5. Tap Select to copy the file to the selected location or Cancel to return to the File Browser 
screen. 

Note: If a file with the same name exists at the selected location, a dialog appears. Tap 

Yes to overwrite the existing file or No to return to the File Browser screen. 

The CFX Opus system displays a confirmation message when the file is successfully copied. 
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Deleting a File 

To delete a file 

1. On the Home screen, tap Files to view the File Browser screen. 

2. On the File Browser screen, navigate to the file you want to delete, then tap the file to view the 

file details pane. 

3. In the file details pane, tap Options and then tap Delete. 

The Delete confirmation message appears. 

4. Tap Delete to confirm or Cancel to return to the File Browser screen. 

The CFX Opus system displays a confirmation message when the file is successfully deleted. 

Renaming a File 

Notes: 

n You can rename only protocol files. Run files cannot be renamed. 

n The protocol files located in the Bio-Rad qPCR folder are read-only and cannot be renamed. 
However, you can copy a protocol file to another location, open the file and edit the 

parameters. You can then save the edited protocol with a new name. 

To rename a file 

1. On the Home screen, tap Files to view the File Browser screen. 

2. On the File Browser screen, navigate to the file you want to rename, then tap the file to view 

the file details pane. 

3. In the file details pane, tap Options, then tap Rename and type a new name for the file using 

the keypad that appears. 

4. Tap OK to confirm. 
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Managing Folders on the CFX Opus System 

Using the CFX Opus system’s File Browser, you can copy, rename, and delete protocol and run 

folders located 

n Locally on the system 

n On an attached USB 

n On a connected shared network drive 

Note: You cannot copy folders to your BR.io account. 

This section explains how to manage folders on the CFX Opus system. 

Creating a New Folder 

To create a new folder 

1. On the Home screen, tap Files to view the File Browser screen. 

2. On the File Browser screen, navigate to location in which you want to create the new folder. 

3. Tap Create Folder ( ) and type a name using the alphanumeric keypad that appears and 

then tap OK to confirm. 

The new folder appears in the File Browser. 

Copying a Folder 

You can copy a folder in one location on the system and save it and its contents into another 
location. For example, you can copy the folder to an attached USB drive, your shared network 

drive, or to the Public folder. 

You can also copy a folder and save it into the same location. In this case, you must rename the 

copied folder. You cannot have more than one folder with the same name in the same location. 

To copy a folder 

1. On the Home screen, tap Files to view the File Browser screen. 

2. On the File Browser screen, navigate to the folder you want to copy and then tap the ellipses 

for that folder to view the Options pane. 
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3. In the Options pane, tap Copy. 

The Select Location dialog box appears. 

4. In the Select Location dialog box, navigate to the target location. 

5. Tap Select to copy the folder and its contents to the selected location or Cancel to return to the 

File Browser screen. 

Note: If a folder with the same name exists at the selected location, a dialog appears. Tap 

OK to close the dialog and select another location. 

The CFX Opus system displays a confirmation message when the folderand its contents are 

successfully copied. 

Deleting a Folder 

Important: When you delete a folder, its contents are also deleted. Take care when deleting 

folders from the CFX Opus system. 

To delete a folder 

1. On the Home screen, tap Files to view the File Browser screen. 

2. On the File Browser screen, navigate to the folder you want to delete and tap its ellipses to 

view the Options pane. 

3. In the Options pane, tap Delete. The Delete confirmation message appears. 
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4. Tap Delete to confirm or Cancel to return to the File Browser screen. 

The CFX Opus system displays a confirmation message when the folder and its contents are 

successfully deleted. 

Backing Up and Restoring Files and Folders 

Using the CFX Opus system’s file browser system you can quickly back up and restore your 
protocol and run files to an attached USB drive or to a shared network folder. 

Tip: Bio-Rad recommends that you back up your data files often, and to a location other than 

another folder on the CFX Opus system. Follow the recommended SOPs in place at your site. 

Notes: You can back up and restore only one file or folder at a time. 

To back up or restore files 

1. With the target file open in the File Browser screen, tap Options > Copy. 

2. In the Select Location dialog box, tap the target destination and then tap Select. 

To back up or restore folders 

1. In the File Browser screen, tap the ellipses for the target folder and then tap Copy. 

2. In the Select Location dialog box, tap the target destination and then tap Select. 

Transferring Data Files 

When the run is complete, CFX Maestro analyzes the fluorescence data. If the run is performed in 

stand-alone mode and saved on the instrument itself, the data need to be transferred to the CFX 

Maestro computer for analysis. 

Before running the protocol, on the Run Setup screen you can elect to email the data file from the 

instrument to your email account after the run completes. If the computer running CFX Maestro 

provides you access to your email account, you can save the .zpcr file to a folder on the CFX 

Maestro computer and open it in CFX Maestro. 

When the run completes, the run file is saved to the location you select on the Run Setup screen. 
The CFX Opus system can store up to 100 real-time PCR runs. Using the system’s file browser 
feature, you can copy the run file to a shared network folder on the computer running CFX Maestro 

or to a connected USB drive, which you can then use to transfer the file to the computer running 

CFX Maestro. 
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Appendix A CFX Opus System and CFX Maestro 
Software Catalog Numbers 

This appendix lists the catalog numbers for Bio-Rad’s CFX Opus real-time PCR system, software 

services, CFX Maestro software, and accessories. 

Table 13. Catalog numbers for Bio-Rad’s CFX Opus system, software, and accessories 

Catalog Number Description 

Instruments 

12011319 CFX Opus 96 Real-Time PCR System 

12011452 CFX Opus 384 Real-Time PCR System 

Software Services, CFX Maestro Software, and Accessories 

12013758 CFX Maestro 2.0 Software 

12004128 CFX Maestro 1.1 Software for Mac 

12012832 CFX Maestro 2.0 Software, Security Edition, 1 user license 

12013028 CFX Maestro 2.0 Software, Security Edition, 5 user licenses 

12012834 CFX Maestro Software 2.0, Chinese Edition 

12012833 CFX Maestro Software 2.0, Russian Edition 

1845025 Precision Melt Analysis Software, with calibration kit 

12012942 USB cable* 

12013205 Ethernet cable * 

CFX Opus Wi-Fi Adaptor 

Contact your Bio-Rad Sales representative for information about the adaptor 
specific to your locale or visit bio-rad.com/cfxopus. 

* For continued compliance with EMC standards only use Bio-Rad-approved USB and Ethernet cables 

with this instrument. 
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Warranty 

The CFX Opus real-time PCR system and its associated accessories are covered by a standard 

Bio-Rad warranty. Contact your local Bio-Rad office for the details of the warranty. 
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Appendix B Recommended Plastic Consumables 

Plastic Consumables for the CFX Opus 384 System 

For optimal results, Bio-Rad recommends the following consumables for CFX Opus 384 systems: 

n HSP3805 — Hard-Shell low-profile 384-well plates with clear shell and white wells 

n HSP3865 — Hard-Shell low-profile 384-well plates with black shell and white wells 

Plastic Consumables for the CFX Opus 96 System 

The CFX Opus 96 System accepts low-profile 0.2 ml plates and tubes. Bio-Rad recommends the 

following consumables for optimal results: 

n MLL9601 — Multiplate low-profile 96-well unskirted PCR plates with clear wells 

n MLL9651 — Multiplate low-profile 96-well unskirted PCR plates with white wells 

n HSP9601 — Hard-Shell low-profile 96-well skirted PCR plates with white shell and clear wells 

n HSP9655 — Hard-Shell low-profile 96-well skirted PCR plates with white shell and white wells 

n TLS0801 — Low-profile 0.2 ml 8-tube PCR strips without caps, clear 

n TLS0851 — Low-profile 0.2 ml 8-tube PCR strips without caps, white 

n TCS0803 — Optical flat 8-cap strip, for 0.2 ml PCR tubes and plates 

Plate Seals and Plate Sealer 
For optimal results, Bio-Rad recommends the following plate seals: 

n MSB1001 — Microseal 'B' adhesive seals, optically clear (strong adhesive-based) 

n MSC1001 — Microseal 'C' optical seals, optically clear (pressure-activated, adhesive-based) 

n 1814030 — Optically clear heat seal plate sealer 
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Appendix C Maintenance and Troubleshooting 
This appendix explains how to clean and maintain the CFX Opus system and how to troubleshoot 
problems that you might have. 

Cleaning and Maintaining the CFX Opus System 

The CFX Opus requires little maintenance for proper operation and precise thermal control. 
However, with long and constant use, the system will require some cleaning and other 
maintenance. 

The CFX Opus system includes a sensitive optical shuttle system that moves quickly during data 

collection and a reaction block that must heat and cool quickly. Contamination of these 

components can interfere with thermal cycling and data collection. 

Avoid contaminating your CFX Opus system by following these guidelines: 

n Always clean the outside of any containers before placing them in the block. 

n Never run a reaction with a seal that is open, loose, punctured, or otherwise damaged. 

n Clean the reaction block and inner lid periodically to prevent the buildup of dirt, biohazardous 

material, or fluorescent solutions (see Table 14 on page 137). 
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n Clean the outer surface of the CFX Opus system on a regular schedule to remove any debris 

or dirt that might interfere with proper function (see Table 14 on page 137). Clean the system 

to prevent damage to the air intake or reaction bay. 

Important: For instructions on handling and cleaning radioactive or biohazardous materials, 
consult the guidelines for radiation safety and biosafety provided by your institution. These 

guidelines also include hazardous materials disposal methods. 
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CFX Opus Instrument Cleaning and Maintenance Safety Warnings 

When cleaning and maintaining the CFX Opus instrument, always consider and follow the 
warnings listed in Table 14 that follows. 

Table 14. Cleaning and maintenance safety warnings 

Warning 

To prevent electrical shock, always turn off and unplug the instrument from 

the electrical outlet before cleaning it. 

A thermal cycler operates at temperatures high enough to cause serious 

burns. Always allow the entire instrument to return to room temperature 

before cleaning. 

When handling biohazardous or radioactive samples, adhere to the recommended 

precautions and guidelines specific to your laboratory and location. These 

guidelines should include cleaning, monitoring, and disposal methods for the 

hazardous material(s) you are using. 

In addition, as identified above, there is a small risk of explosion, or of expulsion of 
liquids or vapors from the sample container(s). When working with hazardous 

materials the risk of injury from expelled material is compounded with the risk that 
the hazardous material themselves could be dispersed in and around the instrument. 
Users should take appropriate precautions for such a situation. 
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CFX Opus Instrument Maintenance 

Table 15 lists the components of the CFX Opus instrument that will require maintenance. 

Table 15. CFX Opus system maintenance 

Component Action 

Air vents Use a soft brush, damp cloth, or vacuum cleaner to remove light 
dust from the air vents. Remove any heavy dust that is deep in the 

vents with a vacuum cleaner. 

Tip: Cleaning the vents allows sufficient airflow for precise 

thermal control during a run. 

Touch screen Use any commercially available touch screen cleaning agent and a 

soft cloth to clean the touch screen. 

Note: Do not spray or pour cleaning agent directly onto the 

touch screen. 

Note: Do not use abrasive detergents or rough material 
because they can scratch the touch screen. 

Outside case of the system Use a damp cloth or tissue to clean spills off the outside case. If 
needed, use a mild soap solution and remove the residue 

completely. 

Tip: Cleaning the outside case prevents corrosion. 
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Table 15. CFX Opus system maintenance, continued 

Component Action 

Reaction block Important: Clean spills immediately to prevent them from 

drying inside wells. 

Use disposable plastic pipettes with water (recommended), 95% 

ethanol, or a 1:100 dilution of bleach in water. Always rinse the 

wells with water several times to remove all traces of ethanol, 
bleach, or soap. 

Note: Consider the following when cleaning the reaction 

block: 

n If left in the block wells, bleach, ethanol, or soap could corrode 

the block and/or destroy tubes and microplates during a run. 
Always rinse the block thoroughly after cleaning it with any 

solution other than water. 

n Never clean the reaction block with strong alkaline solutions 

(strong soap, ammonia, or highly concentrated bleach). Never 
use corrosive or abrasive cleaning solutions. These cleaning 

agents can damage the block, preventing precise thermal control. 

n Never heat the block with cleaning solution on or in it. Heating the 

block with cleaning solution damages the block and lid, and can 

contaminate the optics. 

If oil is used, the wells must be cleaned thoroughly and often. Use of 
oil in the wells is not recommended. Use a solution of 95% 

ethanol to clean oil on the reaction block. Do not allow oil to build up 

in the block. 
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Maintaining Sufficient Airflow 

The CFX Opus system requires sufficient airflow to heat and cool precisely to the correct target 
temperature. If the flow of air is blocked, the thermal cycler cannot ramp to the correct temperature in 

the specified time. This section explains how to test the airflow and how to fix low or warm airflow. 

Testing for Sufficient Airflow 

The airflow is sufficient when the system heats and cools to the correct target temperatures 

promptly. Bio-Rad suggests that you test the airflow when you set up the CFX Opus system in a 

new location. You can also measure the air temperature at any time to ensure sufficient airflow. 

To determine the presence of sufficient airflow 

1. Set up and start the system. 

2. Adjust the local environment for typical conditions: 

n Turn on any nearby equipment, such as fans or other systems. 

n Open any window blinds to reproduce typical conditions during a run. 

3. Run a typical PCR protocol for 30 min. 

If more than one system is in the area, run a protocol on all the systems at the same time. 

Note: Samples are not required for the test runs. However, you must include an empty 

microplate or capped strip tubes. The lid does not heat correctly if it touches the reaction 

block. 

4. Measure the air temperature at the air intake vents of the system. 

If the air intake temperature increases above 31°C, see Fixing Insufficient Airflow that follows. 

Fixing Insufficient Airflow 

If the air temperature near the system is above 31°C, make one or more of the following changes to 

increase the flow of cooler air around the system: 

n Adjust air conditioning to lower the ambient air temperature. 

n Move the system to another location. 

n Provide more space around the system and between adjacent instruments. Arrange 

instruments so that the warm exhaust air from one instrument does not enter the air intake 

vents of another. 
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n Shield the system from heat sources such as radiators, heat-producing instruments, and bright 
sunlight. 

Replacing Fuses 

Fuses on the CFX Opus system are designed to blow in case of severe power surges or other 
causes of electrical short. This protects both the user and the system from excessive, potentiallly 

damaging electric currents. Fuses on the CFX Opus system rarely need to be replaced. However, 
some institutions prefer to replace fuses on a regular basis to maintain uninterrupted operation. 

If the system does not turn on, first verify that the power cord is plugged in to a functioning power 
source. Also, verify that the power cord and power source are within the specifications for this 

system. 

Finally, verify that the fuses are intact. If the fuses are broken or burned, replace the fuses. This 

section explains how to view and replace fuses on the CFX Opus system. 

Tip: The system utilizes two 10 A, 250 V, 5 x 20 mm, fast blow fuses. 

WARNING! To prevent electrical shock, always turn off and unplug the system from 

the electrical outlet before checking the fuses. 

Important: You must unplug the power cord from the instrument to open the fuse door. Trying 

to open the fuse door while the cord is plugged in could damage the door. 

To view and replace the fuses 

1. Verify that you have powered off the instrument and unplugged the power cord from the back 

of the instrument. 

2. Using your finger tip, gently pull the black fuse door on the back of the system out toward you. 
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3. Using a small flathead screw driver, gently pry out the red fuse holder until you can grasp it 
with your fingers. 

4. When you can firmly grasp the fuse holder, pull it straight out of the instrument. 

5. Using a finger tip, gently pry the fuse out of the fuse holder. 

6. The fuse holder contains two fuses, one on each side. You must inspect both fuses. 
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A bad fuse displays a break or burned spot in the internal metal filament, or measures open 

with an Ohm meter. A good fuse has an internal metal filament or measures short (< 1 Ohm). If 
a fuse is bad or damaged, replace it with a new fuse of the same type and rating. 

Note: Some fuses used in the CFX Opus instrument are made from ceramic and cannot 
be visually inspected. In this case, you must use an Ohm meter to determine whether the 

fuse is good. Alternatively, you can replace the fuse with a known good one without 
checking. 

7. Assuming the prongs indicate the front of the fuse holder, insert the back end of a 10 A, 250 V, 
5 x 20 mm, fast blow fuse into the middle bracket. Ensure the front end of the fuse faces the 

prongs. For example: 

8. With the flat red square on the fuse holder facing upward, insert the fuse holder into the 

instrument and firmly press it into position. 
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9. Close the fuse door, insert the power cord, and turn on the instrument. 

Caution: If the CFX Opus instrument repeatedly blows one or more fuses, there 

could be an internal problem with the instrument. Contact Bio-Rad Technical 
Support for assistance in determining whether it is safe to replace the fuses again 

or if the instrument should be repaired. 
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Upgrading System Software and Firmware 

Important: Only the Admin user can upgrade the CFX Opus system software and firmware. 

When connected to the Internet, CFX Maestro software alerts you to software and firmware updates 

available for the CFX Opus systems. You access the updates from Bio-Rad’s Firmware and 

Software Updates web site. The CFX Opus installer can include both software and firmware 

updates. CFX Opus firmware updates are not distributed in a separate package. 

Before upgrading the system, Bio-Rad recommends that you verify the current version installed on 

the CFX Opus system. This section explains how to verify the installed version and how to upgrade 

the system. 

Verifying the Currently Installed Version 

To verify the current version of CFX Opus 

1. On the CFX Opus Home screen, tap Tools to view the Tools screen 

2. If you are logged in as Admin, tap the User icon at the bottom of the screen to view the tools 

available to all users. 

3. Tap About and locate Opus Version on the About screen. 

4. Note the currently installed version. 

Ensure the version you are upgrading to is newer than the version currently installed. 

5. Tap Back and then top Home to return to the Home screen. 

Upgrading the System Software and Firmware 

Note: Depending on the type of upgrade, this process can take several minutes to complete. 

To upgrade CFX Opus system software and firmware 

1. From the CFX Maestro computer, log into bio-rad.com and go to the Firmware and Software 

Updates page to download the installer onto an attached USB drive. 

2. Insert the USB drive into a USB port on the CFX Opus system. 

3. On the Home screen, log in as the Admin user. 

4. On the Home screen, tap Tools to open the Admin tools screen. 

5. In the Admin tools screen, tap System Update to open the Software and Instrument Updates 

screen. 

The Software and Instrument Updates screen appears. 
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Important: While the upgrade is in progress, do not shut down the system and do not 
remove the USB drive. 

6. (Optional) To get details about the update, tap Details. 

7. Do one of the following: 

n To cancel the upgrade, tap Cancel. 

n To upgrade the system, tap Update and follow the prompts. 

Note: When the upgrade complete, the system automatically restarts. 
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Shutting Down the CFX Opus System 

Important: Follow these instructions to safely and completely shut down the CFX Opus 

system. 

To shut down the CFX Opus system 

1. Ensure that no protocol is running and the system is no longer in use. 

2. If you have not already done so, remove the samples from the block. 

a. On the Home screen, tap Open Lid to access the samples. 

b. Remove the samples from the block and then tap Close Lid. 

3. On the Home screen, tap Logout to log out of the system. 

4. On the Login screen, tap Shut Down ( ) to perform a soft shutdown of the system. 

5. When the CFX Opus system has completed the soft shutdown process, press the power switch 

on the back of the instrument to shut down the system. 
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Returning the CFX Opus System to Bio-Rad 

Important: Should you need to return your system to Bio-Rad, your Bio-Rad Technical 
Support specialist will provide instructions for decontaminating, packaging, and shipping the 

instrument. Before you return the instrument, you must install the shipping plate and shipping 

screw. This section explains these tasks. 

Note: Locate the shipping screw and shipping plate that you saved when you installed the 

system. You will need these items to properly package the system. Bio-Rad will send you the 

packaging material required to safely return the system. 

Important: Before you begin, ensure that you have completely backed up all data files to a 

shared network drive or a USB drive. 

Installing the Shipping Plate and Screw 

Tip: This information is also available on the CFX Opus touch screen to ensure you accurately 

install the screw. 

To install the shipping plate and screw 

1. If necessary, start the CFX Opus system and log in. 

2. Copy all user data to a network drive or an attached USB drive. 

3. On the Home screen, tap Tools to view the User Tools screen. 

Note: The Shipping Screw button appears on the User > Tools screen. If you logged in as 

the Admin user, tap User at the bottom of the screen. 

4. On the User Tools screen, tap Shipping Screw. 

The Shipping Screw screen appears with instructions for installing the shipping screw. 
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5. Follow the instructions to install the shipping screw. 

a. Tap Open Lid on the bottom button bar. 

b. Place the shipping plate on the reaction block. 

c. On the Install Shipping Screw screen, tap Close Lid to close the lid. 

d. Tap Lock Instrument to position the shuttle and lock the lid in place. 

The system displays a message confirming that you have installed the shipping plate. 
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n If the shipping plate is installed, tap Yes. The system locks the instrument for 
shipping. When lock-down is complete, tap OK and continue with Step e that follows. 

n If the shipping plate is not installed, tap No. The system stops the lock-down process 

and returns to the Install Shipping Screw screen. 

Repeat the steps in this procedure and ensure to install the shipping plate. 

e. Remove the plug (store it in a safe place) and then install the shipping screw, turning it 
clockwise until it is securely in place. 

f. On the Shipping Screw screen, tap Screw Installed to confirm the shipping screw is 

installed. 

6. Tap Back to return to the Home screen. 

7. Log out of the system and then shut down the CFX Opus instrument. 

8. Package and ship the system to Bio-Rad according to the instructions provided by Bio-Rad. 
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Troubleshooting CFX Opus Systems 

This section provides information on exporting system log information that can be used for 
troubleshooting purposes. It also lists potential problems and suggested solutions for the CFX 

Opus system. 

Viewing and Exporting Log Files 

CFX Opus system message and usage log files contain information that is helpful in 

troubleshooting problems with the system. Bio-Rad Technical Support might ask you to provide 

these files so that they can better assist you in resolving problems. You can export the log files to 

an attached USB drive. 

The CFX Opus system retains all message and usage log data until it is cleared. Only the Admin 

user can clear the log file. 

To view and export log files 

1. If you have not yet done so, insert a USB drive into a USB port on the instrument. 

2. On the Home screen, tap Tools and open the User Tools menu. 

3. On the User Tools screen, tap System Logs. 

The System Logs screen appears, displaying the message logs by default. 
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4. Tap Export Logs to export the system logs. CFX Opus creates a folder labeled Exports on the 

attached USB drive and exports the following .txt log files: 

n SystemMessageLog 

n SystemUsageLog 

n DebugLog 

n CloudLog (present only if the CFX Opus has a connection to Bio-Rad’sBR.io app) 

n OSLog 

n FirmwareUpdateLog 

n GUILog 

n WCFLog 

5. Click Back twice to return to the Home screen. 

To view the log information, remove the USB drive from the CFX Opus system, insert it into a 

USB port on an available computer, and open the log files in a text editing or word processing 

program. 
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Toubleshooting Issues 

Error Possible causes Troubleshooting steps 

Unable to use USB 

drives 

Power loss Turn the CFX Opus system off and then on. 

Unable to connect to 

BR.io after a run 

completes, before 

the run file is 

Communication loss Copy the run file to an attached USB drive 

or to a shared network folder and analyze 

the data using CFX Maestro software. 

uploaded to your 
BR.io account 
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Appendix D Bio-Rad Free and Open-Source 
Notices for PCR Products 

This document includes licensing information relating to free, open-source, and public-source 

software and data (together, the “MATERIALS”) included with or used to develop Bio-Rad products 

and services. The terms of the applicable free, open-source, and public-source licenses (each an 

“OPEN LICENSE”) govern Bio-Rad’s distribution and your use of the MATERIALS. Bio-Rad and 

the third-party authors, licensors, and distributors of the MATERIALS disclaim all warranties and 

liability arising from all use and distribution of the MATERIALS. To the extent the OSS is provided 

under an agreement with Bio-Rad that differs from the applicable OSS LICENSE, those terms are 

offered by Bio-Rad alone. 

Bio- Rad has reproduced below copyright and other licensing notices appearing within the 

MATERIALS. While Bio-Rad seeks to provide complete and accurate copyright and licensing 

information for all MATERIALS, Bio- Rad does not represent or warrant that the following 

information is complete, correct, or error- free. MATERIALS recipients are encouraged to (a) 
investigate the identified MATERIALS to confirm the accuracy of the licensing information provided 

and (b) notify Bio-Rad of any inaccuracies or errors found in this document so that Bio-Rad may 

update this document accordingly. 

Certain OPEN LICENSES (such as the Affero General Public Licenses, Common Development 
and Distribution Licenses, Common Public License, Creative Commons Share-Alike License, 
Eclipse Public License, Mozilla Public Licenses, GNU General Public Licenses, GNU 

Library/Lesser General Public Licenses, and Open Data Commons Open Database License) 
require that the source materials be made available to recipients or other requestors under the 

terms of the same OPEN LICENSE. 

The corresponding open source software is available for download from the links in the section 

that follows. 
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Software Notices 

M2Mqtt (paho.mqtt.m2mqtt) 
Project homepage/download sites: 

https://m2mqtt.wordpress.com/ 

https://www.nuget.org/packages/M2Mqtt/ 

Bio-Rad source code site: 

https://github.com/bio-rad-lsg-open-source/Mqtt-4.3.0.0 

External source code site: 

https://github.com/eclipse/paho.mqtt.m2mqtt 

Project licensing notices: 

Eclipse Foundation Software User Agreement 

February 1, 2011 

Usage Of Content 

THE ECLIPSE FOUNDATION MAKES AVAILABLE SOFTWARE, DOCUMENTATION, 
INFORMATION AND/OR OTHER MATERIALS FOR OPEN SOURCE PROJECTS 
(COLLECTIVELY "CONTENT"). USE OF THE CONTENT IS GOVERNED BY THE 
TERMS AND CONDITIONS OF THIS AGREEMENT AND/OR THE TERMS AND 
CONDITIONS OF LICENSE AGREEMENTS OR NOTICES INDICATED OR 
REFERENCED BELOW. BY USING THE CONTENT, YOU AGREE THAT YOUR USE OF 
THE CONTENT IS GOVERNED BY THIS AGREEMENT AND/OR THE TERMS AND 
CONDITIONS OF ANY APPLICABLE LICENSE AGREEMENTS OR NOTICES 
INDICATED OR REFERENCED BELOW. IF YOU DO NOT AGREE TO THE TERMS 
AND CONDITIONS OF THIS AGREEMENT AND THE TERMS AND CONDITIONS OF 
ANY APPLICABLE LICENSE AGREEMENTS OR NOTICES INDICATED OR 
REFERENCED BELOW, THEN YOU MAY NOT USE THE CONTENT. 

Applicable Licenses 

Unless otherwise indicated, all Content made available by the 
Eclipse Foundation is provided to you under the terms and 
conditions of the Eclipse Public License Version 1.0 ("EPL"). A 
copy of the EPL is provided with this Content and is also 
available at http://www.eclipse.org/legal/epl-v10.html. For 
purposes of the EPL, "Program" will mean the Content. 
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Software Notices 

Content includes, but is not limited to, source code, object code, 
documentation and other files maintained in the Eclipse Foundation 
source code repository ("Repository") in software modules 
("Modules") and made available as downloadable archives 
("Downloads"). 

l Content may be structured and packaged into modules to 
facilitate delivering, extending, and upgrading the Content. 
Typical modules may include plug-ins ("Plug-ins"), plug-in 
fragments ("Fragments"), and features ("Features"). 

l Each Plug-in or Fragment may be packaged as a sub-directory 
or JAR (Java™ ARchive) in a directory named "plugins". 

l A Feature is a bundle of one or more Plug-ins and/or
Fragments and associated material. Each Feature may be 
packaged as a sub-directory in a directory named "features". 
Within a Feature, files named "feature.xml" may contain a 
list of the names and version numbers of the Plug-ins and/or
Fragments associated with that Feature. 

l Features may also include other Features ("Included
Features"). Within a Feature, files named "feature.xml" may
contain a list of the names and version numbers of Included 
Features. 

The terms and conditions governing Plug-ins and Fragments should 
be contained in files named "about.html" ("Abouts"). The terms and 
conditions governing Features and Included Features should be 
contained in files named "license.html" ("Feature Licenses"). 
Abouts and Feature Licenses may be located in any directory of a 
Download or Module including, but not limited to the following
locations: 

l The top-level (root) directory 
l Plug-in and Fragment directories 
l Inside Plug-ins and Fragments packaged as JARs 
l Sub-directories of the directory named "src" of certain 
Plug-ins 

l Feature directories 

Note: if a Feature made available by the Eclipse Foundation is 
installed using the Provisioning Technology (as defined below), 
you must agree to a license ("Feature Update License") during the 
installation process. If the Feature contains Included Features, 
the Feature Update License should either provide you with the 
terms and conditions governing the Included Features or inform you 
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where you can locate them. Feature Update Licenses may be found in 
the "license" property of files named "feature.properties" found 
within a Feature. Such Abouts, Feature Licenses, and Feature 
Update Licenses contain the terms and conditions (or references to 
such terms and conditions) that govern your use of the associated 
Content in that directory. 

THE ABOUTS, FEATURE LICENSES, AND FEATURE UPDATE LICENSES MAY 
REFER TO THE EPL OR OTHER LICENSE AGREEMENTS, NOTICES OR TERMS AND 
CONDITIONS. SOME OF THESE OTHER LICENSE AGREEMENTS MAY INCLUDE 
(BUT ARE NOT LIMITED TO): 

l Eclipse Distribution License Version 1.0 (available at 
http://www.eclipse.org/licenses/edl-v1.0.html) 

l Common Public License Version 1.0 (availabe at 
http://www.eclipse.org/legal/cpl-v10.html) 

l Apache Software License 1.1 (available at 
http://www.apache.org/licenses/LICENSE) 

l Apache Software License 2.0 (available at 
http://www.apache.org/licenses/LICENSE-2.0) 

l Metro Link Public License 1.00 (available at 
http://www.open-
group.org/openmotif/supporters/metrolink/license.html) 

l Mozilla Public License Version 1.1 (available at 
http://www.mozilla.org/MPL/MPL-1.1.html) 

IT IS YOUR OBLIGATION TO READ AND ACCEPT ALL SUCH TERMS AND 
CONDITIONS PRIOR TO USE OF THE CONTENT. If no About, Feature 
License, or Feature Update License is provided, please contact the 
Eclipse Foundation to determine what terms and conditions govern
that particular Content. 

Use of Provisioning Technology 

The Eclipse Foundation makes available provisioning software, 
examples of which include, but are not limited to, p2 and the 
Eclipse Update Manager ("Provisioning Technology") for the purpose
of allowing users to install software, documentation, information 
and/or other materials (collectively "Installable Software"). This 
capability is provided with the intent of allowing such users to 
install, extend and update Eclipse-based products. Information 
about packaging Installable Software is available at 
http://eclipse.org/equinox/p2/repository_packaging.html
("Specification"). 
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Software Notices 

You may use Provisioning Technology to allow other parties to 
install Installable Software. You shall be responsible for 
enabling the applicable license agreements relating to the 
Installable Software to be presented to, and accepted by, the 
users of the Provisioning Technology in accordance with the 
Specification. By using Provisioning Technology in such a manner 
and making it available in accordance with the Specification, you
further acknowledge your agreement to, and the acquisition of all 
necessary rights to permit the following: 

1. A series of actions may occur ("Provisioning Process") in which 
a user may execute the Provisioning Technology on a machine 
("Target Machine") with the intent of installing, extending or 
updating the functionality of an Eclipse-based product. 

2. During the Provisioning Process, the Provisioning Technology 
may cause third party Installable Software or a portion thereof to 
be accessed and copied to the Target Machine. 

3. Pursuant to the Specification, you will provide to the user the 
terms and conditions that govern the use of the Installable 
Software ("Installable Software Agreement") and such Installable 
Software Agreement shall be accessed from the Target Machine in 
accordance with the Specification. Such Installable Software 
Agreement must inform the user of the terms and conditions that 
govern the Installable Software and must solicit acceptance by the 
end user in the manner prescribed in such Installable Software 
Agreement. Upon such indication of agreement by the user, the 
provisioning Technology will complete installation of the 
Installable Software. 

Cryptography 

Content may contain encryption software. The country in which you 
are currently may have restrictions on the import, possession, and 
use, and/or re-export to another country, of encryption software. 
BEFORE using any encryption software, please check the country's
laws, regulations and policies concerning the import, possession, 
or use, and re-export of encryption software, to see if this is 
permitted. 

Java and all Java-based trademarks are trademarks of Oracle 
Corporation in the United States, other countries, or both. 

/LICENSE: 

See EPL-1.0 in the Standard OSS License Text appendix to this document. 
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Standard Open License Text 

EPL 1.0 

Eclipse Public License - v 1.0 

THE ACCOMPANYING PROGRAM IS PROVIDED UNDER THE TERMS OF THIS 
ECLIPSE PUBLIC LICENSE ("AGREEMENT"). ANY USE, REPRODUCTION OR 
DISTRIBUTION OF THE PROGRAM CONSTITUTES RECIPIENT'S ACCEPTANCE OF 
THIS AGREEMENT. 

1. DEFINITIONS 

"Contribution" means: 

a) in the case of the initial Contributor, the initial code and 
documentation distributed under this Agreement, and 

b) in the case of each subsequent Contributor: 

i) changes to the Program, and 

ii) additions to the Program; 

where such changes and/or additions to the Program originate from 
and are distributed by that particular Contributor. A Contribution 
'originates' from a Contributor if it was added to the Program by 
such Contributor itself or anyone acting on such Contributor's 
behalf. Contributions do not include additions to the Program
which: (i) are separate modules of software distributed in 
conjunction with the Program under their own license agreement,
and (ii) are not derivative works of the Program. 

"Contributor" means any person or entity that distributes the 
Program. 

"Licensed Patents" mean patent claims licensable by a Contributor 
which are necessarily infringed by the use or sale of its 
Contribution alone or when combined with the Program. 

"Program" means the Contributions distributed in accordance with 
this Agreement. 

"Recipient" means anyone who receives the Program under this 
Agreement, including all Contributors. 
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2. GRANT OF RIGHTS 

a) Subject to the terms of this Agreement, each Contributor hereby
grants Recipient a non- exclusive, worldwide, royalty- free 
copyright license to reproduce, prepare derivative works of, 
publicly display, publicly perform, distribute and sublicense the 
Contribution of such Contributor, if any, and such derivative 
works, in source code and object code form. 

b) Subject to the terms of this Agreement, each Contributor hereby
grants Recipient a non-exclusive, worldwide, royalty-free patent
license under Licensed Patents to make, use, sell, offer to sell, 
import and otherwise transfer the Contribution of such 
Contributor, if any, in source code and object code form. This 
patent license shall apply to the combination of the Contribution 
and the Program if, at the time the Contribution is added by the 
Contributor, such addition of the Contribution causes such 
combination to be covered by the Licensed Patents. The patent
license shall not apply to any other combinations which include 
the Contribution. No hardware per se is licensed hereunder. 

c) Recipient understands that although each Contributor grants the 
licenses to its Contributions set forth herein, no assurances are 
provided by any Contributor that the Program does not infringe the 
patent or other intellectual property rights of any other entity.
Each Contributor disclaims any liability to Recipient for claims 
brought by any other entity based on infringement of intellectual 
property rights or otherwise. As a condition to exercising the 
rights and licenses granted hereunder, each Recipient hereby 
assumes sole responsibility to secure any other intellectual 
property rights needed, if any. For example, if a third party
patent license is required to allow Recipient to distribute the 
Program, it is Recipient's responsibility to acquire that license 
before distributing the Program. 

d) Each Contributor represents that to its knowledge it has 
sufficient copyright rights in its Contribution, if any, to grant
the copyright license set forth in this Agreement. 

3. REQUIREMENTS 

A Contributor may choose to distribute the Program in object code 
form under its own license agreement, provided that: 

a) it complies with the terms and conditions of this Agreement;
and 
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b) its license agreement: 

i) effectively disclaims on behalf of all Contributors all 
warranties and conditions, express and implied, including
warranties or conditions of title and non- infringement, and 
implied warranties or conditions of merchantability and fitness 
for a particular purpose; 

ii) effectively excludes on behalf of all Contributors all 
liability for damages, including direct, indirect, special,
incidental and consequential damages, such as lost profits; 

iii) states that any provisions which differ from this Agreement 
are offered by that Contributor alone and not by any other party;
and 

iv) states that source code for the Program is available from such 
Contributor, and informs licensees how to obtain it in a 
reasonable manner on or through a medium customarily used for 
software exchange. 

When the Program is made available in source code form: 

a) it must be made available under this Agreement; and 

b) a copy of this Agreement must be included with each copy of the 
Program. 

Contributors may not remove or alter any copyright notices 
contained within the Program. 

Each Contributor must identify itself as the originator of its 
Contribution, if any, in a manner that reasonably allows 
subsequent Recipients to identify the originator of the 
Contribution. 

4. COMMERCIAL DISTRIBUTION 

Commercial distributors of software may accept certain 
responsibilities with respect to end users, business partners and 
the like. While this license is intended to facilitate the 
commercial use of the Program, the Contributor who includes the 
Program in a commercial product offering should do so in a manner 
which does not create potential liability for other Contributors. 
Therefore, if a Contributor includes the Program in a commercial 
product offering, such Contributor ("Commercial Contributor")
hereby agrees to defend and indemnify every other Contributor 
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("Indemnified Contributor") against any losses, damages and costs 
(collectively "Losses") arising from claims, lawsuits and other 
legal actions brought by a third party against the Indemnified 
Contributor to the extent caused by the acts or omissions of such 
Commercial Contributor in connection with its distribution of the 
Program in a commercial product offering. The obligations in this 
section do not apply to any claims or Losses relating to any
actual or alleged intellectual property infringement. In order to 
qualify, an Indemnified Contributor must: a) promptly notify the 
Commercial Contributor in writing of such claim, and b) allow the 
Commercial Contributor to control, and cooperate with the 
Commercial Contributor in, the defense and any related settlement 
negotiations. The Indemnified Contributor may participate in any
such claim at its own expense. 

For example, a Contributor might include the Program in a 
commercial product offering, Product X. That Contributor is then a 
Commercial Contributor. If that Commercial Contributor then makes 
performance claims, or offers warranties related to Product X, 
those performance claims and warranties are such Commercial 
Contributor's responsibility alone. Under this section, the 
Commercial Contributor would have to defend claims against the 
other Contributors related to those performance claims and 
warranties, and if a court requires any other Contributor to pay 
any damages as a result, the Commercial Contributor must pay those 
damages. 

5. NO WARRANTY 

EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, THE PROGRAM IS 
PROVIDED ON AN "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF 
ANY KIND, EITHER EXPRESS OR IMPLIED INCLUDING, WITHOUT LIMITATION, 
ANY WARRANTIES OR CONDITIONS OF TITLE, NON- INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Each 
Recipient is solely responsible for determining the 
appropriateness of using and distributing the Program and assumes 
all risks associated with its exercise of rights under this 
Agreement, including but not limited to the risks and costs of 
program errors, compliance with applicable laws, damage to or loss 
of data, programs or equipment, and unavailability or interruption
of operations. 
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6. DISCLAIMER OF LIABILITY 

EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, NEITHER RECIPIENT 
NOR ANY CONTRIBUTORS SHALL HAVE ANY LIABILITY FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING WITHOUT LIMITATION LOST PROFITS), HOWEVER CAUSED AND ON 
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF 
THE USE OR DISTRIBUTION OF THE PROGRAM OR THE EXERCISE OF ANY 
RIGHTS GRANTED HEREUNDER, EVEN IF ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES. 

7. GENERAL 

If any provision of this Agreement is invalid or unenforceable 
under applicable law, it shall not affect the validity or 
enforceability of the remainder of the terms of this Agreement,
and without further action by the parties hereto, such provision
shall be reformed to the minimum extent necessary to make such 
provision valid and enforceable. 

If Recipient institutes patent litigation against any entity
(including a cross-claim or counterclaim in a lawsuit) alleging
that the Program itself (excluding combinations of the Program
with other software or hardware) infringes such Recipient's patent
(s), then such Recipient's rights granted under Section 2(b) shall 
terminate as of the date such litigation is filed. 

All Recipient's rights under this Agreement shall terminate if it 
fails to comply with any of the material terms or conditions of 
this Agreement and does not cure such failure in a reasonable 
period of time after becoming aware of such noncompliance. If all 
Recipient's rights under this Agreement terminate, Recipient 
agrees to cease use and distribution of the Program as soon as 
reasonably practicable. However, Recipient's obligations under 
this Agreement and any licenses granted by Recipient relating to 
the Program shall continue and survive. 

Everyone is permitted to copy and distribute copies of this 
Agreement, but in order to avoid inconsistency the Agreement is 
copyrighted and may only be modified in the following manner. The 
Agreement Steward reserves the right to publish new versions 
(including revisions) of this Agreement from time to time. No one 
other than the Agreement Steward has the right to modify this 
Agreement. The Eclipse Foundation is the initial Agreement 
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Steward. The Eclipse Foundation may assign the responsibility to 
serve as the Agreement Steward to a suitable separate entity. Each 
new version of the Agreement will be given a distinguishing
version number. The Program (including Contributions) may always
be distributed subject to the version of the Agreement under which 
it was received. In addition, after a new version of the Agreement
is published, Contributor may elect to distribute the Program
(including its Contributions) under the new version. Except as 
expressly stated in Sections 2 (a) and 2 (b) above, Recipient
receives no rights or licenses to the intellectual property of any
Contributor under this Agreement, whether expressly, by
implication, estoppel or otherwise. All rights in the Program not 
expressly granted under this Agreement are reserved. 

This Agreement is governed by the laws of the State of New York 
and the intellectual property laws of the United States of 
America. No party to this Agreement will bring a legal action 
under this Agreement more than one year after the cause of action 
arose. Each party waives its rights to a jury trial in any
resulting litigation. 
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